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Foreword 

The National Vocational & Technical Training Commission (NAVTTC) developed a National Skills 
Strategy (NSS) after extensive research and consultation with experts and stakeholders including policy 
makers and representatives from Industry, Academia and the Provincial Government departments 
dealing with technical and vocational training. The strategy aims at establishing a regime that facilitates 
competency-based and demand-driven training and assessment.  
 
NAVTTC has developed competency-based training programs with the technical support of TVET Reform 
Support Programme (TVET-RSP), which is funded by the European Union, the Kingdom of the 
Netherlands, the Federal Republic of Germany and the Royal Norwegian Embassy. The Programme has 
been commissioned by the German Federal Ministry for Economic Cooperation and Development (BMZ) 
and is being implemented by the Deutsche Gesellschaft für Internationale Zusammenarbeit (GIZ) GmbH 
in close collaboration with NAVTTC. These vocational training programs have been approved by the 
National Curriculum Review Committee (having representation from all over the country from TEVTAs 
and industry) for implementation in Public and Private Training institutions. 
 
The purpose of developing competency-based training programs is to equip the learners with modern 
skills and knowledge for each of the trades to meet the requirements of local as well as international 
markets. These training programs include competency standards, qualification, curriculum, assessment 
material and teaching & learning material that will aid in implementation of competency-based and 
demand driven training in the country.  
 
This Teaching and Learning Material is part of the competency based training program exclusively 
developed to support the implementation of CBT curricula. This Material is intended for the use of 
learners undertaking training in National Vocational Certificate Level-2 in Information Technology (Office 
Assistant) under the guidance of experts and appropriate trainers. This Teaching and Learning Material 
has been designed in consultation with industry, academia and researchers to ensure that the material 
is relevant and current.  

On behalf of the Federal Government/NAVTTC, I wish to express my sincere appreciation and gratitude 
to all subject matter experts, industry representatives and TVET-RSP experts who have diligently 
contributed in producing this valuable Teaching and Learning Material. 

 
 
 
 
 
 
 

Executive Director 
National Vocational & Technical Training Commission 

(NAVTTC) 

  



Introduction 

An Office Assistant performs simple and routine tasks to carry out different office related functions in an 
organization. Major responsibilities include creation of documents using computer applications, 
maintaining record about human resources, accounting transactions and inventory etc.   

 

The National Vocational & Technical Training Commission (NAVTTC) has developed a national 

qualification entitled, “National Vocational Certificate Level-2 in Information Technology (Office 

Assistant)”. Relevant industry and employers were consulted in the design and validation processes in 

order to come up with a national qualification that fulfills the requirements of the sector in general and the 

occupation in particular.  

 

This Teaching and Learning Material (TLM) is developed based on competency standards and curriculum 

of the Computer Operator national qualification. It carries a learning volume of 50 credits and includes 

eight learning modules which are as under:  

 

Module 1: Duties and Rights at the Workplace  
Module 2: Computer Skills  
Module 3: Databases  
Module 4: Business Functional Process Area (Accounts-Bookkeeping)  
Module 5: Business Functional Process Area (Inventory Control-Store keeping)  
Module 6: Business Functional Process Area (Human Resource Management)  
Module 7: Business Functional Process Area (Administration) 
Module 8: Project 
 

 

This TLM provides support for more effective training and productive learning. Each of the learning 

modules contains learning outcomes and information regarding learning elements in the form of 

knowledge, skills and attitudes. At the end of every learning module are Frequently Asked Questions 

(FAQs) and Test Yourself which will help learners in self-assessment before proceeding to modular or 

final assessment. 
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Module 1: Duties and Rights at the Work 
Place 

Learning Outcomes 

 
After completion of this learning module, you will be able to describe 
and practice: 
 

 Understand and perform the mandatory standard for 
Responsibility, Respect, Fairness and Honesty. 

 Identify tasks, their scheduling, define milestones, and learn 
optimal utilization of resources. 

 Recognize the aspirational requirements of human rights in 
employment context. 

 Understand the legal right granted to an author, composer, 
publisher, production, or any other artist’s work. 

 Understand that unauthorized use or reproduction of copyright or 
patented material is illegal. 

 Understand that they can’t give the design made for and sold to 
one client to the others. 
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Learning Unit 1: Ethics and Professional Conduct 

Overview 

In this leaning unit, you will be able to introduce the four values that serve as the foundation for decision 
making and guidance to the action of the employees, these are: responsibility, respect, fairness, and 
honesty. You will be able to identify and practice the mandatory standards for these four values. 
 

1. Duty to take Ownership and Act for the Decisions/Actions 

Responsibility 

Responsibility is to take ownership for the decisions we make or fail to make, 
the actions we take or fail to take, and the consequences of those decisions 
and actions. The responsibility involves two types of standards working in a 
work place which are as under: 

1. Aspirational Standards 

In working in an organization, the following aspirational standards need to be followed: 

 Take decisions and perform actions in the best interests of the society, are not a risk for public 
safety, and beneficial for the environment. 

 Accept only those assignments that are consistent with your background, experience, skills, 
and qualifications so that you can fulfill the assignment with professional conduct. 

 Always fulfill the commitments that you undertake, you should do what you say you will do. 

 Take responsibility and make corrections instantly, if you make errors or omissions and as you 
come to know that the errors or omissions were caused by others, communicate them to the 
appropriate person as soon they are discovered.  

 Protect proprietary or confidential information shared with you. 

 
2. Mandatory Standards 

Requirement standards that all the employees must fulfill include the following: 

 Be aware and maintain the policies, rules, regulations and laws that control your work, 
professional behavior, and volunteer activities. 

 Report unethical or illegal behavior to appropriate management and, if necessary, to those 
affected by the manner. 

 Bring violations against these standards to the attention of the aggregate body for resolution. 

 File only complaints should be files which are validated by facts. 

The state or fact of 
having a duty to deal 
with something or of 
having control over 
someone. 

Responsibility 
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 Follow disciplinary action against an individual who violates rules and regulations. 
 

2. Respect  

Respect refers to show a high regard for ourselves, others, and the resources assigned to us. 
Resources entrusted to us may include people, money, reputation, the safety of others, and natural or 
environmental resources. An environment of respect creates trust, confidence, and performance 
excellence by raising mutual cooperation. Respect involves two types of standards: 

1. Aspirational Standards 

 Be aware of the rules and traditions of others and avoid engaging in behaviors they might 
consider disrespectful. 

 Listen to others’ points of view in order to understand them. 

 Approach directly those persons with whom you have a conflict or disagreement. 

 Conduct in a professional manner, even when it is not replied the same way. 
 

2. Mandatory Standards 

 Negotiate in good faith. 

 Do not exercise the power of your expertise or position to influence the decisions or actions of 
others in orders to get benefit personally at their expense. 

 Do not act in a rude manner toward others. 

 Respect the property rights of others. 
 

3. Fairness  

Fairness is our duty to make decisions and act neutrally and objectively. Our 
conduct must be free from competing self-interest, bias, and favoritism. 
Fairness involves two types of standards working in a work place, which are 
as under: 

1. Aspirational Standards 

 Always demonstrate transparency in your decision-making process. 

 Constantly re-examine your neutrality and objectivity 

 Provide equal access to information to those who are authorized to have that information. 

 Make opportunities equally available to qualified candidates. 

 

In the workplace, 
perceived injustice 
has been directly 
linked to burnout 
and job 
dissatisfaction. 

Remember 
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2. Mandatory Standards 

 Fully disclose any real or potential conflicts of interest to the appropriate stakeholders. 

 If you realize that you have a real or potential conflict of interest, avoid engaging yourself in the 
decision making process or otherwise attempting to influence outcomes until you have made 
full disclosure to the affected stakeholders. 

 Never hire or fire, reward or punish, or award or deny contracts based on personal 
considerations, bias, or favoritism. 

 Never discriminate against others based on gender, race, age, religion, disability, nationality, 
or sexual orientation. 

 Apply the rules of the organization without favoritism or prejudice. 
 

4. Honesty  

Honesty is to understand the truth and act in a truthful manner both in our communications and in our 
conduct. It involves two types of standards working in a work place, which are as under: 

 

1. Aspirational Standards 

 Sincerely try to understand the truth. 

 Always be truthful in your communications and in your conduct. 

 Provide accurate information in a timely manner. 

 Always make commitments and promises, unspoken or clear, in good faith. 

 Should strive to create an environment in which others feel safe and comfortable to tell the 
truth. 

 
2. Mandatory Standards 

 Do not engage in or ignore behavior that is intended to deceive others, making misleading or 
false statements, stating half-truths, providing information out of context or withholding 
information that, if known, would render your statements as misleading or incomplete. 

 Do not engage in dishonest behavior with the intention of personal gain at the expense of 
another. 
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Learning Unit 2: Planning of the Business Process 
Activities 

Overview 

In this learning unit, you will come to know about different concepts and activities involved in the 
planning of the business process activities. After the completion of this learning unit, you will be able 
to assist their in-line managers, define activities like specific life cycle methodologies, estimate time for 
activities, and perform breakdowns of the work and leveling the resources. 
 

1. Provide Due Assistance to In-Line Manager  

While working at the workplace, the following tasks may provide assistance to 
the managers: 

1. Coordinating Recurring Meetings 

 Schedule recurring meetings properly using software like outlook 
calendar, or some other good schedule software’s.  

 Organize the meeting venue.  

 Inform the attendees about the schedule and make the agenda of the 
meeting clear to them.  

 Make sure that documents to be used and other equipment like computer etc. are ready to use.  
 

2. Intimate Resource Availability 

A project plan is considered to be good if tasks are as clear as possible and 
resources needed to accomplish those tasks are readily available. Before 
assigning individuals to tasks, associate a task with a resource type. Then 
enter the expected duration of that task based on the resource chosen. This 
ensures the intimate resource availability. 

3. Create and Keep Documentation 

You can assist in-line managers by maintaining the documents about meetings, resource assignments, 
project assignments and completion status, client history etc. This involves the creation and updating 
of documentation.  

4. Validate Applicable Company Defined Standards 

It is important to validate and follow established company standards for the duration of your 
employment. You should be informed and understand all the company standards but pay particular 
attention to the ones that are specific to your job role in the company. Try to help other employs to 
understand and follow the company applicable standards. 

Resources needed 
to be available can 
be machinery, 
equipment, human 
or time. 

Remember 

The agenda of 
recurring meeting 
depends upon the 
management 
decision. It may be 
to present status 
report to attendees 
or to plan for the 
next phase. 

Do you know! 
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2. Define Activities  

In order to perform task in good manner, you should be able to apply specific life cycle methodology to 
the procedure. Prior to perform your job or duty, the undergone activities belong to some specific 
phase. It is necessary to define what phase an activiy belongs to. Application of life cycle methodology 
help the worker and a company to delive assignment effectively. The different phases of life cycle are: 

1. Requirement Gathering 

Requirement gathering is the first and the most important phase of any project development. The 
specifications of the project results are an outcome of requirements gathered. The acivities involved in 
this phase include interviewing the potential users or employees of the company about their needs for 
the final product (in case of new system replacing an old one, interviewing them about the problems 
they face in the existing system), verfication of the gathered information, documentation of information 
for futher development. 

2. Design Solution 

During this phase, the gathered requirements are analysed and assesed to find out the problem. The 
activities in this phase include plans are laid out concerning the physical construction, hardware, 
operating systems, programming, communications, and security issues.  

3. Prototype  

At this phase, instead of freezing the requirements before a design or coding 
can proceed, a prototype is built to understand the requirements. This 
prototype is developed based on the currently known requirements. By using 
this prototype, the client can get an “actual feel” of the system, since the 
interactions with prototype can enable the client to better understand the 
requirements of the desired system. 

4. Testing 

After the prototype is approved, the life cycle proceeds to the final product that 
fulfills the gathered requirements. This product is then tested throughly using 
series of testing techniques. Product should be tested from every aspect and 
in all the possible conditions and audience.  

5. Documentation 

In this phase, the activities performed include, preparing documentation of the 
various area that need to be documented. This documentation can be used as 
written proof, can be used as a help for future consultation if some problem 
arises. 

3. Estimate Time 

Whether you bill clients hourly or on a per project basis, a necessary step of all projects is estimating 
the time it will take. You need to estimate time accurately if you're going to deliver your project on time 
and within budget. Without this skill, you won't know how long your project will take, and you won't be 
able to get commitment from the people required to help you achieve your objective. Not only does the 
client want to have an idea of how much money they will be spending, but they also need to plan 

A prototype is an 
instance of a 
working product, 
representing all the 
specification of final 
project. 

Prototype 

Time estimation 
depends on a 
number of factors, 
including how much 
experience you have 
with the type of work 
you’re doing. 

Remember 
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around an estimated timeline. And you need to be able to ensure you have the time and resources 
necessary to complete the project. 

Time estimation depends on a number of factors, including how much experience you have with the 
type of work you’re doing. With the help of following you can estimate the time: 

1. Identify the Product Deliverables 

The first step is to identify the main project (i.e. website redesign), and then pinpoint the specific 
deliverables associated with the project. For example, upon completion of the redesign, you will be 
providing the client with a newly designed website by transferring the site files and sending the client 
a CD or USB drive with the working files. 

2. Breaking the Project in Sub-Tasks  

Next, take the project and break it down into simple tasks. At the end of this 
step, you will have a list of activities that will take us to the deliverables. Now, 
list all of the activities you identified in the order in which they need to happen. 

3. Estimate Time for Each Step 

The next step is to estimate time in hour for each task or activity, rounding up. 
To begin with, estimate the time needed for each task rather than for the project 
as a whole. Then take the total time for all of the tasks and add in a buffer. The 
buffer can be anything, although I usually stick with a 10-25% addition. This 
helps to deal with any unexpected situations or challenges that arise. 

4. Things to keep in mind 

Following points need to be kept in mind while calculating total time required by a project: 

 Project management time 

 All the constraints that are relevant, it will help to identify risks. 

 Consider calendar year official leaves,  

 Company’s working timings 

 Debugging 
 

4. Achieve Work Breakdowns  

Dividing complex projects into simpler and manageable tasks is the process identified as Work 
Breakdown Structure (WBS). Usually, the project managers use this method for simplifying the project 
execution. In WBS, much larger tasks are broken down to manageable chunks of work. These chunks 
can be easily supervised and estimated. Following are a few reasons to achieve work breakdown in 
your project: 
 

 Accurate and readable project organization. 

 Accurate assignment of responsibilities to the project team. 

 Indicates the project milestones and control points. 

 Helps to estimate the cost, time and risk. 

 Illustrate the project scope, so the stakeholders can have a better understanding of the same. 

 

Work breakdown is 
not restricted to a 
specific field when it 
comes to 
application. This 
methodology can be 
used for any type of 
project 
management.  

Do you know! 
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5. Level Resource Due to Work Load  

Research indicates that it is not just the amount of work that makes a difference in employee 
satisfaction and success, but also the extent to which employees have the resources (time, equipment 
and support) to do the work well. 

Resource leveling is a technique in project management that deals with resource allocation and 
resolves any possible conflict that can arise from wrong allocation. When project managers take a 
project, they need to plan their resources accordingly. This helps an organization to avoid any conflicts 
and being able to deliver the project on time. Resource leveling is considered one of the key elements 
to resource management in the organization. 

An organization starts to face problems if resources are not allocated properly i.e., some resource may 
be over-allocated whilst others will be under-allocated. Both will bring about a financial risk to the 
organization.  

Key Elements of Resource Leveling 

The main aim of resource leveling is to allocate resource efficiently, so that the project can be 
completed in the given time period. Resource leveling can be broken down into two main areas: 

 Projects that can be completed by using up all resources, which are available and projects that 
can be completed with limited resources. 

 Projects, which use limited resources can be extended for over a period of time until the 
resources required are available.  

Process of Resource Leveling 

Resource leveling helps an organization to make use of the available resources to the maximum. The 
idea behind resource leveling is to reduce wastage of resources i.e. to stop over-allocation of 
resources. 

Project manager will identify time that is unused by a resource and will take measures to prevent it or 
making an advantage out of it. By resource conflicts, there are numerous disadvantages suffered by 
the organization, such as: 
 

 Delay in certain tasks being completed 

 Difficulty in assigning a different resource 

 Unable to change task dependencies 

 To remove certain tasks 

 To add more tasks 

 Overall delays and budget overruns of projects 
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Learning Unit 3: Awareness to Rights 

Overview 

In this learning unit, you will learn about the workers’ rights at the workplace, policies and procedures, 
reporting of illegal conduct. After the completion of this module, you will be able to define and know the 
importance of the policies, rules and regulations that administer the work and workplace, reporting the 
illegal conduct or illegitimate action to appropriate management and the importance of protecting the 
propriety or confidential information. 

 

1. Inform and Uphold the Policies, Rules and Regulations at the Workplace 

Policies, rules or regulations communicate an organization’s values and the 
organization’s expectations of employee behaviors and performance. 
Workplace policies support and clarify standard operating procedure in a 
workplace. They help organization to manage staff more effectively by clearly 
defining acceptable and unacceptable behavior in the workplace, and define 
the effects of not complying with those policies. 

A policy may also be required where there is a large number of interests and 
preferences, which could result in unclear and conflicting objectives among 
those who are directly involved. 

They set rules and guidelines for decision-making in routine situations so that employees and 
managers do not need to continually ask senior managers what to do. They help you to adopt a 
consistent and clear response across the company to continually refer to situations involving employee 
interaction.  

We should understand well and support these policies, rules, regulations and laws that govern our 
work, professional, and volunteer activities. These rules, regulation and policies protect business and 
workers and if correctly implemented and executed, create and maintain a better work environment for 
all. 
 

2. Report Illegal Conduct or Illegitimate Action to the Appropriate Authority 

From time to time, there is a possibility that the workers may violate the 
policies or laws established for a business or company. Even if an employee 
breaks the rules with the best of intentions, the flow of the workplace can be 
impacted negatively.  

It is the responsibility of a worker to report illegal or illegitimate action to 
appropriate management. That needs to encourage employees to bring 
ethical and legal violations they are aware of to an internal or responsible 
authority so that action can be taken immediately to resolve the problem. It 
important to minimize the organization's exposure to the damage that can 

occur when employees circumvent internal mechanisms. For this purpose organization should let 
employees know the organization is serious about adherence to codes of conduct. 

The main barriers to lack of confidence in employees to report illegitimate conduct can be as under: 

It is unlawful to 
terminate an 
employee who 
reported, complains 
about some illegal or 
fraudulent conduct 
by an employer or 
co-workers. 

Do you know! 

A policy is a 
statement which 
explains how human 
resource 
management issues 
will be dealt with in 
an company. 
 

Policy 
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 A lack of trust in the internal system 

 Unwillingness of employees to be "informers" 

 Misguided union solidarity 

 Belief that management is not held to the same standard 

 Fear of revenge 

 Fear of isolation from peers  
 

It is the moral and social responsibility of the employees to report unethical or illegal conduct to 
appropriate management and if necessary to those affected by the conduct. If he sees any illegal 
behavior including but not limited to theft, fraud, corruption, embezzlement or bribery. Furthermore 
someone taking or abusing the property of others is including intellectual property. 
 

3. Protect Propriety or Confidential Information  

Protecting confidential and proprietary business information, good will and 
relationships with clients, customers and key employees are matters of most 
important concern to any successful business. Theft of trade secrets, 
harassment of clients and customers, raiding of key employees, employee 
disloyalty and violations of trusty duties can cause irreparable loss.  

The company’s confidential information falls into two main categories:  

1. Information developed and owned by company.  

2. Information temporarily given to company by its customers, collaborators and others.  
 

Every company team member, whether a manager, employee or contractor, has a key role in 
maintaining the company’s confidential information. Following policies can help to protect the 
company’s proprietary and secrets: 

1. The company should establish a written confidentiality protection guide and share it with all staff 
who interact with confidential information related to the company. 

2. Upon hiring, each company staff member should sign a contract that must include a 
confidentiality provision about their confidentiality promises. 

3. The staff member should refrain from disclosing a confidential information until management 
has provided clarification. 

4. A staff member should not disclose confidential information unless the staff member obtains 
authorization from management and the receiving party has signed a confidentiality agreement. 

5. Staff members should not store or keep open the confidential information to on a desktop or 
computer screen exposed to view when not actively used.  

6. A staff member should only share confidential information with only those staff members of 
other company who need to know the information. 

7. The company should prevent unauthorized user access to any electronic and physical areas 
containing confidential information.  For computers, staff members should password protect 

All key staff 
members should 
read and become 
familiar with the 
guide.   

Remember 
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screensavers and password protect files. For hardcopy documents, staff members should limit 
the physical access to the document by locking the office door, locking a desk drawer, locking 
a filing cabinet, and / or restricting room access. 

8. A sender of an email should assume unauthorized readers will view the text and files contained 
in an unencrypted email.  A sender should not send sensitive data in an unencrypted email or 
file. 
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Summary of Module 

 Take responsibility and make corrections instantly, if you make errors or omissions. And others 
are involved then communicate if you come to know that the errors or omissions were caused 
by others, communicate them to the appropriate person as soon they are discovered. 
 

 Always aware of the rules and traditions of others and avoid engaging in behaviors they might 
consider disrespectful. 
 

 If you realize that you have a real or potential conflict of interest, avoid engaging in the decision 
making process or otherwise attempting to influence outcomes until you have made full 
disclosure to the affected stakeholders. 
 

 Do not engage in or ignore behavior that is intended to deceive others, making misleading or 
false statements, stating half-truths, providing information out of context or withholding 
information that, if known, would render your statements as misleading or incomplete. 
 

 You can provide assistance to the manager by coordinating meetings, intimate resource 
availability, creating and keeping documentation, validating company’s defined standards. 
 

 It is a professional approach to apply life cycle methodology to project and define its activities 
as phase like requirement gathering, planning design, prototype, testing and documentation. 
 

 Estimate time accurately for your job or assignment. Follow the steps required for accurate 
estimation of time and cost. Break down the work in smaller manageable pieces and allocate 
time cost and other resources required to get the job done.  
 

 Resource leveling is a technique in project management that deals with resource allocation and 
resolves any possible conflict that can arise from wrong allocation. 
 

 Understand well and follow the specific policies, rules, regulations and laws that govern our 
professional work,   and volunteer activities. 
 

 It is the moral and social responsibility of the employees to report unethical or illegal conduct to 
appropriate management and if necessary to those affected by the conduct.  
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Frequently Asked Questions (FAQs) 

FAQ 1:  
What are the four values that serve as the foundation of ethical and professional 
conduct? 

Answer These are Responsibility, Honesty, Fairness and Respect. 

FAQ 2:  What is meant by fairness? 

Answer 
Fairness is our duty to make decisions and act neutrally and objectively. Our conduct 
must be free from competing self-interest, bias, and favoritism. 

FAQ 3:  What is recurring meeting? 

Answer 
Recurring meetings are where the same group of people regularly gather to 
accomplish the same goal. Its agenda may depend upon the company’s policy. 

FAQ 4:  Which are the main phases of life cycle? 

Answer 
The main phases of a life cycle are requirement gathering, design solution, prototype, 
testing and documentation. 

FAQ 5:  What is prototype? 

Answer 
A prototype is an instance of a working product, representing all the specification of 
final project. Prototype is developed to verify and asses customer’s needs about the 
final product. 

FAQ 6:  What is buffer in time estimate? 

Answer 
The buffer is the supplementary time that worker requires after the completion of the 
service. 

FAQ 7:  What rule is used for work breakdown? 

Answer 
There is no hard and fast rule on how you should breakdown a task in work 
breakdown structure. Rather, the level of breakdown is a matter of the project type 
and the management style followed for the project 

FAQ 8:  What is meant by resource leveling? 

Answer 
Resource leveling is a technique in project management that deals with resource 
allocation and resolves any possible conflict that can arise from wrong allocation 

FAQ 9:  Why is policy important for an organization? 

Answer 
Workplace policies help organization to manage staff more effectively by clearly 
defining acceptable and unacceptable behavior in the workplace, and define the 
effects of not complying with those policies. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  _____________ is our duty to take ownership for the decisions we make.  

a.  Respect b.  Honesty 

c.  Responsibility d.  Fairness 

2.  
____________________ refers to show a high regard for ourselves, others, and the 
resources assigned to us. 

a.  Respect b.  Honesty 

c.  Responsibility d.  Fairness 

3.  The first step of life cycle methodology is _________________. 

a.  Design Solution b.  Requirement Gathering 

c.  Testing d.  Prototype 

4.  Goal of work breakdown is _____________. 

a. 
Giving visibility to important work 
efforts. 

b. Giving visibility to risky work efforts 

c. Show clear ownership by task leaders d.  All of them 

5.  The idea behind resource leveling is ____________. 

a. Reduce wastage of resources b. Purchase resources 

c. Assign resources permanently d.  Estimate time for resources 
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6.  Buffer in time estimate adds _________________ to time estimate. 

a. 30 – 40 % b. 25 – 35 % 

c. 5 – 10 % d.  10 – 25 % 

7.  Select the INCORRECT option: reasons to achieve work breakdown are: 

a. 
Accurate and readable project 
organization 

b. 
Point out the negative points in 
project. 

c. 
Indicates the project milestones and 
control points 

d.  
Helps to estimate the cost, time and 
risk. 

8.  A policy is __________________. 

a. 
A statement which explains how 
human resource management issues 
will be dealt with in an organization. 

b. 
A rule that helps in estimating the time 
for project. 

c. 
A statement that describes the history 
concerns of the organization. 

d.  
All of them 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 a 

3 b 

4 d 

5 a 

6 d 

7 b 

8 a 
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Module 2: Computer Skills 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Install operating system by applying instructional manual.  

 Install as per sequence and according to the instructional 
manual without losing any kind of data (Disk Management and 
Fragmentation). 

 List and Understand functionality of Computer Hardware 
(Mother Board, Processor, Bus, and Firmware (e.g. ROM-BIOS) 
Components.  

 Understand various kinds of peripheral devices.  

 Configure peripheral devices as per recommended manual and 
perform “test” function(s).  

 Troubleshoot different commonly known (Level-1 Support) basic 
computer hardware problems.  

 Perform Basic Internet Connectivity for standalone computer(s)  

 Compose and Type a document draft (Letter, Report, Meeting 
Minute, Resume) with a typing speed of up to 25 words/minute 
by following standardized typing pattern (asdfg ;lkjh) on Qwerty 
keyboards.  

 Perform the combinations of Control, Shift, and Alternative keys 
e.g. Shift+F7 for Similar Words, Ctrl+] to increase text size, 
Shift+F3 for toggle text and Alt+N for New command.  

 Utilize standard menu (toolbar) e.g. Home, Page Layout, 
References, Review hover buttons.  
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 Given any word document, insert table, picture, header/footer, 
endnote, page number, word art, table of contents, etc.  

 Associate data as Hyperlink at a given location of a document or 
storage device with a URL.  

 Explain the nature of document views (Print, Full Screen, Web 
Layout, and Outline Draft). 

 Insert a Section Break at a given location of a word document. 
When clicked on show/hide icon under home menu, different 
breaks should be displayed. 

 Protect a given document. Document by assigning a password 
and making it final.  

 Insert dialog box and grouping shapes.  

 Understand OLE concept.  

 Install and Configure Phonetic Keyboard for Urdu language 
editing in Inpage software.  
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Learning Unit 1: Configure Graphical User Interface 
Enabled System Software 

Overview 

In this learning unit, you will be introduced to basic concepts of configuring graphic user interface and 
learn sharing techniques, computer short cut keys, administrative tools, computer backup and scanning 
system. After completion of this learning unit, you will be able to install operating system in sequential 
order by applying instructional manual. 
 

1. Precautions to be taken to Install Operating System 

The following precautions should be taken before installing an Operating 
System (O.S):  

1. Ensure the System is Compatible 

The hardware must meet the following specifications;  

Processor: Min. 1 GHz or faster for 32(x86)/64-bit 
RAM:  Min. 1 GB for 32-bit / 2GB for 64-bit  
HDD:  Min. available disk space 16 GB for 32-bit and 20 GB 
  for 64-bit 

 

2. Get Data Backup (if the system already contains O.S and data) 
 
 Obtain a secondary storage device like DVD, CD, Flash Drive etc. 
 Make sure that there is enough space available for data backup on the 

selected drive. 
 Copy the whole data to the selected device. 
 Secure the device at a safe place. 

 

3. Create System Restore Point (if system already contains an O.S)  
 
Procedure  to create system restore point  has the following steps: 
 
1. Go to start menu and select control panel. 
2. Click on system and security. 
3. Select system from the list. 
4. Select remote setting. 
5. Select system protection. 
6. Select system restore. 
7. Create your restore point here. 

 

The physical parts of 
a computer system 
are called hardware 
e.g. Monitor, 
keyboard, system 
unit, mouse etc. 

Hardware 

A set of instructions 
that tells the 
computer what to do 
and how to do is 
called software. 

Do you know! 

System restore 
creates a restore 
point in order to 
preserve all previous 
programs and 
configurations. 

System Restore 

Boot Sequence is 
very important in 
order to load 
operating system 
into memory. 

Remember 
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2. Procedure to Install Windows 8 Operating System  

The procedure of installing Windows 8 operating system from DVD, insert the DVD into DVD Drive and 
restart the PC. Then perform the following steps: 
 

  
1. Welcome screen will appear.  2. Copying temporary files screen 

will appear. 

  

3. Setup starting Screen will appear. 4. Select Installation updates option. 

  
5. Agree to the system license. 6. Select type of installation 

(Upgraded or Custom). 

  
7. Checking compatibility Screen will 

appear. 
8. Installing features and updates 

screen will appear. 

The kind of 
installation in which 
features of previous 
version remain in 
addition the features 
of the fresh version. 

Upgraded 

Installation 

Disk formatting is 
the process of 
preparing a data 
storage device such 
as a hard disk drive, 
solid-state drive, 
floppy disk or USB 
flash drive for initial 
use. In some cases, 
the formatting 
operation may also 
create one or more 
new file systems. 

Do you know! 

Logical division of a 
Hard Disk Drive is 
called Partitioning. 

Partitioning 

The process of 
removing previous 
version of an 
operating system 
and installing a fresh 
version. 

Clean Installation 
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9. The systems will restart and 

configure post installation settings. 
Use express settings 
(Recommended). 
 

10.  Start Screen will appear 

3. Executing Common Commands using Help  

Format  a Storage Disk Using Help Command 

Perform the following steps to format a Storage Disk: 

1. Come to the Windows Main Desktop Screen. 
2. Press F1 Function key to run Windows Help Application. 
3. Help interface will open as shown below. 

 

4. Type “Format a Storage Disk” in the search bar and press enter key. 
5. You will find a list of related help links. 

 

6. Click “Formatting disks and drives” link. 

Press F1 to run 
help. 

Short key 

The part of 
Windows O.S that 
allows users to view 
and configure basic 
system settings and 
controls via applets 
such as adding 
hardware, add and 
remove software 
etc. 

Control Panel 
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7. The detailed procedure will appear.  
8. Follow the procedure to format a storage disk. 

 

View the List of Running Processes Using Help Command 

The procedure of using Help command to view the list of running process has 
following steps: 

1. Type “view running process” in the search bar and press enter key. 
2. The following screen will appear. 
 
 

 

 
3. Click on “View Programs running on this computer” link. It will take you to Task Manger where you 

can see all the running programmes. 

 

File Sharing Techniques 

Following operations can be performed on files: 

1. Copy and Paste a file/folder. 
2. Cut and Paste a file/folder. 
 
 
 
 
 
 

The process of 
Logical division of a 
Hard Disk Drive is 
called Partitioning. 

Partitioning 

The given minimum 
specifications are 
required for windows 
7 Operating System. 
Different O.S may 
have different 
Hardware 
requirements. 

Installation 

requirements 

New features of 
windows O.S for 
better performance 
and services. 

Windows updates 
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Steps to Copy and Paste File(s) / Folder(s) 

1. Click the file(s) you want to copy 
2. Right click on any selected file 
3. From the menu click Copy 
4. Go to the destination 
5. Right Click at the destination 
6. Click Paste option 

 
 

 

 

Steps to Cut and Paste File(s) 

The following are the steps to cut and paste 
file(s): 

1. Click the file(s) you want to cut. 
2. Right click on any selected file. 
3. From the menu click Cut. 
4. Go to the destination. 
5. Right Click at the destination. 
6. Click Paste option. 

 

 

  

ST
EP

-1
 

ST
EP

-2
 

ST
EP

-1
 

ST
EP

-2
 

Keyboard shortcuts 
are combinations of 
two or more keys 
that you can use to 
perform a task that 
would typically 
require a mouse or 
other pointing 
device. Keyboard 
shortcuts can make 
it easier to work with 
your PC, saving you 
time and effort as 
you work with 
Windows and other 
apps. 

Keyboard 

Shortcuts 
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4. Computer Shortcut Keys  

There are certain shortcuts you can use. Some of most frequently used shortcut keys are given below: 
 

Ease of Access 

Right Shift for eight seconds Turn Filter Keys on and off 

Left Alt+Left Shift+PrtScn (or 
PrtScn) 

Turn High Contrast on or off 

Left Alt+Left Shift+Num Lock Turn Mouse Keys on or off 

Shift five times Turn Sticky Keys on or off 

Num Lock for five seconds Turn Toggle Keys on or off 

Windows logo key +U Open the Ease of Access Center 

General 

F1 Display Help 

Ctrl+C or Ctrl+Insert Copy the selected item 

Ctrl+X Cut the selected item 

Ctrl+V or Shift+Insert Paste the selected item 

Ctrl+Z Undo an action 

Ctrl+Y Redo an action 

Delete or Ctrl+D Delete the selected item and move it to the Recycle Bin 

Shift+Delete Delete the selected item without moving it to the Recycle Bin first 

F2 Rename the selected item 

Ctrl+Right Arrow Move the cursor to the beginning of the next word 

Ctrl+Left Arrow Move the cursor to the beginning of the previous word 

Ctrl+Down Arrow Move the cursor to the beginning of the next paragraph 

Ctrl+Up Arrow Move the cursor to the beginning of the previous paragraph 

Ctrl+Shift with an arrow key Select a block of text 

Shift with any arrow key 
Select more than one item in a window or on the desktop, or 
select text within a document 
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Ctrl with any arrow 
key+Spacebar 

Select multiple individual items in a window or on the desktop 

Ctrl+A Select all items in a document or window 

F3 Search for a file or folder 

Alt+Enter Display properties for the selected item 

Alt+F4 Close the active item, or exit the active program 

Alt+Spacebar Open the shortcut menu for the active window 

Ctrl+F4 
Close the active document (in programs that allow you to have 
multiple documents open simultaneously) 

Alt+Tab Switch between open items 

Ctrl+Alt+Tab Use the arrow keys to switch between open items 

Ctrl+Mouse scroll wheel Change the size of icons on the desktop 

Windows logo key +Tab Cycle through programs on the taskbar by using Aero Flip 3-D 

Ctrl+Windows logo key +Tab 
Use the arrow keys to cycle through programs on the taskbar by 
using Aero Flip 3-D 

Alt+Esc Cycle through items in the order in which they were opened 

F6 Cycle through screen elements in a window or on the desktop 

F4 Display the address bar list in Windows Explorer 

Shift+F10 Display the shortcut menu for the selected item 

Ctrl+Esc Open the Start menu 

Alt+underlined letter Display the corresponding menu 

Alt+underlined letter Perform the menu command (or other underlined command) 

F10 Activate the menu bar in the active program 

Right Arrow Open the next menu to the right, or open a submenu 

Left Arrow Open the next menu to the left, or close a submenu 

F5 or Ctrl+R Refresh the active window 

Alt+Up Arrow View the folder one level up in Windows Explorer 

Esc Cancel the current task 

Ctrl+Shift+Esc Open Task Manager 
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Shift when you insert a CD Prevent the CD from automatically playing 

Left Alt+Shift 
Switch the input language when multiple input languages are 
enabled 

Ctrl+Shift 
Switch the keyboard layout when multiple keyboard layouts are 
enabled 

Right or Left Ctrl+Shift 
Change the reading direction of text in right-to-left reading 
languages 

Dialog Box 

Ctrl+Tab Move forward through tabs 

Ctrl+Shift+Tab Move back through tabs 

Tab Move forward through options 

Shift+Tab Move back through options 

Alt+underlined letter 
Perform the command (or select the option) that goes with that 
letter 

Enter Replaces clicking the mouse for many selected commands 

Spacebar Select or clear the check box if the active option is a check box 

Arrow keys Select a button if the active option is a group of option buttons 

F1 Display Help 

F4 Display the items in the active list 

Backspace 
Open a folder one level up if a folder is selected in the Save As 
or Open dialog box 

Windows Logo Key 

Windows logo key Open or close the Start menu. 

Windows logo key +Pause Display the System Properties dialog box. 

Windows logo key +D Display the desktop. 

Windows logo key +M Minimize all windows. 

Windows logo key +Shift+M Restore minimized windows to the desktop. 

Windows logo key +E Open Computer. 

Windows logo key +F Search for a file or folder. 

Ctrl+Windows logo key +F Search for computers (if you're on a network). 
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Windows logo key +L Lock your computer or switch users. 

Windows logo key +R Open the Run dialog box. 

Windows logo key +T Cycle through programs on the taskbar. 

Windows logo key +number 
Start the program pinned to the taskbar in the position indicated 
by the number. If the program is already running, switch to that 
program. 

Shift+Windows logo key 
+number 

Start a new instance of the program pinned to the taskbar in the 
position indicated by the number. 

Ctrl+Windows logo key 
+number 

Switch to the last active window of the program pinned to the 
taskbar in the position indicated by the number. 

Alt+Windows logo key +number 
Open the Jump List for the program pinned to the taskbar in the 
position indicated by the number. 

Windows logo key +Tab Cycle through programs on the taskbar by using Aero Flip 3-D. 

Ctrl+Windows logo key +Tab 
Use the arrow keys to cycle through programs on the taskbar by 
using Aero Flip 3-D. 

Ctrl+Windows logo key +B 
Switch to the program that displayed a message in the 
notification area. 

Windows logo key +Spacebar Preview the desktop. 

Windows logo key +Up Arrow Maximize the window. 

Windows logo key +Left Arrow Maximize the window to the left side of the screen. 

Windows logo key +Right Arrow Maximize the window to the right side of the screen. 

Windows logo key +Down Arrow Minimize the window. 

Windows logo key +Home Minimize all but the active window. 

Windows logo key +Shift+Up 
Arrow 

Stretch the window to the top and bottom of the screen. 

Windows logo key +Shift+Left 
Arrow or Right Arrow 

Move a window from one monitor to another. 

Windows logo key +P Choose a presentation display mode. 

Windows logo key +G Cycle through gadgets. 

Windows logo key +U Open Ease of Access Center. 

Windows logo key +X Open Windows Mobility Center. 

Windows Explorer 

Ctrl+N Open a new window 

Ctrl+W Close the current window 
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Ctrl+Shift+N Create a new folder 

End Display the bottom of the active window 

Home Display the top of the active window 

F11 Maximize or minimize the active window 

Ctrl+Period (.) Rotate a picture clockwise 

Ctrl+Comma (,) Rotate a picture counter-clockwise 

Num Lock+Asterisk (*) on 
numeric keypad 

Display all subfolders under the selected folder 

Num Lock+Plus Sign (+) on 
numeric keypad 

Display the contents of the selected folder 

Num Lock+Minus Sign (-) on 
numeric keypad 

Collapse the selected folder 

Left Arrow 
Collapse the current selection (if it's expanded), or select the 
parent folder 

Alt+Enter Open the Properties dialog box for the selected item 

Alt+P Display the preview pane 

Alt+Left Arrow View the previous folder 

Backspace View the previous folder 

Right Arrow 
Display the current selection (if it's collapsed), or select the first 
subfolder 

Alt+Right Arrow View the next folder 

Alt+Up Arrow View the parent folder 

Ctrl+Shift+E Display all folders above the selected folder 

Ctrl+Mouse scroll wheel Change the size and appearance of file and folder icons 

Alt+D Select the address bar 

Ctrl+E Select the search box 

Ctrl+F Select the search box 

Taskbar 

Shift+Click on a taskbar button Open a program or quickly open another instance of a program 

Ctrl+Shift+Click on a taskbar 
button 

Open a program as an administrator 
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Shift+Right-click on a taskbar 
button 

Show the window menu for the program 

Shift+Right-click on a grouped 
taskbar button 

Show the window menu for the group 

Ctrl+Click on a grouped taskbar 
button 

Cycle through the windows of the group 
 

 

5. Administrative Tools  

Following are the most commonly used administrative tools:  

1. Computer Management 
2. Event viewer 
3. Performance Monitor 
4. Services 
5. Boot Sequence 
6. Task Scheduler 
7. Registry Editor 

 

Steps to Take System Backup  

Following are the strategies to take system backup: 

1. Create system restore point 
2. Incremental Backup 
3. Differential Backup 

 

Steps to Create System Restore Point 

To create a restore point, you need to; 

1. Open System by clicking the Start button, right-clicking Computer, and then clicking 
Properties.  

2. In the left pane, click System protection. If you're prompted for an administrator password or 
confirmation, type the password or provide confirmation. 

3. Click the System Protection tab, and then click Create. 

4. In the System Protection dialog box, type a description 

5. Click Create. 

Administrative Tools is a folder in Control Panel that contains tools for system administrators and 
advanced users. The tools in the folder might vary depending on which version of Windows you are 
using. 

 

A restore point is a 
representation of a 
stored state of your 
computer's system 
files. You can use a 
restore point to 
restore your 
computer's system 
files to an earlier 
point in time. 

Restore Point 

There are two types 
of backup i.e 
Incremental and 
Differential. 

Types of Backup 
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Open Administrative Tools by clicking the Start button, and then clicking Control Panel. In the search 
box, type administrative tools, and then click Administrative Tools.  

Many of the tools in this folder, such as Computer Management, are Microsoft Management Console 
(MMC) snap-ins that includes their own help topics. To view specific help for an MMC tool, or to search 
for an MMC snap-in that you don't see in the following list, open the tool, click the Help menu, and then 
click Help Topics. Some common administrative tools in this folder include: 

Component Services. Configure and administer Component Object Model (COM) 
components. Component Services is designed for use by developers and administrators. 

Computer Management. Manage local or remote computers by using a single, consolidated 
desktop tool. Using Computer Management, you can perform many tasks, such as monitoring 
system events, configuring hard disks, and managing system performance. 

Data Sources (ODBC). Use Open Database Connectivity (ODBC) to move data from one type 
of database (a data source) to another.  

Event Viewer. View information about significant events, such as a program starting or 
stopping, or a security error, which are recorded in event logs. 

iSCSI Initiator. Configure advanced connections between storage devices on a network. 

Local Security Policy. View and edit Group Policy security settings. 

Performance Monitor. View advanced system information about the central processing unit 
(CPU), memory, hard disk, and network performance. 

Print Management. Manage printers and print servers on a network and perform other 
administrative tasks. 

 

6. System Backup 

When you set the Backup Type setting to Full, all the files and folders on the drive are backed up every 
time you use that file set. To set the backup type, click Options on the Settings menu, and then click 
the Backup tab. Steps to perform full backup are as under: 

1. In Backup, click the drives, files, or folders to back up, and then click Next Step.  

2. Click the destination (where you want the files backed up to).  

3. On the Settings menu, click Options, click the Backup tab, click "Full: backup of all selected 
files," and then click OK.  

4. On the File menu, click Save As and name your backup set. Once saved, click Start Backup. 

5. Provide a name for the selected drive, files, or folders in the Backup Set Label dialog box, and 
then click OK. 
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Incremental Backup 

An incremental backup differs from the other types of backup. The difference is that Windows 8 
incremental backup saves only the data from last successful incremental backup. The “incremental 
restore” will usually take more time comparing to using restore from the other types of backups. Steps 
to perform incremental backup: 

1. On the File menu, click Open File Set. Click the file set you want to use, and then click Open. 
Click Next Step.  

2. Click the destination (where you want the files backed up to).  

3. On the Settings menu, click Options, click the Backup tab, click "Full: backup of all selected 
files," and then click OK.  

4. On the File menu, click Save to save your backup set.  

5. Repeat steps 1 and 2. 

6. On the Settings menu, click Options, click the Backup tab 

7. Click "Incremental: backup of selected files that have changed since the last full back up," and 
then click OK. 

Differential Backup 

Differential backup is more elegant backup utility, because in fact every time 
you do a differential backup you save not all the data, but only changes made 
since the last full backup. Remember yourself, do you reinstall your programs 
every day, or make significant changes to the registry? In below pictures, it is 
shown schematically how that works: 

 

 

 

 

 

 
  

Incremental and 
differential backups 
keep only the 
differences, so they 
require less disk 
space and time. 

Incremental Vs 

Differential Backup 
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7. Local Security Policy 

To Open Local Security Policy Editor, follow the steps given below: 

1. Open the Control Panel (icons view), and click/tap on the Administrative Tools icon. Close the 
Control Panel window. Then, double click/tap on Local Security Policy to open it, and go to step 
2 below. 

2. If prompted by UAC, click/tap on Yes. Note: If you did step 2, then you can now close the 
Administrative Tools window if you like. 

3. You can now set and manage the Local Security Policies on your computer to how you want 
them. 

 

Scan Devices for Viruses/Worms 

Following a the steps to perform a scan using AVG: 

1. Open the AVG Program. 

2. Click the Update Now button to make sure that AVG is fully up-to-date. 

3. Click the Scan options button. 

4. Click the Change scan settings blue text within the Whole computer scan button. 

5. Make sure that all available check boxes are selected (except the Scan for Tracking Cookies 
option). 

6. Click the Additional scan settings... blue text, and then click All file types. 

7. Click OK, and then click Start scan. 
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Learning Unit 2: Configure Peripheral Devices  

Overview 

In this learning unit, you will learn the methods and techniques for configuring the peripheral devices, 
capacitor, types and usage of ports, hardware problems and their solution and basic features of 
internet. After the completion of this learning unit, you will be able to understand functionality of various 
kinds of peripheral devices and will be able to configure peripheral devices as per recommended 
manual and perform “test” function(s) and troubleshoot basic hardware problems and perform basic 
internet features.  

 

1. Peripheral Devices 

A peripheral device is generally defined as any auxiliary device such as a 
computer mouse or keyboard that connects to and works with the computer in 
some way. Other examples of peripherals are image scanners, tape drives, 
microphones, loudspeakers, webcams, and digital cameras.  

 

Input Devices: 

1. Mouse and keyboard. 
2. KVM = keyboard video and monitor switch. 
3. Scanners and barcode readers. 
4. Biometric devices. 
5. Game pads and joysticks. 
6. Microphones. 
7. Digitizers (capturing an analog signal in a digital format). 

 

They are add-on 
components that are 
external to the PC. 
They add 
capabilities that 
were not present 
when the system 
was built. They have 
a connection to the 
computer and utilize 
drivers to 
communicate with 
the OS and other 
peripherals. 

Remember 

They can be broken 
out into three basic 
categories: input 
devices (e.g., 
keyboard/mouse, 
KVM, scanners), 
output devices (e.g., 
printers, video 
displays, speakers), 
or multimedia 
devices (e.g., 
camcorders, 
webcams, MIDI). 

Remember 
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Output Devices: 

1. Printers. 
2. Speakers. 
3. Display devices. 

 

Multimedia Devices: 

1. Digital cameras, camcorders, and webcams. 

2. MIDI = Musical Instrument Digital Interface. 

 

Connecting Peripheral Devices 

Peripheral devices can be connect to the PC with different ways.   Some wired connections include: 
through a serial port, through a PS/2 port, and via a USB port. Peripheral devices may also be 
connected wirelessly. If manufacturers require a proprietary type of connection, it is up to them to 
provide the means of making the connection. Read the installation instruction before installing to reduce 
frustration. 

 

2. Capacitor, VLSI, PCB, and FPGA   

Capacitor 

A capacitor (originally known as a condenser) is a passive two-terminal electrical component used to 
store electrical energy temporarily in an electric field. 

VLSI 

VLSI (Very Large Scale Integration) is a technology that helps us integrate millions of transistors in one 
small chip. It is a structured design flow that enables millions of transistors to sit together and work on 
a single microchip by saving microchip area. This comes under the Circuit Design process flow 

FPGA 

A Field Programmable Gate Array (FPGA) is an integrated circuit designed to be configured by a 
customer or a designer after manufacturing – hence "field-programmable". The FPGA configuration is 
generally specified using a Hardware Description Language (HDL), similar to that used for an 
Application Specific Integrated Circuit (ASIC), (Circuit diagrams were previously used to specify the 
configuration, as they were for ASICs, but this is increasingly rare). 

 

 

 

 



Module 2: Computer Skills 

Teaching and Learning Material: Information Technology (Office Assistant)                                                                            | 37 

3. Steps to Configuring Peripheral Devices with Software Driver (s)  

Monitors 

Before connecting or disconnecting a monitor, ensure that the power to both the PC and the monitor 
is off. Then connect a VGA (DB-15) cable from the monitor to the PC’s video card, and connect the 
monitor’s power cord to an AC outlet. 

Modems 

There are two types of modems:   

Internal modems; These are installed as expansion cards inside a computer. 

External modems; They have their own power supplies and connect to an external COM port with an 
RS-232 cable or to a USB port.  

Internal modems are usually smaller and cheaper than their external counterparts. However, they are 
more difficult to configure, especially if they are not Plug and Play. You need to configure them to use 
an unused COM port. Non-PnP internal modems have jumpers on them for setting the resources to 
use.  

External modems use an existing serial port (legacy serial port or USB), so they don’t have the 
configuration problem with IRQs and I/O addresses. A legacy serial external modem must be 
connected with the power off for both the PC and the modem. A USB modem can be connected or 
disconnected to the computer at any time. External modems have their own power supplies that 
connect to an AC outlet. 

Digital Cameras 

Most digital cameras connect to a PC via a USB interface. When the camera is connected, the camera 
appears as a removable drive in My Computer, and you can browse its contents to examine the 
pictures. You can then copy the pictures to the PC’s hard disk with drag-and-drop through a regular 
file-management interface. 

Wireless Access Points, Hubs, and Routers 

A wireless access point is like a network hub. It works independently of any network node and 
continues to function even when the PCs are turned off. However, you can configure it by entering its 
IP address into a web browser interface. Check the documentation to find out the IP address to use 
and the username and password required for access to it. 

Infrared Devices 

Infrared ports are most often associated with notebook PCs, although any PC may have one installed 
as an add-on. An infrared device is automatically recognized through the operating system whenever 
it comes into range of the PC, and it’s available through the infrared port. For example, when an infrared 
printer comes into range, the printer is detectable. 

Printers 

Almost all printers are Plug and Play, such that Windows can automatically detect them and either 
install a driver automatically or prompt you for a Setup disk. To set up a printer, use the Add Printer 
Wizard through the Printers applet in the Windows Control Panel. 
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Some printers have their own special queue software. If possible, run the Setup utility that comes with 
the printer. A printer may have either a legacy parallel or USB interface. If it’s legacy parallel, both the 
printer and the PC must be powered off to make the connection; if it’s USB, the connection can be 
made at any time. 
 

4. Types of Computer Ports  

With passage of time new technologies are incorporating with old one and they are bringing more and 
more users to avail chance of using best gifts of technology. Just like that new kinds of ports are also 
becoming popular with new devices. Some of famous and new ports are given as below: 

PS/2 Ports are most simple and oldest type of ports, and are still working in market with systems. 
These are 6-pin, low-speed serial connection ports which are used with mouse and keyboards mostly. 
In system two ports of this kind are found, although they look similar but they are not interchangeable. 
It is important to be extremely careful to attach the keyboard and mouse to their respective PS/2 port. 

VGA Monitor Port is used to display Video Graphics Array in your system. This port uses an analog 
monitor which forward signals towards display adapter. All monitors and LCDs accept these signals, 
but some flat displays prefer to use digital signal interface.  VGA resolution typically refers to the original 
resolution of 640×480 pixels and 16 colors, but it is not preferred to use for small monitors or displays. 

USB ports are popular now as they have replaced many old ports from systems now. They have take 
place of old printer hook-ups, and these port are also addition ways for transferring data and add 
accessories to a system. Flash drives are biggest examples for these ports, which are connected on 
these ports only. These ports are also helping Smartphone users, as they can now transfer data very 
easily from computer to their phones. 

Serial ports are designed to handle all processes of a system. This port consist 9 to 24 pins and are 
able to send data in range of more than 18 feet. Serial ports have ability to do one and two way data 
transmission with complete responsibility. 

Parallel ports consisted of 25 holes or pins and commonly connected the devices to system. 
Performance capability of these ports is much faster as compared to serial ports and other types of 
ports. These ports are built in mother board and consist of 25 wires, 8 of those wires are responsible 
to transfer data and control complete circuit. 

RJ45 Ethernet Port is famous to use for connecting your system with local area networks. It look like 
connector of telephone wire but it is little wider than that. 
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Computer Ports 
 

5. Solutions for Hardware Failure  

Common hardware failures of PCs and their solutions are discussed below: 

1. Computer Freeze 

Heat is the measure Reason for PC hardware problems. Ensure if it’s computer freeze or lockup. 
Generally, your computer temperature is controlled by the internal fan called the Heat Sink. Dust is 
another enemy of PC hardware as it sticks on motherboard and electrical components. You can control 
overheating by removing dust from around the internal fan. 

2. System Error Blue Screen 

Often it is seen that a blue screen appears suddenly while you are working or when you start your 
computer. This is usually due to either a hardware failure or a driver problem. Reinstalling the driver or 
correcting the hardware problem can help to solve the issue. If nothing seems to work, you should 
consider backing up and re-formatting your Hard Drive, then reinstalling your operating system. 
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3. RAM Faults and Errors 

Whenever RAM fault occurs your monitor shows a blue screen with a memory reference like x000xxxx 
as a boot interruption. RAM faults cannot be prevented but you can fix them. There may be frequent 
PC restarts. This is due to faulty RAM chips. These Faulty RAM chips are unable to store the boot 
loader or NT loader file therefore the OS cannot find it and hence it shuts down all the processes, due 
to non-availability of the boot loader file in the RAM as a result the PC restarts again and again. This 
problem can be fixed by replacing the old RAM with a new one. You must know the model compatibility 
of you motherboard before buying a new RAM. It may be DDR, DDR2 or DDR3.   

4. Noisy Computer 

It means that the computer system is making noise while running. The reason of noisy computer is 
dirty condition fan. The dust particles sticks on the fan including the heat sink and other parts such as 
motherboard and other electrical parts of computer .This dust blocks the smooth action of fan and 
causing the fan to make noise. Clean your system completely by removing motherboard from its place 
and also clean the fan and heat sink with a brush or soft cloth. 

6. Basic Features of Internet 

The Internet is a collection of computers that share information. Home users commonly use a phone 
modem, cable modem, or DSL connection to connect to the Internet. An Internet Service Provider (ISP) 
connects the home user to other computers. Files that are transferred over the Internet are called Web 
pages. Computers that store these Web pages are called Web servers. For Web servers to work 
effectively, it must always be connected to the Internet. The main features of Internet: 

 Connect to people in just a moment  

 Emailing and transferring of files 

 Internet calls 

 Online shopping 

 Websites and Blogs 

 Online advertisement 

 Watching TV  

 Playing online games 

Electronic Email 

E-mail is defined as the transmission of messages over communications networks. Typically the 

messages are notes entered from the keyboard or electronic files stored on disk. Most mainframes, 
minicomputers, and computer networks have an email system. 

Web Suffering 

To navigate through the World Wide Web or Internet, usually by click- ing with a mouse. The 
term also has a generic meaning of spending time on the Internet. 
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Learning Unit 3: Business Writing 

Overview 

In this learning unit, you will be introduced to compose business writings. After the completion of this 
learning unit, you will be able to compose and type a document draft like letters, reports, minutes of 
meeting, resume etc. 
 

1. Installing Microsoft Office Suit  

Install or Remove Individual Office Program 

If you   want to install custom programs from your Office suite - for example, 
you have Office Home and Business and want to install Word, Excel, 
PowerPoint and Outlook but not OneNote. You can choose a custom 
installation during setup as  

1. Initiate the installation of your Office suite. 

2. In the Choose the installation you want dialog box, click Customize. 

3. On the Installation Options tab, right click the programs that you do not 

want installed, and then click  Not Available. 

4. Click Install now to complete the custom installation.  

 

Uninstall Office 

1. Click the Start button, and then click Control Panel. 

2. Do one of the following: 

 Windows 7 and Windows Vista   Click Programs, and then click Programs and Features. Click 
the name of the Office suite that you want to remove, and then click Uninstall. 

Note   In Classic view, double-click Programs and Features. Click the name of the Office suite that you 
want to remove, and then click Uninstall. 

 Microsoft Windows XP    Click Add or Remove Programs, and then click Change or Remove 
Programs. Click the name of the Office suite that you want to remove, and then click Uninstall. 

Note   In Classic view, double-click Add or Remove Programs, click the name of the Office suite that 
you want to remove, and then click Uninstall. 

3. Follow the prompts to complete the removal. 

 

 

Always use licensed 
software. 

Remember 

You can’t remove 
Office programs 
individually after the 
suite has been 
installed. You must 
uninstall Office 
completely, and then 
reinstall it using a 
custom installation 
following the steps 
outlined above. 

Remember 
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2. Steps to Adjust Page Margins, Size and Layout  

Choose page margins using predefined settings using following: 

1. On the Page Layout tab, in the Page Setup group, click Margins. The Margins gallery appears as 
shown below. 

 

2. Click the margin type that you want to apply. 

If your document contains multiple sections, the new margin type will only be applied to the current 
section. If your document contains multiple sections and you have multiple sections selected, the new 
margin type will be applied to each section you have selected. 
 

3. Document Editing Features  

Editing and Formatting Text 

Before you edit or format text, you must first select the text. Follow the steps below to select text: 

 Place the curser at the beginning of the text you’d like to edit or format and then press the left 
mouse button. 

 While holding down the left mouse button, move it to the right (called “dragging”) to select the 
text. A background color is added in the location of the selected text to indicate the selection 
range. 
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Most text formatting tools are found by clicking the Home tab and then choosing from the Font group. 

 

1. This is the Home tab. 
2. This is the Font group on the Home tab. 
3. This is the Bold button. See the table below for the names and functions of all the buttons in the 

Font group. 

 

Button Name Function 

 

Font Changes the font. 

 

Font Size Changes the size of the text. 

 

Grow Font Increases the text size. 

 

Shrink Font Decreases the text size. 

 

Change Case 
Change all the selected text to uppercase, lowercase, or 
other common capitalizations. 

 

Clear Formatting 
Clears all formatting for the selected text, leaving only the 
plain text. 

 

Bold Makes the selected text bold. 

 

Italic Italicizes the selected text. 

 

Underline 
Draws a line under the selected text. Click the dropdown 
arrow to select the type of underline. 

 

Strikethrough Draws a line through the middle of selected text. 

 

Subscript Creates subscript characters. 

 

Superscript Creates superscript characters. 

 

Text Effects 
Apply a visual effect to selected text, such as shadow, 
glow, or reflection. 

 

Text Highlight Color Makes text look like it was marked with a highlighter pen. 

 

Font Color Changes the text color. 
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4. Saving and Opening a Document 

Save and Open a Document 

In M.S Word, you must save your document so you can quit the program without losing your work/data. 
When you save the document, it is stored as a file on your computer. Later, you can open the file, 
change it, and print it. To save a document, do the following: 

1. Click the Save button in the Quick Access toolbar. 

2. Specify the location where you want to save the document in the Save in box. The first time you 
save your document, the first line of text in the document is pre-filled in as the file name in the File 
name box. To change the file name, type in a new file name. 

3. Click Save. 

The document is saved as a file. The file name in the Title Bar changes to reflect the saved file name. 
 

5. Steps to Create a Table  

The following are steps to Create a Table: 

Use the Table Menu 

1. Click where you want to insert a table. 

2. On the Insert tab, in the Tables group, click Table, and then, under Insert Table, drag to select 
the number of rows and columns that you want. 

 

The document is saved as a file. The file name in the Title Bar changes to reflect the saved file name. 

 

Applying Table Designs 

After you create a table, you can format the entire table by using Table Styles. By resting your pointer 
over each of the preformatted table styles, you can preview what the table will look like. 

1. Click in the table that you want to format. 

2. Under Table Tools, click the Design tab. 
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3. In the Table Styles group, rest the pointer over each table style until you find a style that you 

want to use. Note:   To see more styles, click the arrow . 

4. Click the style to apply it to the table. 

In the Table Style Options group, select or clear the check box next to each the table element to apply 
or remove the selected style. 
 

6. Inserting Links  

Adding a Bookmark 

1. Select the text or item to which you want to assign a bookmark, or click 
where you want to insert a bookmark. 

2. On the Insert tab, in the Links group, click Bookmark. 

3. Under Bookmark name, type or select a name.  

Bookmark names must begin with a letter and can 
contain numbers. You can't include spaces in a 
bookmark name. However, you can use the underscore 
character to separate words — for example, 
"First_Heading." 

4. Click Add. 

 

Creating a Cross-Reference 

You can't cross-reference something that doesn't exist, 
so be sure to create the chart, heading, page number, 
etc. When you insert the cross-reference, you will see a 
dialog box that lists everything that' is available to link. You can see in the below example:   
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Insert the Cross-Reference 

1. In the document, type the text that begins the cross-reference. For 
example, "See Figure 2 for an explanation of the upward trend." 

2. On the Insert tab, click Cross-reference.  

3. In the Reference type box, click the drop-down list to pick what you want 
to link to. The list of what's available depends on the type of item (heading, page 

number, etc.) you're linking to.  

 

4. In the Insert reference to box, click the information you want inserted in the document. Choices 
depend on what you chose in step 3. 

 

5. In the For which box, click the specific item you want to refer to, such as "Insert the cross-
reference."  

6. To allow users to jump to the referenced item, select the Insert as hyperlink check box. 
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7. If the Include above/below check box is available, check it to include specify the relative position 
of the referenced item. 

8. Click Insert. 

 

Insert a Hyperlink 

1. Select the text or picture that you want to display as the hyperlink. 

2. On the Insert tab, in the Links group, click Hyperlink. You can also right-click the text or picture 
and then click Hyperlink on the shortcut menu. 

3. Do one of the following:  

 To link to an existing file or Web page, click Existing File or Web Page under Link to, 
and then type the address that you want to link to in the Address box. If you don't know 
the address for a file, click the arrow in the Look in list, and then navigate to the file that 
you want. 

 To link to a file that you haven't created yet, click Create New Document under Link to, 
type the name of the new file in the Name of new document box, and then, under When 
to edit, click Edit the new document later or Edit the new document now. 

Note: To customize the ScreenTip that appears when you rest the pointer over the hyperlink, click 
ScreenTip and then type the text that you want. If you don't specify a tip, Word uses the path or address 
of the file as the tip. 
 

7. Header and Footer 

Insert a Predefined Header or Footer  

 On the Insert tab, in the Header & Footer group, click Header or Footer. 

 Click the header or footer design that you want. 
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Note:    

 If you don't see a gallery of header or footer designs, there might be a problem with the Building 
Blocks template on your computer. The header or footer is inserted on every page of the 
document. 

 If necessary, you can format the text in the header or footer by selecting the text and using the 
formatting options on the Mini toolbar, which is a part of the Microsoft Office Fluent interface. 

 If you want to switch to a different predefined header or footer, repeat these steps, and choose 
a different header or footer from the gallery. 

 

Insert a Custom Header or Footer 

 On the Insert tab, in the Header & Footer group, click Header or Footer. 

 Click Edit Header or Edit Footer. 

 Type text or insert graphics and other content by using the options in the 
Insert group on the Design tab, under the Header & Footer Tools tab. 

 

Tip:   To save the header or footer that you created to the gallery of header or footer options, select 
the text or graphics in the header or footer, and then click Save Selection as New Header or Save 
Selection as New Footer. 

 

8. Inserting Section Breaks 

To insert a section break, click Page Layout, click Breaks, and then click the section break that you 
want to add. 

 

A Next Page section break starts the new section on the next page. 

A Continuous section break starts the new section on the same page. 
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A continuous section break is useful when you want to change the formatting, such as changing the 
number of columns, without starting a new page. 

 

An Even Page or an Odd Page section break starts the new section on the next even-numbered or 
odd-numbered page. 

 

When you want document chapters to begin on an odd page, use an Odd page section break. 
 

9. Insert a Column Break 

To change a section’s layout into columns, click Page Layout, click Columns, and then click the number 
of columns that you want. For example, you can add a Continuous section break and then lay out part 
of a single-column page as two columns. 

 

1. Section formatted as a single column. 

2. Section formatted as two columns. 

The section break is like a fence that encloses your column formatting. But if you remove a section 
break, the text above becomes part of the section that was below the break, and it’s formatted like that 
text.  
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Let’s look at the example in the picture above. If we remove the section break between the first and 
second sections, the entire document will be formatted in two columns, because that’s the formatting 
below the section break. 

 

10. Section Break Vs Page Break 

After a page break, the following text will start at the beginning of the next page. Section Breaks split 
your document into sections, enabling you to have different formatting for each section: for example - 
different page numbering, margins, header/footers, page orientation and borders. 

 

11. Insert a Spreadsheet 

When you create a new worksheet within a document, the worksheet is inserted in the document as 
an embedded object. 

1. Place the insertion point where you want to create the worksheet. 

2. On the Insert tab, in the Tables group, click Table, and then click Excel Spreadsheet. 

 

Fill in the worksheet with the information that you want. 

 

12. Customize In-Page for Phonetic Keyboard 

Run In-Page by double clicking on the INPAGE.exe file. 
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13. Type the Urdu Language Text 

The following Phonetic keyboard layout will help you typing Urdu text. 

 

 

 

 

 

 

 

 

 

STEP
-1

 

STEP
-2 

STEP
-3 
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14. Execute the Text Editing Instructions 

After typing the text select the text and follow the steps mentioned in the given picture to edit the text. 

 

 

 

 

 

  

STEP-1: 

Select the Text 

STEP-2: 

Click the Urdu 

font combo box 

STEP-3: 

Click your desired 

font 
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Summary of Module 

 Computer is a combination of software and hardware. Hardware needs an operating system 
that provides interface to a user. 
 

 This module explains the procedure for the installation of windows 8 operating system. 
 

 Administrative Tools is a folder in Control Panel that contains tools for system administrators 
and advanced users. The tools in the folder might vary depending on which version of Windows 
you are using. 
 

 An incremental backup differs from the other types of backup. The difference is that Windows 
8 incremental backup saves only the data from last successful incremental backup. The 
“incremental restore” will usually take more time comparing to using restore from the other types 
of backups. 
 

 After the installation of operating system configuration process begins where settings are made 
according to the user requirements Administrative Tools is a folder in Control Panel that 
contains tools for system administrators and advanced users. The tools in the folder might vary 
depending on which version of Windows you are using. 
 

 Peripheral devices like mouse, keyboard, printer, scanner etc., are also essential for giving 
input to the computer system and getting output accordingly. 
 

 The Internet is a collection of computers that share information. Home users commonly use a 
phone modem, cable modem, or DSL connection to connect to the Internet. 
 

 For business writing Microsoft Word Processing software is used. This module elaborated and 
covers all of the important aspects for preparing a word document for writing letters, reports, 
resume etc. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is an operating system? 

Answer 
A set of instructions that coordinates between computer software and computer 
hardware is called an operating system. 

FAQ 2:  What do you understand by the term installation? 

Answer 
Installation (or setup) of a computer program (including device drivers and plugins), is 
the act of making the program ready for execution. 

FAQ 3:  What are the commonly used applications available in Microsoft Office Suit? 

Answer Microsoft Word, Excel, Power Point, Access etc. 

FAQ 4:  Define disk formatting? 

Answer 
Disk formatting is the process of preparing a data storage device such as a hard disk 
drive, solid-state drive, floppy disk or USB flash drive for initial use. In some cases, the 
formatting operation may also create one or more new file systems. 

FAQ 5:  Define ports? 

Answer 
An interface on a computer to which you can connect a device. Personal computers 
have various types of ports. 

FAQ 6:  List down the different types of ports? 

Answer 

There are two types of ports i.e. internal and external. Internally, there are several 
ports for connecting disk drives, display screens, and keyboards. Externally, personal 
computers have ports for connecting modems, printers, mice, and other peripheral 
devices. 

FAQ 7:  What is a word processing program? 

Answer 
Applications software that allows user to create letters, applications and reports etc. 
e.g Microsoft word. 

FAQ 8:  What is spread sheet program? 

Answer 
Table of data arranged in columns and rows often used in business and financial 
applications. Spreadsheet software programs are widely used computer applications 
that allow the user to organize large amounts of data. 
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FAQ 9:  What are peripheral devices? Give examples? 

Answer 

A peripheral device is generally defined as any auxiliary device such as a computer 
mouse or keyboard that connects to and works with the computer in some way. Other 
examples of peripherals are image scanners, tape drives, microphones, loudspeakers, 
webcams, and digital cameras. 

FAQ 10:  What is a presentation Software? 

Answer 
A presentation program is a software package used to display information in the form 
of a slide show. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  Windows is an _______ software 

a.  application b.  Platform 

c.  Microsoft d.  Operating System 

2.  Which one of the following is NOT application software? 

a.  Word b.  Excel 

c.  Windows d.  In-Page 

3.  Which one of the following is NOT available in Microsoft Office Suit? 

a.  Word b.  In-Page 

c.  Excel d.  Power Point 

4.  Which one of the following is NOT a step of windows installation procedure? 

a.  Create restore point b.  Install Microsoft Office Tool 

c.  Take data backup d.  None 

5.  Which one of the following is a peripheral device? 

a.  Motherboard b.  RAM 

c.  Mouse d.  Processor 

6.  What is the short key for copy and paste command? 

a.  CTRL + V / CTRL + C b.  CTRL + C / CTRL + V 

c.  CTRL + C / CTRL + P d.  ALT + C / ALT + V 

7.  In which tab Text formatting options are available? 

a.  HOME b.  LAYOUT 

c.  VIEW d.  FORMAT 
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8.  
And excel spreadsheet can be inserted in a word document using__________ 
command? 

a.  Links b.  Review 

c.  Illustrations d.  Table 

9.  Which keyboard layout is recommended for Urdu Text composing? 

a.  Arabic b.  Monotype 

c.  Phonetic d.  Farsi 

10.  Which section of HOME tab contains the text alignment options? 

a.  Font b.  Styles 

c.  Paragraph d.  Editing 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 c 

3 b 

4 b 

5 c 

6 b 

7 a 

8 d 

9 c 

10 c 
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Module 3: Database 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Perform record keeping and explain database concept and 
procedure. 

 Define, apply and integrate data relationships. 

 Describe Column (Field) of a table.  

 Define Row (Record) of a table.  

 Explain structure of a table (Database) in similarity with a table of 
a word document file.  

 Describe different data type e.g. character, number, logical, and 
date/time, etc.  

 Define the role of different “key” including Primary Key, etc.  

 Illustrate definition of a Database; not null, unique, logical data 
entry.  

 Describe search and its criteria (query) e.g. select, etc.  

 Find and apply relationships on different data entities entered, 
e.g. one student can register many courses in a training session; 
so here 1 To N (Many) relation meets.  

 Design ERD (entity relationship diagram) in word document using 
symbols and shapes.  

 Define different relationships types (One-to-One, One-to-Many, 
and Many-to-Many).  
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Learning Unit 1: Record Keeping 

Overview 

In this learning unit, you will learn to keep record using database. After completion of this learning 
module, you will be able to describe Column (Field) of a table, define Row (Record) of a table and use 
search and its criteria (query) etc. 

1. Database Concept 

A database is a collection of related data that is stored in a computer system. 
Databases allow their users to enter, access, and analyze their data quickly 
and easily. The easiest way to understand a database is to think of it as 
a collection of lists.  

This is true of all databases, from the simplest to the most complex. For 
instance, if you like to bake you might decide to keep a database containing the types of cookies you 
know how to make and the friends you give these cookies to. This is one of the simplest databases 
imaginable. It contains two lists: a list of your friends, and a list of cookies. 

 

However, if you were a professional baker, you would have many more lists to keep track of: a list of 
customers, a list of products sold, a list of prices, a list of orders, and so on. The more lists you add, 
the more complex the database will be. 

 

In Access, lists are a little more complex than the ones you write on paper. Access stores its lists of 
data in tables, which allow you to store even more detailed information. In the table below, 

Good record 
keeping is vital for 
its survival. 

Remember 
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the People list in the amateur baker’s database has been expanded to include other relevant 
information on the baker’s friends. 

 

If you are familiar with other programs in the Microsoft Office suite, this might remind you of Excel, 
which allows you to organize data in a similar way. In fact, you could build a similar table in Excel. 

2. Procedure of Database Creation from Table  

To begin, launch access by clicking on the desktop icon, or choose access from the start menu. This 
brings up the getting started with Microsoft Office Access screen. 

 

If you already have MS Access open, you can go to the File menu: 

 

Choose Blank desktop database. (Skip this step if you already chose Blank desktop database at step 
one). You also have other options, but we'll just use a blank database here: 
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Choose a name and click Create. Let's call it Space Trips. You can either use the default location or 
click the folder icon to change the location:  

 

Your New Database 

Once you have completed the above steps, you should see a blank database, like this: 
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As you know this database is blank because it only contains one table (called Table1) and that table 
has only one column (called ID). So we need to add some more columns to the table and give the table 
a name. 

 

3. Fields (column) and Records (row) in a Table  

Tables are organized into vertical columns and horizontal rows. 

 

In Access, rows and columns are referred to as records and fields. A field is more than just a column; 
it’s a way of organizing information by the type of data and the information within a field is of the 
same type, for example, every entry in a field called First Name would be a name, and every entry in 
field called Street Address would be an address. 
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Likewise, a record is more than just a row; it is a unit of information. Every cell in a given row is part of 
that row’s record. 

 

Notice how each record spans several fields. Even though the information in each record is organized 
into fields, it belongs with the other information in that record. See the number at the left of each row? 
It is the ID number that identifies each record. The ID number for a record refers to every piece of 
information contained on that row. 
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Each customer would be represented by a unique record, and each type of information about these 
customers would be stored in its own field.  
 

4. Selection and Limitation of Different Data Types  

Select the field type that best describes the data you want to store in the field and that works for the 
type of analysis you need to use the field. Here are tips for using different types of fields. 

 

Selection Limitation 

Short Text 
Text up to 255 characters long (including spaces and punctuation). Use a Text 
field, not a Number field, for codes even if they look like numbers, such as phone 
numbers, zip codes, and other postal codes. 

Long Text 
Text up to 65,536 characters. A Long Text field can contain Rich Text (formatted 
text), and you can set it to append only so that it can accumulate text notes without 
allowing the user to delete what’s already there. 

Number 
Only numbers. You may use + or – before the number, as well as a decimal point. 
If you plan to do math with a field, use a Number or Currency field. 

Currency Numbers with a currency sign in front of them ($, ¥, and so on). 

AutoNumber 
Numbers unique to each record and assigned by Access as you add records, 
starting at 1. Use an AutoNumber field as the primary key field for most tables. 

Date/Time Dates, times, or both. 

Hyperlink 
Text string formatted as a hyperlink. (If you click the link, it takes you to the page.) 
This field type is especially useful if related information is available on the web. 

Yes/No 
Yes or no (a particular condition is, or isn’t, in effect) — or other two-word sets, 
such as True/False, On/Off, and Male/Female. Use a Yes/No field if you want to 
display the field as a check box on forms. 

Attachment 
Stores one or more entire files — pictures, sound, Word documents, even video — 
in one Attachment field. 

Calculated 
Data created with a formula. Use a calculated field when a calculated value will be 
used in many queries, forms, and reports. 

 

 

5. Different “keys” for the Functionality of Having Indexes 

There are following main kinds of indexes those have keys: 

1. Primary Key 

A primary key is unique and can never be null. It will always identify only one record, and each record 
must be represented. Each table can only have one primary key. 
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2. Unique Index 

A Unique Index must be unique, but it can be null. So each key value identifies only one record, but 
not each record needs to be represented. 

3. Multiple-column Indexes 

Indexes can contain more than one column. Maria DB is able to use one or more columns on the 
leftmost part of the index, if it cannot use the whole index. 

 

6. Execution of Specific Search 

Flexible search form provides several boxes where a user can enter criteria. An efficient search form 
creates the criteria from only those boxes where the user enters a value. 

 

It illustrates how to use: 

 Exact matches, 

 Partial matches (wildcards), 

 A range of values, 

 Delimiters for each field type, 

 Any combination of criteria, 

 A design that is easy to extend. 

7. Procedure of Data Entry and Assurance Procedure to Check Validity of 
Punched Data  

There are 5 steps of data entry and assurance procedures to check validity of punched data: 

1. Data Collection 

 Data are collected 
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 Cover Sheet 

 Length Frequency Form. 

 Pot Catch Form 

 Tagging and Release Form 

 

2. Pre-key Punching, Checking and Collating 

Paper forms from each sample are visually checked for obvious errors or omissions, corrected, and 
collated together with paper forms from other samples from the same fishing area, allocated a file 
name. 

 

3. Key Punching Data Entry 

All data entry is verified, that is, each page of data is key punched twice and the two results are 
crosschecked electronically for mismatches. Any data entry operator errors are corrected at this point. 
Data are now ready for error checking and validation routines. If the client requires invalidated data, a 
disk copy of the digitized data will be returned to the client, along with a hard copy print out together 
with the original raw data. If validation is required then the data go through the next step. 

 

4. Data Error Checking (Manual and Computer) and Validation (“Grooming”) 

Grooming is defined as the process by which digitized data files are checked for validation errors (is 
value A within valid range?), data integrity (given that value A is valid, and value B is valid, does B 
make sense given A?), and the file structure is manipulated in preparation for insertion into the 
database. The individual data files are now put through a number of computer error checking 
(validation) routines that look for inconsistencies within the sample and check ranges of data within set 
limits.  

 

5. Groomed Data Loaded to Database 

The groomed data are now loaded into the database. At this point the data become available for 
analyses. 

 

 

  



Module 3: Database 

Teaching and Learning Material: Information Technology (Office Assistant)                                                                            | 69 

Learning Unit 2: Data Relationships  

Overview 

In this learning unit, you will be introduced to the concepts and principles about data relationship. After 
completion of this learning unit, you will be able to find and apply relationships on different data entities 
entered, design ERD (entity relationship diagram). 

1. Relationships between Entities  

The types of information that are saved in the database are called 'entities'. 
These entities exist in four kinds: people, things, events, and locations.     

In relation to a database, an entity is a single person, place, or thing about 
which data can be stored. In data modeling (a first step in the creation of 
a database), an entity is some unit of data that can be classified and have stated 
relationships to other entities. 

 

An entity relationship model, also called an entity-relationship (ER) diagram, is a graphical 
representation of entities and their relationships to each other, typically used in computing in regard to 
the organization of data within databases or information systems. An entity is a piece of data-
an object or concept about which data is stored.  

A relationship is how the data is shared between entities. There are three types of relationships 
between entities: 

 

1. One-to-One 

One instance of an entity (A) is associated with one other instance of another entity (B). For example, 
in a database of employees, each employee name (A) is associated with only one social security 
number (B). 

 

All things are not 
entities only those 
about which 
information should 
be captured. 

Remember 

A relationship exists 
between two 
database tables 
when one table has 
a foreign key that 
references the 
primary key of 
another table. 

Relationship 

http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/D/database.html
http://www.webopedia.com/TERM/O/object.html
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2. One-to-Many 

One instance of an entity (A) is associated with zero, one or many instances of another entity (B), but 
for one instance of entity B there is only one instance of entity A. For example, for a company with all 
employees working in one building, the building name (A) is associated with many different employees 
(B), but those employees all share the same singular association with entity A. 

 

3. Many-to-Many 

One instance of an entity (A) is associated with one, zero or many instances of another entity (B), and 
one instance of entity B is associated with one, zero or many instances of entity A. For example, for a 
company in which all of its employees work on multiple projects, each instance of an employee (A) is 
associated with many instances of a project (B), and at the same time, each instance of a project (B) 
has multiple employees (A) associated with it. 

 

2. Design Entities Relationship Diagrams for (1:1, 1: N, M: N) Relations  

The Entity Relationship Diagram (ERD) gives a graphical overview of the database.  

1:1 relationship is represented as follows: 

 

One to one relationship. 
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1:N  relationship:  

 

One to many relationship. 

 

A M:N relationship is: 

 

Many to many relationship. 

 

The model of our example will look like this: 

 

Model with entity relationships. 

 

  

A relational 
database holds its 
data over a number 
of tables instead of 
one. Records within 
the tables are linked 
(related) to records 
held in other tables. 

Do you know! 
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Summary of Module 

 Computer based databases are usually organized into one or more tables.  
 

 A table stores data in a format similar to a published table and consists of a series of rows and 
columns.  
 

 To carry the analogy further, just as a published table will have a title at the top of each column, 
so each column in a database table will have a name, often called a field name.  
 

 The term field is often used instead of column. Each row in a table will represent one example 
of the type of object about which data has been collected.  
 

 An entity relationship is the result of using a systematic process to describe and define a subject 
area of business data. It does not define business process; only visualize business data.  
 

 The data is represented as components (entities) that are linked with each other 
by relationships that express the dependencies and requirements between them, such as, one 
building may be divided into zero or more apartments, but one apartment can only be located 
in one building. Entities may have various properties (attributes) that characterize them. 
Diagrams created to represent these entities, attributes, and relationships graphically are called 
entity. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is a recordkeeping system? 

Answer 
A "recordkeeping system" is a manual or automated system that collects, organizes, 
and categorizes records, facilitating their preservation, retrieval, use, and disposition. 

FAQ 2:  What is the value of record keeping   system? 

Answer A recordkeeping system helps ensure that records are trustworthy. 

FAQ 3:  What are trustworthy records? 

Answer 

The characteristics of trustworthy records are: 
 

 Reliability - the records are a full and accurate representation of the 
transactions, activities or facts to which they attest. 
 

 Authenticity - the records can be proven to be what they claim to be, to have 
been created or sent by the persons claiming to have created or sent them, 
and to have been created or sent at the claimed time; 
 

 Integrity - the records are complete and unaltered; and 
 

 Usability - the records can be located, retrieved, presented and interpreted. 

FAQ 4:  How long do records have to be kept? 

Answer The length of time, a record must be kept depends on the nature of record. 

FAQ 5:  What are the advantages of a relational database? 

Answer 

There are following major advantages of relational database. 

 Avoids data duplication 

 Avoids inconsistent records 

 Easier to change data 

 Easier to change data format 

 Data can be added and removed easily 

 Easier to maintain security. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  The first step to create a database is to create a/an ___________ database first. 

a.  already saved database b.  blank database 

c.  Both are correct d.  None of the above 

2.  A/An_______ is a single person, place, or thing about which data can be stored. 

a.  Attribute b.  Entity 

c.  Both of the above d.  None of the above 

3.  A _________ key is unique and can never be null 

a.  Unique b.  Composite 

c.  Primary d.  None of the above 

4.  

Which relation shows given picture?   

a.  One to many b.  Many to many 

c.  One to one d.  None of the above 

5.  A flexible search form provides ___________ boxes where a user can enter criteria. 

a.  One b.  Two 

c.  Both a and b d.  Several 
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Answer Key 
MCQ Number Correct Answer 

1  b 

2  b 

3  c 

4  a 

5  d 
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Module 4: Business Functional Process 
Area (Account - Bookkeeping) 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Define basic accounting terminologies and important principles 
such as matching. 

 Gain a good knowledge of recording, closing and posting entries. 

 Differentiate between credit and debit entries. 

 Explain assets types e.g. fixed, current, etc. 

 Define the depreciation, and their techniques. 

 Record the daily business transactions (Revenue, Expense, etc.) 
detail in worksheet (e.g. Microsoft Excel) from day book.  

 Calculate balance amount (either credit or debit) of petty cash 
(Treasury) after each & every business transaction.  

 Explain and Implement CoA (chart of accounts) e.g. A-1017 
means repair and maintenance of wood furniture. 

 Apply the credit and debit rules on CoA. 

 Know the basic information about checking (auditing) procedure 
and reporting of findings.  

 Know the introduction of different regulation imposed by 
company-nature (e.g. Private limited) Government regulation 
body (e.g. SECP) including but not limited to From-29.  

 Deposit and electronic filing of Tax returns in scheduled banks 
and on Federal Board of Revenue Website.  
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 Given any set of data, apply basic formulas/functions. Applied 
formulas/functions are error free. E.g. =(A1 + D24) * X39. 

 Apply different logical functions.  

 Use different logical, mathematical, statistics, and financial 
formulas.  

 Plot column data in charts.  

 Edit worksheet.  

 Select different currency styles.  
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Learning Unit 1: Accounting and Bookkeeping 
Terminologies 

Overview 

In this unit, you will learn about fundamental concept of book keeping process and accounting 
terminologies. These concepts are building block to perform basic accounting operation and for 
working in accounting software (e.g. Peachtree). After completion of this learning unit you will be able 
to explain accounting cycle, assets types. You will also able to define depreciation and their techniques. 

 

1. Accounting Terminologies  

Credit 
Entered in the right column of accounts. Liability, equity and revenue increase on the credit side. 
 
Debit 
Entered in the left column of accounts. Assets and expenses increase on the debit side.  
 
Revenue 
The actual amount of money a company brings in during a particular time period; gross income. 
 
Expense 
Costs that are matched with revenues on the income statement. For example, Cost of Goods Sold is 
an expense caused by Sales. Insurance Expense, Wages Expense, Advertising Expense, Interest 
Expense is expenses matched with the period of time in the heading of the income statement. Under 
the accrual basis of accounting, the matching is NOT based on the date that the expenses are paid. 
 
Taxation 
Accounting methods that focus on taxes rather than the appearance of public financial statements. Tax 
accounting is governed by the Internal Revenue Code which dictates the specific rules that companies 
and individuals must follow when preparing their tax returns. Tax principles often differ from Generally 
Accepted Accounting Principles.  
 
Invoice 
An Invoice shows the amount of money owed for goods or services received. 
 
Receipt 
A written acknowledgment that something of value has been transferred from one party to another. In 
addition to the receipts consumers typically receive from vendors and service providers, receipts are 
also issued in business-to-business dealings, as well as stock market transactions. For example, the 
holder of a futures contact is generally given a delivery instrument, which acts as a receipt, in that it 
can be exchanged for the underlying asset when the future contract expires. 
 
Capital 
In simple word, capital means that amount or asset which is invested in business by businessman or 
owner of business. 
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Assets 
Things that are resources owned by a company and which have future economic value that can be 
measured and can be expressed in dollars. Examples include cash, investments, accounts receivable, 
inventory, supplies, land, buildings, equipment, and vehicles. Assets are reported on the balance sheet 
usually at cost or lower. Assets are also part of the accounting equation:  
 
          Assets = Liabilities + Owner's (Stockholders') Equity’s 
 
Liabilities 
Obligations of a company or organization. Amounts owed to lenders and suppliers. Liabilities often 
have the word "payable" in the account title. Liabilities also include amounts received in advance for a 
future sale or for a future service to be performed. 
 
Equity 
The difference between assets and liabilities, such as stockholders' equity, owner's equity, or a 
nonprofit organization's net assets. 
 
Also used to indicate an owner's interest in a personal asset. For example, the owner of a RS 200,000 
house with a RS 75,000 mortgage loan is said to have equity of RS 125,000. 
 
Journal 
The first place financial transactions are entered. They are entered chronologically. 
 
Ledger 
Where debit and credit transactions are recorded. 
 
Trail Balance 
A listing of the accounts in the general ledger along with each account's balance in the appropriate 
debit or credit column. The total of the amounts in the debit column should equal the total of the 
amounts in the credit column. 
 
Income 
This term is used in several ways. Some use the word interchangeably with revenues. Others use the 
word to signify a net amount, such as income from operations (revenues minus expenses in the 
company's main operating activities). Still others use it when referring to nonoperational revenues, 
such as interest income. 
 
Balance Sheet 
Provides a snapshot of a business' assets, liabilities, and equity on a given date. 
 

2. Categorization of Assets 

Assets can be defined as “Things that are resources owned by a company and which have future 
economic value that can be measured”. Examples include cash, investments, accounts receivable, 
inventory, supplies, land, buildings, equipment, and vehicles. 

 
Types of Assets 
There are two types of current assets and fixed assets. That is used differently in business cycle 
accordingly. 
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Current Assets: Current assets are those assets that can be expected to turn into cash within a year 
or less. Current assets include cash, marketable securities, accounts receivable, and inventory.  
 
Fixed Assets: Fixed assets cannot be quickly turned into cash without interfering with business 

operations. Fixed assets include land, buildings, machinery, equipment, furniture, and long‐term 
investments.  
 

 Intangible Assets are items such as patents, copyrights, trademarks, licenses, franchises, 
and other kinds of rights or things of value to a company, which are not physical objects. These 
assets may be the most important ones a company owns. Often they do not appear on financial 
reports. 

 Tangible Assets It can be touch physically like land, building, furniture. 

 

3. Depreciation 

Depreciation is a systematic and rational process of distributing the cost of tangible assets over the life 
of assets. 
 

 Depreciation is a process of allocation. 

 Cost to be allocated = acquisition cot - salvage value 

 Allocated over the estimated useful life of assets. 

 Allocation method should be systematic and rational. 
 
Depreciation Methods 

 Depreciation methods based on time: 

 Straight line method 

 Declining balance method 

 Sum-of-the-years'-digits method 

 Depreciation based on use (activity) 
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4. Accounting Life Cycle 

The accounting cycle has eight steps, which you can see in the following illustration: 
 

 
 
1. Transactions 
Financial transactions start the process. Transactions can include the sale or return of a product, the 
purchase of supplies for business activities, or any other financial activity that involves the exchange 
of the company’s assets, the establishment or payoff of a debt, or the deposit from or payout of money 
to the company’s owners. 
 
2. Journal Entries 
The transaction is listed in the appropriate journal, maintaining the journal’s chronological order of 
transactions. The journal is also known as the “book of original entry” and is the first place a transaction 
is listed. 
 
A company purchasing 10,000 shares of RS 1 par stock. 
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3. Posting in Ledger Account 
The transactions are posted to the account that it impacts. These accounts are part of the General 
Ledger, where you can find a summary of all the business’s accounts. 
 
Let's post the journal entries that Abdullah & Co. made during the first year in business to the ledger 
accounts. 
 

 
 

 
 

 
 

 
 

4. Trial Balance 
At the end of the accounting period (which may be a month, quarter, or year depending on a business’s 
practices), you calculate a trial balance. 
 
After ABDULLAH & CO records its journal entries and posts them to ledger accounts, it prepares this 
unadjusted trial balance. 

http://www.myaccountingcourse.com/accounting-cycle/journal-entries
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ABDULLAH & CO 

 
 
5. Worksheet 
Unfortunately, many times your first calculation of the trial balance shows that the books aren’t in 
balance. If that’s the case, you look for errors and make corrections called adjustments, which are 
tracked on a worksheet. 
 
Adjustments are also made to account for the depreciation of assets and to adjust for one-time 
payments (such as insurance) that should be allocated on a monthly basis to more accurately match 
monthly expenses with monthly revenues. After you make and record adjustments, you take another 
trial balance to be sure the accounts are in balance. 
 
 
6. Adjusting Journal Entries 
You post any corrections needed to the affected accounts once your trial balance shows the accounts 
will be balanced once the adjustments needed are made to the accounts. You don’t need to make 
adjusting entries until the trial balance process is completed and all needed corrections and 
adjustments have been identified. 
 
7. Financial Statements 
Financial statements give a picture of how your business is doing. 
 
8. Closing the Books 
You close the books for the revenue and expense accounts and begin the entire cycle again with 
zero balances in those accounts. 
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Learning Unit 2: Introduction to Accounts Reporting 

Overview 

In this learning unit, you will be able to work on Peachtree, installation, maintaining charts of accounts, 
recording daily business transactions (revenue, expense). After completion of this learning unit you will 
be able to record daily business transactions, calculate and navigate financial reporting like: General 
journal, income statements & balance sheet and basic knowledge about regulations and electronic 
filing of tax return. 

 

1. Installation of Peachtree 

Peachtree is an accounting application for small and medium-sized businesses (SMBs) made by Sage 
Software. Peachtree enables comptrollers and managers to automate and manage numerous 
accounting tasks, like: Reconciling accounts payable and receivable. Steps required to install 
Peachtree software are as under: 
 

1. Run step up Peachtree Complete 2005 CD into your CD-ROM tray.  
2. Click "Next" on the Peachtree Complete 2005 installation prompt.  

 

 
 

3. Select "I accept the terms in the License Agreement" and then click "Next." 
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4. Select standard setup and click next as shown below. 
 

 
 

5. Check Yes , install the Peachtree shortcut to my desktop  
 

 
 

6. When installation starts, you will see the following on your screen. 
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After the installation of software you will create company information. The method of creating 
company information is illustrated below. 
 
Company Creation 

This is the first window of the setup process. It lists the areas you will be setting up as you use the 
wizard. 

 

 
 

1. Read the introductory information. 
2. Select Next to continue setting up your company. 
3. Peachtree displays the New Company Setup - Company Information Window. 
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4. Enter the company name, address, phone, and fax information. 
5. From the list in the Business Type field, select your business type. 

 
The business type defines the kind of business you run. Your selection here determines the makeup 
of the equity section of your chart of accounts. You can change the business type at any time. You can 
select the type of business after referring the following types of businesses. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Enter your Federal and State Employer ID, as well as your State 
Unemployment ID. 

7. Enter your company’s Web site and e-mail address, if applicable. 
8. Select Next to continue setting up your company. 

TYPES OF BUSINESSES 
Corporation 
This is a business that is owned by a few persons or by thousands of persons and is incorporated 
under the laws of one\of the 50 states. It is a body formed and authorized to act as a single entity 
and is legally endowed with various rights and duties including the capacity of succession. 
 
Corporation 
A type of corporation that, for federal tax purposes (in most states), may be taxed as a partnership 
provided certain requirements are met. There are certain limitations that restrict this election 
typically to small businesses. These are limits on the number of shareholders, the types of 
shareholders, the classes of stock issued, and on other things. 
 
Partnership 
A business owned by two or more persons associated as partners. The partners have joint control 
over operations and the right to share in profits. 
 
Sole Proprietorship 
A business owned by a single individual and often managed by that same individual. A person who 
does business for himself or herself is engaged in the operation of a sole proprietorship. Many 
small service businesses, such as doctors, lawyers, barbers, electricians, and small retail 
establishments are sole proprietorships. 
 
Limited Liability Company 
An unincorporated association of two or more persons (partners, corporations, or other business 
entities) whose members have limited personal liability for obligations or debts of the company. 
Similar to corporations, a limited liability company shields the assets of owners and investors from 
liability claims. This type of business is classified as a partnership for federal tax purposes. If the 
company has more corporate characteristics, it may be taxed as a corporation.  
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Peachtree displays the New Company Setup - Chart of Accounts window. 
 
Chart of Accounts 
The chart of accounts is nothing more than a list of categories into which your transactions are 
summarized. It contains a code, referred to as an account ID, a description for each account, and a 
type code. 
 
Chart of Accounts Windows 
On the first Chart of Accounts window, you choose how you will be defining the chart of accounts for 
your company 
 

 
Select one of the setup options on the window. You  will select  Build your own company 

 
Accounting Method 
When you set up your company, you must indicate if you will use a cash or accrual accounting method. 
The cash method records income when cash is received, expenses when cash is paid out. Accrual 
accounting records income and expenses at the time of the transaction regardless of when the cash is 
exchanged. 
 
If you choose cash accounting, Peachtree updates your income or expense accounts only when you 
receive or disburse checks. However, the invoice is recorded in the vendor or customer ledger. That 
way, you still have aging information available. 
 
The choice between cash and accrual accounting is final. You cannot change this decision after you 
finish New Company Setup. The only way to change accounting methods is by setting up a new 
company all over again. You select the accounting method on the New Company Setup – Accounting 
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Method Window 

 
 

1. Select either the Accrual or Cash option. 
2. Select Next to continue setting up your new company. 

 
Peachtree displays the New Company Setup - Posting Method window. 
 
Posting Method 
You must choose whether you want Peachtree to post your transactions as they are entered (real time) 
or if you want to wait and post transactions in a group (batch posting). Remember that in batch posting, 
the transactions you enter are saved to a temporary holding area, where you can review them before 
posting the batch to the general ledger. In real-time posting, the transactions you enter are posted as 
you save them. 
 
You can edit your transactions in either of the methods, and you can change the method at any time. 
You select the posting method on the New Company Setup - Posting Method window. 
 

 
 

3. Select either the Real Time or Batch option. 
4. Select Next to continue setting up your new company. 

 
Peachtree displays the New Company Setup - Accounting Periods window. 
 
Accounting Periods Windows 
You select the type of accounting periods on the first New Company Setup as shown below. 
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5. Select either the option button for 12 monthly accounting periods. 
6. Select Next to continue setting up your accounting periods. If you selected 12 monthly 

accounting periods, Peachtree displays the following window. Here, you specify information for 
your standard accounting periods. 
 

 
 
Two fiscal years are created, 24 periods total. The fiscal years are based on the start date you specify, 
as well as the first month you specify for entering data. Both fiscal years are set up with 12 periods 
each. The month you enter as the month your first fiscal year starts will be the first period for your 
company in Peachtree. Each period after that increases by month and year. 
 
Defaults 
The information on this window shows you the defaults that were created for you automatically if you 
chose to set up a company based on a sample company. It will look similar to the following window: 
 



Module 4: Business Functional Process Area (Account - Bookkeeping) 

92 |                                                                          Teaching and Learning Material: Information Technology (Office Assistant) 

 
 

7. Review the accuracy and appropriateness of the default information. If it is not satisfactory, you 
can change it before you begin entering transactions. From the Peachtree menu, select 
Maintain, Default Information, and then select the appropriate type of default information. 

8. Select Next to continue setting up your new company.  
 
Finish 
There are several versions of the Finish window. The one displayed depends on an earlier option you 
selected in New Company Setup. Peachtree displays this window if you selected one of the following 
options: 
 
The New Company Setup - Chart of Accounts Window: 
 

 Set up a new Retail, Service, Construction, Manufacturing, or Distribution company, using a 
simplified chart of accounts. 

 Set up a new company using an extensive chart of accounts from one or many sample 
companies. 

 Copy settings from an existing Peachtree company 

 Build your own company. 
 

 
 

 Click Finish. 
After the Completion of company creation process now you have to create charts of accounts for 
practically posting of double entry system in this PEACHTREE accounting software. 
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2. Creation of Charts 

Introduction to Charts of Accounts: 
 
A chart of accounts is a listing of the names of the accounts that a company has identified and made 
available for recording transactions in its general ledger. A company has the flexibility to tailor its chart 
of accounts to best suit its needs, including adding accounts as needed. 
 
Each account in the chart of accounts is typically assigned a name and a unique number by which it 
can be identified. (Software for some small businesses may not require account numbers.) Account 
numbers are often five or more digits in length with each digit representing a division of the company, 
the department, the type of account, etc. Now for understanding of creation of charts of accounts here 
is an example below:  

 
As you will see, the first digit might signify if the account is an asset, liability, etc. For example, if the 
first digit is a "1" it is an asset. If the first digit is a "5" it is an operating expense. 
 
A gap between account numbers allows for adding accounts in the future. The following is 
a partial listing of a sample chart of accounts. 
 
 
Current Assets (account numbers 10000 - 16999) 

10100   Cash - Regular Checking 
10200   Cash - Payroll Checking 
10600   Petty Cash Fund 
12100   Accounts Receivable 
12500   Allowance for Doubtful Accounts 
13100   Inventory 
14100   Supplies 
15300   Prepaid Insurance 
 

Property, Plant, and Equipment (account numbers 17000 - 18999) 
17000   Land 
17100   Buildings 
17300   Equipment 
17800   Vehicles 
18100   Accumulated Depreciation - Buildings 
18300   Accumulated Depreciation - Equipment 
18800   Accumulated Depreciation – Vehicles 
 

Current Liabilities (account numbers 20000 - 24999) 
20100   Notes Payable - Credit Line #1 
20200   Notes Payable - Credit Line #2 
21000   Accounts Payable 
22100   Wages Payable 
23100   Interest Payable 
24500   Unearned Revenues 
 

Long-term Liabilities (account numbers 25000 - 26999) 
25100   Mortgage Loan Payable 
25600   Bonds Payable 
25650   Discount on Bonds Payabl 
 

http://www.accountingcoach.com/terms/C/chart-of-accounts.html
http://www.accountingcoach.com/terms/A/account.html
http://www.accountingcoach.com/terms/G/general-ledger.html
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Stockholders' Equity (account numbers 27000 - 29999) 
27100 Common Stock, No Par 
27500 Retained Earnings 
29500 Treasury Stock 
 

Operating Revenues (account numbers 30000 - 39999) 
31010   Sales - Division #1, Product Line 010 
31022   Sales - Division #1, Product Line 022 
32015   Sales - Division #2, Product Line 015 
33110   Sales - Division #3, Product Line 110 

 
Cost of Goods Sold (account numbers 40000 - 49999) 

41010   COGS - Division #1, Product Line 010 
41022   COGS - Division #1, Product Line 022 
42015   COGS - Division #2, Product Line 015 
43110   COGS - Division #3, Product Line 110 
 

Marketing Expenses (account numbers 50000 - 50999) 
50100   Marketing Dept. Salaries 
50150   Marketing Dept. Payroll Taxes 
50200   Marketing Dept. Supplies 
50600   Marketing Dept. Telephone 
 

Payroll Dept. Expenses (account numbers 59000 - 59999) 
59100   Payroll Dept. Salaries 
59150   Payroll Dept. Payroll Taxes 
59200   Payroll Dept. Supplies 
59600   Payroll Dept. Telephone 
 

Other (account numbers 90000 - 99999) 
91800   Gain on Sale of Assets 
96100   Loss on Sale of Assets 

 
Moreover you will be able to create charts of account according to need of organization. After the 
understanding of charts of account you will learn creating of charts of accounts in accounting software. 
(PEACHTREE) 
 
 
Creation of Charts of Accounts in PEACHTREE Accounting Software 

The Chart of Accounts window is used to add new accounts, to modify the description of an existing 
account, to delete an existing account, to make an account inactive, or to change the account type for 
an account. 

 
1. When you are setting up a new chart of accounts (instead of copying from one of Peachtree's 

sample businesses), you need to have all your account numbers and names written down. 

2. Have all of your transactions that have occurred after the conversion date ready to enter to 
bring your accounts up to date. 

1. Do one of the following: 
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 To let Peachtree walk you through the process of setting up your chart of accounts, 
open Peachtree Today, and on the Welcome page, select Setup Guide. Select General 
Ledger from the menu bar; then select the first task on the page, Set up Your Chart of 
Accounts.  

OR 

 From the Maintain menu, select Chart of Accounts. 

2. Peachtree displays the Maintain Chart of Accounts window. 

 

3. Enter an account ID and description for the account. 

Account ID: This is an alphanumeric code that identifies the account. To enter a new account, select 
the New button. It also determines how the account is identified and sorted in the chart of accounts list. 
Most charts of accounts are set up with specific account types grouped together.  

Description: This is the description of the account entered in the Maintain Chart of Accounts window. 
You can edit this description by selecting the New button, entering the ID of the account whose 
description you want to edit, and then making any changes you want to the description. 
 

4. Select an account type from the drop-down list. 

Account Types: It defines how the account will be grouped in reports and financial statements. They 
also control what happens during fiscal year-end. General Ledger accounts are assigned types on the 
General tab of the Maintain Chart of Accounts window. Choose one of the following account types 
from the drop-down list: 
 

 Accounts Payable   Expenses  

 Accounts Receivable   Fixed Assets  

 Accumulated Depreciation   Income  

 Cash   Inventory  

 Cost of Sales   Long term liabilities  

mk:@MSITStore:C:/PROGRA~2/PEACHT~1/Help/PeachW.chm::/PTODAY/Peachtree_Today_Overview.htm
mk:@MSITStore:C:/PROGRA~2/PEACHT~1/Help/PeachW.chm::/PTODAY/Peachtree_Today_Welcome_Page.htm
mk:@MSITStore:C:/PROGRA~2/PEACHT~1/Help/PeachW.chm::/PTODAY/Peachtree_Today_Setup_Guide.htm
mk:@MSITStore:C:/PROGRA~2/PEACHT~1/Help/PeachW.chm::/GL01/GL01_Maintain_Chart_of_Accounts_Account_Types.htm
javascript:BSSCPopup('GL01_Account_Type_Accounts_Payable.htm');
javascript:BSSCPopup('GL01_Account_Type_Accounts_Receivable.htm');
javascript:BSSCPopup('GL01_Account_Type_Fixed_Assets.htm');
javascript:BSSCPopup('GL01_Account_Type_Accumulated_Depreciation.htm');
javascript:BSSCPopup('GL01_Account_Type_Income.htm');
javascript:BSSCPopup('GL01_Account_Type_Cash.htm');
javascript:BSSCPopup('GL01_Account_Type_Inventory.htm');
javascript:BSSCPopup('GL01_Account_Type_Cost_of_Sales.htm');
javascript:BSSCPopup('GL01_Account_Type_Long_Term_Liabilities.htm');


Module 4: Business Functional Process Area (Account - Bookkeeping) 

96 |                                                                          Teaching and Learning Material: Information Technology (Office Assistant) 

 Equity - doesn't close (Corporation)   Other assets  

 Equity - gets closed (Proprietorship)   Other current assets  

 Equity - Retained Earnings   Other current liabilities  

 

5. Enter any debits or credits you've made against the account in the months listed for period 
history. 

6. Select Save and then select Close. 

After this Charts of accounts will be started to create as per Organization need. 

 
Some Important Operations of Charts of Accounts Window 

Changing an Account ID: 
 
As your business changes and grows, your chart of accounts may need to change as well, including 
the IDs of existing accounts. Use the following procedure to change a general ledger account ID. 

1. From the Maintain menu, select Chart of Accounts. Peachtree displays the Maintain Chart of 
Accounts window. 

2. Enter or select the account ID you want to change. To display a list of existing general ledger 
accounts, type in the Account ID field, or select the Lookup button. 

3. From the Edit menu, select Change ID, or select the Change ID button on the window toolbar. 
Peachtree displays the Change Account ID window. 

4. Enter the new ID that you want to use instead of the current ID. 

5. When you are finished, select OK to change the ID and return to the Maintain Chart of Accounts 
window. 

When you change an account ID, all data records and transactions associated with this account will 
reflect the new ID. This includes both current and past transactions. 

Deleting an Account from Charts of Accounts: 

In order to delete an account from the chart of accounts, there must be no transactions posted to the 
general ledger that references the account ID. If an account has a nonzero balance, you must delete 
or remove transactions associated with it. These can include beginning-balance entries. 

If an account has a nonzero balance, you can enter an adjusting G/L transaction in the General Journal 
to bring the account's balance to zero. Then, after two year-end closings, you can purge or delete the 
account. 

Making the Account In-active 

You can make the account inactive to ensure that no further transactions are associated with it. Then 
after two year-end closings, you can purge the account. 

javascript:BSSCPopup('GL01_Account_Type_Equity_-_doesn_t_close.htm');
javascript:BSSCPopup('GL01_Account_Type_Other_Assets.htm');
javascript:BSSCPopup('GL01_Account_Type_Equity_-_gets_closed.htm');
javascript:BSSCPopup('GL01_Account_Type_Other_Current_Assets.htm');
javascript:BSSCPopup('GL01_Account_Type_Equity_-_Retained_Earnings.htm');
javascript:BSSCPopup('GL01_Account_Type_Other_Current_Liabilities.htm');
javascript:BSSCPopup('../BUTTONS/BUTTONS_Change_ID_button.htm');
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1. From the Maintain menu, select Chart of Accounts. Peachtree displays the Maintain Chart of 
Accounts window. 

2. Select the account you want to make inactive. To display a list of existing accounts, type in the 
G/L Account ID field, or select the Lookup button. 

3. Select the Inactive check box to the right of the account ID. (There is an X in the check box 
when it is selected.) 

Deleting an Account Immediately 

1. From the Maintain menu, select Chart of Accounts. Peachtree displays the Maintain Chart of 
Accounts window. 

2. Enter or select the account ID you want to remove. To display a list of existing accounts, type 
in the G/L Account ID field, or select the Lookup button. 

3. Select the Delete toolbar button to remove the account. 

If the account has a non-zero balance in any accounting period within the two currently open fiscal 
periods, Peachtree displays a message stating that you cannot delete the account. 

 
If you still want to remove an account that has had a nonzero balance at one time, examine the history 
of the account in the Maintain Chart of Accounts window. Then, display the General Ledger report 
including a date range of the two open fiscal years. Locate the account transactions; then double-click 
to display the corresponding task window where the transactions originated. Finally, delete these 
transactions, and return to the general ledger. To remove an account beginning-balance entry, select 
the Beginning Balances button in the Maintain Chart of Accounts window. 

 

Enter General Ledger Account Beginning Balances 

You are just starting out with your company and have not posted any transactions; Peachtree assumes 
that you are entering beginning balances for your accounts when you select the Beginning Balances 
button. If you have posted transactions, Peachtree assumes that you are entering adjustments to your 
accounts for a period in a prior year. If you enter a new account, Peachtree assumes that this account 
has a zero balance. You may find it easier to add all necessary accounts and then create one 
cumulative beginning-balance entry. 

1. From the Maintain menu, select Chart of Accounts. Peachtree displays the Maintain Chart of 
Accounts window. 

2. Select the Beginning Balances button. Peachtree displays the Select Period window. 

Selecting Period 

If you are operating with a new chart of accounts and no transactions have been posted to an account, 
you can enter a beginning balance for the account for a previous accounting period, the current 
accounting period, or a future accounting period. Select the period in which you want to start your 
beginning balances by highlighting the period and selecting the OK button. 

javascript:BSSCPopup('../BUTTONS/BUTTONS_Delete.htm');
mk:@MSITStore:C:/PROGRA~2/PEACHT~1/Help/PeachW.chm::/REP01/GeneralLedger_870.htm
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Note: When setting up a new chart of accounts, it is best to wait to enter the Beginning Balances until 
after you have set up all your accounts. 

3. Select the period in which you want to enter beginning balances. You can select from previous, 
current, or future periods. 

4. Select OK. Peachtree displays the Chart of Accounts Beginning Balances window. 

 

Beginning Balances for General Ledger Accounts 

Select the Beginning Balances button on the General tab of the Maintain Chart of Accounts window 
to enter beginning balances for general ledger accounts. You use this to enter the beginning balance 
for the account or to adjust the balance for an account in a previous period. 

Although you enter beginning balances on the Chart of Accounts Beginning Balances window and 
prior period adjustments on the Chart of Accounts Prior Year Adjustments window, the fields on the 
two windows are the same. The columns where you enter amounts for accounts on these two windows 
are set up to give you a better feel for how the different accounts in your chart of accounts affect the 
balance of your finances. When you finish entering balances for all of your accounts, the total of the 
amounts in the Assets, Expenses column must equal the total of the amounts in the Liabilities, 
Equity, and Income column. 

Notice that the Trial Balance keeps a running total, or trial balance, of your entries. In addition, totals 
for your income and expenses are calculated. 
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Account ID: This is an alphanumeric code that identifies the account. To enter a new account, select 
the New button. 

Description: This is the description of the account entered in the Maintain Chart of Accounts window. 
You can edit this description by selecting the New button, entering the ID of the account whose 
description you want to edit, and then making any changes you want to the description. 

Account Type: This is the type of the account entered in the Maintain Chart of Accounts window. 

Assets, Expenses or Liabilities, Equity, Income: Depending on the Account Type specified for this 
account in Maintain Chart of Accounts, you will either have to enter an amount in the Assets, 
Expenses column or in the Liabilities, Equity, Income column. Peachtree tells you the column where 
you enter the amount by graying out the other column. Enter a positive amount in the column, unless 
circumstances warrant a negative amount . 

For example, if you enter Rs.5,000 as a beginning balance for your checking account in the Assets, 
Expenses column, to offset this entry, you might enter Rs.5,000 in the Liabilities, Equity, Income 
column for a capital account such as retained earnings. For normal balances, you will just enter positive 
numbers. 

5. Click or tab to any of the white cells in the grid to add an amount. (The gray cells are for viewing 
purposes only.) 

6. Enter all the beginning balances for the accounts. Scroll the list box to make sure the account 
amounts are correct. If necessary, you can enter a negative amount; just type a minus sign 
before the number. Note that for each period, a running beginning balance is kept. Thus, if you 
change an amount in Period 1, the amounts for subsequent periods are also changed. 
However, if you change an amount in Period 2, the same account balance in Period 1 is 
unchanged. 

7. Select the OK button when you're finished. 

 
If Software says you are Out of Balance: 

If you are out of balance in the Beginning Balances for General Ledger Accounts window, Peachtree 
displays a warning message indicating that an equity account will be created (or updated) to contain 
the difference or out-of-balance amount. 

 

This account will be named Beginning Balance Equity, and its type is Equity-Doesn't Close. This 
account does not appear in the Beginning Balances window, but it will appear in the list of accounts 
and on financial statements and general ledger reports. 

 
Try to find the reason for the out-of-balance situation, and correct it if possible. (Select Cancel when 
Peachtree displays the warning message.) If you are entering beginning balances from financial 
statements supplied by your previous accounting system or by your accountant, you most likely made 

mk:@MSITStore:C:/PROGRA~2/PEACHT~1/Help/PeachW.chm::/GL01/GL01_Maintain_Chart_of_Accounts_Account_Types.htm
javascript:BSSCPopup('When_to_Enter_a_Negative_Balance.htm');


Module 4: Business Functional Process Area (Account - Bookkeeping) 

100 |                                                                          Teaching and Learning Material: Information Technology (Office Assistant) 

an error in data entry. Make sure you didn't leave out an account or balance and that you entered all 
amounts correctly. 

If you still cannot find the error, you can select OK at the warning message. Your books will be in 
balance, and you can proceed with setting up your company. You can even begin entering and posting 
transactions. (Remember that once you post transactions, you will need to enter prior-period 
adjustments rather than beginning balances. Although both are entered using the Maintain Chart of 
Accounts Beginning Balances button, Peachtree will display the proper window according to whether 
the transaction has been posted or not.) Then later, if you find the cause of the out-of-balance situation, 
you can go back to the Beginning Balances or Prior Period Adjustments window and correct the 
situation. Once the Beginning Balance Equity account has no transactions associated with it, you can 
delete the account. 

1. Continue entering beginning balances. 

2. Select OK when you are through. 

3. Adding a New Account While Entering G/L Beginning Balances 

The method of adding a new account while entering general ledger beginning balances is as under: 
 

1. In the Beginning Balances window accessed from the Maintain Chart of Accounts window, 
select the New button. Peachtree displays the Enter New Account window. 

2. Enter an account ID and description for the account. To display a list of existing accounts, type 
in the G/L Account ID field, or select the Lookup button. The account ID determines how the 
account is identified and sorted in the chart of accounts list. Most charts of accounts are set up 
with specific account types grouped together. 

3. Select a type for the account. 

4. Select OK. 

After the creation of charts of accounts in Peachtree now you will be able to post journal entry. 

 
Introduction of General Journal in Peachtree 

In the General Journal, you enter both debits and credits, and when the amounts balance, you can 
post the General Journal by selecting the Save button if you're using the real-time posting method. If 
you are using the batch-posting method, select the Save button; then use the Post option from the 
System selection of the Tasks menu. 
 
In General Journal Entry, you can also enter withdrawal and deposit adjustments you need to make 
during account reconciliation. Sometimes adjustments must be made to account for errors, service 
charges, check charges, or unrecorded withdrawals or deposits; such adjustments are necessary to 
help keep your bank account balanced. When you select the Adjust button in Account Reconciliation, 
the General Journal Entry window opens to receive this adjustment data. 

 
You use the General Journal to enter those types of transactions that are not readily categorized in the 
Tasks menu. Depreciation would be an example of something that would be entered into the General 
Journal. 
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Record a General Journal Entry 
The General Journal is used to enter those types of transactions that are not readily categorized in the 
Tasks menu. Typical General Journal entries include chart of account beginning balances, 
depreciation, and account transfers.  
 
Here, you also enter adjustments you need to make during Account Reconciliation. Such adjustments 
are necessary to account for errors, service charges, check charges, or unrecorded withdrawals or 
deposits. When you select Adjust in Account Reconciliation, the General Journal Entry window opens. 
 
Unlike other screens in Peachtree, you provide all the accounting distributions in the General Journal. 
At other times, Peachtree automatically distributes certain amounts, based on guidelines you set in 
Maintain menus. 
 

1. From the Tasks menu, select General Journal Entry. Peachtree displays the General Journal 
Entry window. 

 

2. Enter or select the date of the transactions you want to enter. Peachtree defaults this date to 
the Peachtree system date. If you are in an accounting period that is different from the system 
date, then Peachtree displays the first day of that period. You can also select the Open toolbar 
button to edit a General Journal entry in the current or alternate accounting period. 

3. Select the Reverse check box to have the transaction automatically reversed the first day of 
the next accounting period. Reversing means that debits become credits and credits become 
debits. 

4. Enter a reference for the transaction up to 20 characters. If you enter a number reference, 
Peachtree will increase future General Journal entries by one while this window is open. 

5. For each line enter or select an account ID. To display a list of existing accounts, type in the 
G/L Account ID field, or select the Lookup button. 

6. For each line enter an amount in either the Debit or Credit columns. 

7. For each line enter a description for the transaction. 

8. The description will appear in General Ledger and various reports. 
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9. If the transaction is associated with a job, enter or select a job ID. You can later apply the 
General Journal entry to a customer invoice, if needed. 

10. Once the Out of Balance field is zero (0.00), select Save to record the transaction in the 
General Journal. 

The General Journal Entry window is essentially a table where you enter debit and credit distributions 
to specific accounts for the General Journal transaction. Before you save the transaction, the total debit 
amount must equal the total credit amount. If you are unsure about whether an account should be 
debited or credited, check with your accountant. 
 

 

Save or post the entry Click the Save button to post or record the currently displayed 
transaction. If you use the Real-Time posting method, the saved transaction is posted to 
the General Journal, and the general ledger is updated. If you use the Batch posting 
method, the transaction is recorded in the General Journal and must be posted later to 
update the general ledger. For more information, 

 

Memorize the general journal entry To save a general journal entry as a memorized 
transaction, click the drop-down arrow to the right of the Save button, and then select the 
Memorize button from the drop-down button menu. For more information, look up 
“memorized transactions, Maintain Memorized General Journal Entries” in the Peachtree 
Help index. 

 

Memorize the general journal entry To save a general journal entry as a memorized 
transaction, click the drop-down arrow to the right of the Save button, and then select the 
Memorize button from the drop-down button menu. For more information, look up 
“memorized transactions, Maintain Memorized General Journal Entries” in the Peachtree 
Help index. 

 

Save or post the entry Click the Save button to post or record the currently displayed 
transaction. If you use the Real-Time posting method, the saved transaction is posted to 
the General Journal, and the general ledger is updated. If you use the Batch posting 
method, the transaction is recorded in the General Journal and must be posted later to 
update the general ledger. 

 

Schedule future transactions like this one Select the Recur button to set up repeating 
journal entries for this transaction in future months or accounting periods. You can change 
or delete a recurring entry at any time. 

 

Add or remove a distribution line Use the Row button menu to add an extra line item 
or remove the selected line item from the displayed transaction. 

• To insert a line in the grid, select the line below which you want the new line to appear; 
then from the Row button menu, click the Add button.  

• To remove a line in the grid, select the line you want to delete; then from the Row button 
menu, click the Remove button. 

 
After the posting of journal entries in software you will be able to generate the required reports with the 
help of Peachtree software. Here are some steps to find out the reports: 
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1. Select a Report Menu from Menu Bar 
The Select a Report window lists all the reports, forms, and financial statements currently set up in 
Peachtree. Use this window to select a report or form you want to display, print, or design. 
 
2. Report Area, List, and Description 
On the left of the Select a Report window is the report area (Accounts Receivable, Accounts Payable, 
Financial Statements, and so on), where you select what type of reports or forms you want to see. 
When you select a report area, Peachtree displays a list of reports and forms associated with that area 
on the right. Once a report or form is selected (highlighted in the report list), Peachtree displays its 
description at the far-right side of the window. 
 
Whenever you select a report or form in the report list, a special right-click pop-up menu lets you 
perform most of the functions available from the toolbar at the top of the window. For more information, 
click. 
 
3. Report and Form Icons 
Each report and form icon indicates what type it is: 
 

 This report or statement is read-only. You cannot make changes to this, but you can use this 
as a basis for customizing. 

 This report or statement has been customized. Forms and report groups are contained in 
folders like this. A report group is a group of multiple reports. You can set up groups of reports 
that you want to print at the same time so it won’t take as long to print them. Click the folder 
with the left mouse button to see the forms or reports that the folder contains. 
 

 This form is read-only. You cannot make changes to this form, but you can use it as a basis for 
customizing. 

General Ledger Reports: 

General Ledger reports allow you to list your Chart of Accounts, General Ledger, General Journal, and 
Trial Balances. When you display or print a report,  
 

 
 

mk:@MSITStore:C:/PROGRA~2/PEACHT~1/Help/PeachW.chm::/REP02/ReportGroups_937.htm


Module 4: Business Functional Process Area (Account - Bookkeeping) 

104 |                                                                          Teaching and Learning Material: Information Technology (Office Assistant) 

Peachtree displays the following three tabs: 
 
Filter: Select the Filter tab to determine the data criteria for the reports you want to see or print. For 
specific information about a particular report's filter options, select the report from the list below. 
 
Fields: Select the Fields tab to choose which data fields to include and where the columns break on 
your report. For more information on choosing report fields, click. 
 
Fonts: Select the Fonts tab to set the font styles for the heading and body of the report. You can also 
have the titles of the report show special codes, such as the current period, today's date, an as-of date, 
and the company name.  
 
Now click on general journal report than you will see the window: 
 

 

 
From the Reports menu, select Financial Statements: 

Peachtree displays the Select a Report window with the Financial Statements report area selected. 
The report list displays reports, forms, or financial statements pertaining to the respective report area 
selected. 
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There are several report areas. You can switch among them at any time in this window. Selecting a 
new report area displays a different list of reports. 

1. From the report list, scroll down to select a financial statement you want to appear on the 
screen. 

2. There are two methods to displaying a financial statement on the screen: 

 Double-click the specific financial statement in the report list. 

 Select the specific report or financial statement. Then, select the Preview button in the 
top of the Select a Report window. 

3. Peachtree displays the report Options window pertaining to the financial statement. Enter the 
desired information, then select OK. Peachtree displays the financial statement on the screen. 
Note: For assistance on each report filter, select the Help button or press F1 when the Options 
window is displayed. 

4. To print a financial statement displayed on the screen, select the Print button. 

5. To design a financial statement displayed on the screen, select the Design button. 

6. To display alternate financial statement filter information, select the Options button. If you 
change the financial statement options, you will be prompted to save the new report when 
closing the report window. 

7. When finished viewing the financial statement, select Close to return to the Select a Report 
window. 

 

javascript:BSSCPopup('../BUTTONS/BUTTONS_Preview_(Forms).htm');
mk:@MSITStore:C:/PROGRA~2/PEACHT~1/Help/PeachW.chm::/REP02/Options_Window_for_Reports,_Financial_Statements,_and_Forms.htm
javascript:BSSCPopup('../BUTTONS/BUTTONS_Print.htm');
javascript:BSSCPopup('../BUTTONS/BUTTONS_Design.htm');
javascript:BSSCPopup('../BUTTONS/BUTTONS_Options.htm');
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4. Income Statement (Financial Statement) 

The Income Statement shows income and expenses over a range of time, reflecting the difference as 
a profit (income greater than expenses) or a loss (income less than expenses). Peachtree's Income 
Statement sums totals for the following: 

 Total Revenues 

 Total Cost of Sales 

 Gross Profit 

 Expenses 

 Net Income (Income minus Expense) 
 

In addition, there are columns for current month and year-to-date figures, as well as the percentage 
each account represents of each subtotal. When you display or print a financial statement, Peachtree 
displays the following options: 

 

Time Frame: You have the choice of a range of periods, current period, or current three periods. If you 
select a range, use the From and To list boxes. 

Print Page Numbers: Checking this will print page numbers on the top right corner of the page. Both 
the page number and the number of pages are indicated. For example, if you are looking at page 2 of 
a 13-page document, it will display on the report as "Page: 2 of 13." 

Show Zero Amounts: Select this check box to show accounts with zero amounts. 

Print All Words Capitalized: Select this check box if you want the report to print in all capital letters. 

Right Margin/Left Margin: Enter the size of the margins you want, in inches. 

Center on Page: Select this check box if you want each page of the report to be centered on the page 
instead of left justified when it is printed. 

Number of Copies: Enter the number of copies you want to print. You can enter any number from 1 
to 99. 
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5. Balance Sheet (Financial Statement) 

 
The Balance Sheet lists all assets, liabilities, and capital of a business entity as of a specific date, such 
as the last day of an accounting period or the last day of the year. Peachtree's Balance Sheet sums 
totals for the following: 

 Current Assets 

 Property and Equipment (Fixed Assets) 

 Other Assets 

 Total Assets 

 Current Liabilities 

 Long Term Liabilities 

 Total Liabilities 

 Total Capital 

 Total Liabilities plus Capital 

When you display or print a financial statement, Peachtree displays the following options: 
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Time Frame: You have the choice of a range of periods, current period, or current three periods. If you 
select a range, use the From and To list boxes. 

Print Page Numbers: Checking this will print page numbers on the top right corner of the page. Both 
the page number and the number of pages are indicated. For example, if you are looking at page 2 of 
a 13-page document, it will display on the report as "Page: 2 of 13." 

Show Zero Amounts: Select this check box to show accounts with zero amounts. 

Print All Words Capitalized: Select this check box if you want the report to print in all capital letters. 

Right Margin/Left Margin: Enter the size of the margins you want, in inches. 

Center on Page: Select this check box if you want each page of the report to be centered on the page 
instead of left justified when it is printed. 

Number of Copies: Enter the number of copies you want to print. You can enter any number from 1 
to 99. 
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Learning Unit 3: Spread Sheet Computation 

Overview 

In this learning unit, you will learn different concepts involved in creating 
accounting sheets or ledgers using spreadsheet software by applying different 
formulas and functions. After completion of this learning unit, you will be able 
to apply error free logical, mathematical, statistical and financial formulas and 
functions, and create charts of the given data. 
 

1. Difference between Formula and Function  

A formula is a method of calculation written by user using arithmetic and logical 
operators in spreadsheet software. A formula can have values, cell references, 
defined names and functions too. 
 
For example;  =A1+A2+A3 
 
Functions are built into the software by the developer to simplify the complex 
expressions and also have wizards to help in completely applying them. 
 
For example;  =SUM(A1:A3), =AVERAGE(A1:A3) 
 

 
 
Formula & Function  
There are many types of built-in functions available in Microsoft Excel. For 
example; Logical, Mathematical, Financial, Statistical etc. 
 
 
 
 

2. Performing Logical Operations  

MS Excel has six logical operators, also called comparison operators. Logical operators (=, <, >, <=, 
>=, <>) are used to compare two values. The result of these logical operators in any given case is 
either TRUE or FALSE. The following table shows the results returned by these logical operators:  

We can easily nest 
functions but not 
formulas. 
 

 To increase an 
asset account, 
debit it. 

 To decrease an 
asset account, 
credit it. 

 To increase a 
liability or equity 
account, credit 
it. 

 To decrease a 
liability or equity 
account, debit it. 

Do you know! 

Use equal (=) sign 
as prefix to type in 
formula or function. 

Remember 

A premade method 
of calculation by the 
software developer 
is called function. 

Function 
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Logical Operators 
 

3. Applying Logical Functions 

Any operation or expression involving the use of logical operators and conditions such as AND, OR, <, 
=, that are applied to the input. Some of the logical functions are explained here. 
 
IF() Function: 
In Excel, IF() function is one of the logical functions available, and most popular and useful in 
calculations having conditional criteria. The syntax is as under: 
 
 IF(logical test, [value_if_true], [value_if_false]) 
 
The IF function evaluates a condition given in logical_test and returns the value mentioned if the 
condition is TRUE, and another value if the condition is FALSE. 
 
The following sheet demonstrates the simple workings of IF function. 
 

 
 

The IF() Function 
 
AND() Function: 
It returns TRUE if all its arguments evaluate to TRUE otherwise FALSE. The syntax is as under: 
 
   AND(logical1, [logical2], ...) 
 

 logical1 is required. The first condition that you want to test that can evaluate to either TRUE 
or FALSE. 

 logical2, ... is optional and so on. Additional conditions that you want to test that can evaluate 
to either TRUE or FALSE, up to a maximum of 255 conditions. 

Logic is reasoning 
conducted or 
assessed according 
to strict principles of 
validity. 

Logic 
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AND() Function 
 
NOT() Function: 
It returns a reversed or opposite logical value. The syntax is as under: 
 
  NOT( logical_value ) 
 

 logical_value is a required value or expression that can be evaluated to TRUE or FALSE. 
 
OR() Function: 
It returns a TRUE if any argument is TRUE and returns FALSE if all arguments are FALSE. The 
syntax is as under: 
 
   OR( logical1, [logical2, ….] ) 
 

 logical1, logical2, …. Logical1 is required, subsequent logical values are optional. Additional 
conditions can be tested to either TRUE or FALSE, up to a maximum of 255 conditions. 

 
TRUE() Function: 
It returns a logical value of TRUE. The syntax is as under: 
 
   TRUE( ) 
 
There are no arguments for the TRUE function. 
 
FALSE() Function: 
It returns a logical value of FALSE. The syntax is as under: 
 
   FALSE( ) 
 
There are no arguments for the FALSE function. 
 
The following sheet shows the working of above formulas: 
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Logical Formulas 
 
IFERROR() Function: 
It returns a specified value if a formula evaluates to an error, otherwise returns result of the formula. 
This function is used to handle errors in a formula. The syntax is as under: 
 
  IFERROR(value, value_if_error) 
 

 Value is required argument that is checked for an error. 

 Value_if_error is required value to return if the formula evaluates to an error. The following 
error types are evaluated: #N/A, #VALUE!, #REF!, #DIV/0!, #NUM!, #NAME?, or #NULL!. 

 

 
 

IFERROR() Function 
 

4. Applying Mathematical Formulas  

ABS() Function: 
It returns the absolute value of a number. The syntax is as under: 
 
  ABS( number ) 
 

 number is required value to calculate its absolute value. 
 
PRODUCT() Function: 
It multiplies all the number(s) given as argument(s). The syntax is as under: 
 
  PRODUCT(number1, [number2], ...) 
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 number1, number2, …. Number1 is required, subsequent number arguments or ranges are 
optional. Additional numbers or ranges can be multiplied, up to a maximum of 255 arguments. 

 
SUM() Function: 
It adds all the number(s) or a range(s) of cells given as argument(s). 
The syntax is as under: 
 
  SUM( number1, [number2, ..., number_n]) 
 

 number1, number2, …. A numeric value or range of cells that is required to be added. 
 
AVERAGE() Function: 
It returns arithmetic mean of all the number(s) or a range(s) of cells given as argument(s). The syntax 
is as under: 
 
  AVERAGE( number1, [number2, ..., number_n]) 
 

 number1, number2, …. are numeric values or range of cells, arrays up to 30 values. 
 
MIN() Function: 
It returns minimum or smallest value from all the number(s) or a range(s) of cells given as argument(s). 
The syntax is as under: 
 
  MIN( number1, [number2, ..., number_n]) 
 

 number1, number2, …. are numeric values or range of cells, arrays up to 30 values. 
 
MAX() Function: 
It returns maximum or largest value from all the number(s) or a range(s) of cells given as argument(s). 
The syntax is as under: 
 
  MAX( number1, [number2, ..., number_n]) 
 

 number1, number2, …. are numeric values or range of cells, arrays up to 30 values. 
 
LOG() Function: 
It returns the logarithm of a number to a specified base. The syntax is as under: 
 
  LOG( number, [base]) 
 

 number is a required value that must be greater than 0. 

 base is optional and used to calculate the logarithm, if omitted; it will use a base of 10. 
 
MOD() Function: 
It returns the remainder after dividing by a divisor. The syntax is as under: 
 
  MOD( number, divisor) 
 

 number is a required value whose remainder to be found. 

 divisor is used to divide the number parameter. If the divisor is 0, then it will return #DIV/0! 
error. 

 
POWER() Function: 
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It returns the result of a number raised to a power. The syntax is as under: 
 
  POWER( number, power ) 
 

 number is a required base value from any real number. 

 power is a required exponent to which the base number is raised. 
 
The following sheet shows the execution of all above mathematical formulas. 
 

 
 

Mathematical Formulas 
 

5. Applying Statistical Formulas  

MEDIAN() Function: 
It returns the median of the numbers provided. The syntax is as under: 
 
  MEDIAN( number1, [number2, ..., number_n]) 
 

 number1 is a numeric value that can be a number, named range, array, or reference to a 
number. 

 number2, ..., number_n are numeric values or range of cells, arrays up to 30 values. 
 
AVERAGE() Function: 
It returns arithmetic mean of all the number(s) or a range(s) of cells given as argument(s). The syntax 
is as under: 
 
  AVERAGE( number1, [number2, ..., number_n]) 
 

 number1, number2, …. are numeric values or range of cells, arrays up to 30 values. 
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MODE() Function: 
It returns the most frequently occurring, or repetitive, value in an array or range of data. The syntax is 
as under: 
  MODE( number1, [number2], ... ) 
 

 number1 is required first number argument whose mode is to be calculated. 

 number2 is optional number arguments from 2 to 255. 
 
VAR() Function: 
It returns the variance based on a sample of a population. The syntax is as under: 
 
  VAR( number1, [number2], ... ) 
 

 number1 is required first number argument corresponding to a sample of a population. 

 number2 is optional number arguments from 2 to 255. 
 
Standard Deviation: 
The standard deviation is a measure of how widely values are dispersed from the average value. 
 
STDEV() Function: 
It calculates the standard deviation based on a sample. The syntax is as under: 
 
  STDEV( number1, [number2], ... ) 
 

 number1 is required first number argument corresponding to a sample of a population. 

 number2 is optional number arguments from 2 to 255. 
 
STDEVP() Function: 
It calculates the standard deviation based on the entire population given as arguments.  The syntax is 
as under: 
 
  STDEVP( number1, [number2], ... ) 
 

 number1 is required first number argument corresponding to a population. 

 number2 is optional number arguments from 2 to 255. 
 
STDEVA() Function: 
It calculates the standard deviation based on a sample. The syntax is as under: 
 
  STDEVA( Value1, [value2], ... ) 
 

 value1, value2… value1 is required, subsequent values are optional. 1 to 255 values 
corresponding to a sample of a population. 
 

STDEV.S() Function: 
It calculates the standard deviation based on a sample, but ignores logical values and text in the 
sample. The syntax is as under: 
 
  STDEV.S( number1, [number2], ... ) 
 

 number1 is required first number argument corresponding to a sample of a population. 

 number2 is optional number arguments from 2 to 255. 



Module 4: Business Functional Process Area (Account - Bookkeeping) 

116 |                                                                          Teaching and Learning Material: Information Technology (Office Assistant) 

The following sheet shows the execution of statistical functions described above. 
 

 
 

Statistical Functions 
 

6. Applying Financial Formulas  

PV() Function: 
It calculates the present value of a loan or an investment, based on a constant interest rate. You can 
use PV with either periodic, constant payments (such as a mortgage or other loan), or a future value 
that's your investment goal. The syntax is as under: 
 
  PV(rate, nper, pmt, [fv], [type]) 
 
The PV function syntax has the following arguments: 
 

 Rate is required. The interest rate per period. For example, if you obtain an automobile loan at 
a 10 percent annual interest rate and make monthly payments, your interest rate per month is 
10%/12, or 0.83%. You would enter 10%/12, or 0.83%, or 0.0083, into the formula as the rate. 

 Nper is required. The total number of payment periods in an annuity. For example, if you get a 
four-year car loan and make monthly payments, your loan has 4*12 (or 48) periods. You would 
enter 48 into the formula for nper. 

 Pmt is required. The payment made each period and cannot change over the life of the annuity. 
Typically, pmt includes principal and interest but no other fees or taxes. For example, the 
monthly payments on a RS10,000, four-year car loan at 12 percent are RS263.33. You would 
enter -263.33 into the formula as the pmt. If pmt is omitted, you must include the fv argument. 

 Fv is optional. The future value or a cash balance you want to attain after the last payment is 
made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). For 
example, if you want to save RS50,000 to pay for a special project in 18 years, then RS50,000 
is the future value. You could then make a conservative guess at an interest rate and determine 
how much you must save each month. If fv is omitted, you must include the pmt argument. 

 Type is optional. The number 0 or 1 and indicates when payments are due. 

The sheet below shows the execution of above function. 
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PV Function 
 
FV() Function: 
It calculates the future value of an investment based on a constant interest rate. You can use FV with 
either periodic, constant payments, or a single lump sum payment. The syntax is as under: 
 
  FV(rate, nper, pmt, [pv], [type]) 
 
The FV function syntax has the following arguments: 
 

 Rate is required. The interest rate per period. 

 Nper is required. The total number of payment periods in an annuity. 

 Pmt is required. The payment made each period; it cannot change over the life of the annuity. 
Typically, pmt contains principal and interest but no other fees or taxes. If pmt is omitted, you 
must include the pv argument. 

 pv is optional. The present value, or the lump-sum amount that a series of future payments is 
worth right now. If pv is omitted, it is assumed to be 0 (zero), and you must include the pmt 
argument. 

 Type is optional. The number 0 or 1 and indicates when payments are due. If type is omitted, 
it is assumed to be 0. 

 
The sheet below shows the execution of above function. 
 

 
 

FV function 
 
RATE() Function: 
It calculates the interest rate per period of an annuity. RATE is calculated by iteration and can have 
zero or more solutions. If the successive results of RATE do not converge to within 0.0000001 after 20 
iterations, RATE returns the #NUM! error value. The syntax is as under: 
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  RATE (nper, pmt, pv, [fv], [type], [guess]) 
 
The FV function syntax has the following arguments: 

 Nper is required. The total number of payment periods in an annuity. 

 Pmt is required. The payment made each period; it cannot change over the life of the annuity. 
Typically, pmt contains principal and interest but no other fees or taxes. If pmt is omitted, you 
must include the fv argument. 

 pv is required. The present value, the total amount that a series of future payments is worth 
now. 

 fv is optional. The future value or a cash balance you want to attain after the last payment is 
made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). If fv 
is omitted, you must include the pmt argument. 

 Type is optional. The number 0 or 1 and indicates when payments are due. If type is omitted, 
it is assumed to be 0. 

 guess is optional. Your guess for what the rate will be. 

 If you omit guess, it is assumed to be 10 percent. 

 If RATE does not converge, try different values for guess. RATE usually converges if 
guess is between 0 and 1. 

 
The sheet below shows the execution of above function. 
 

 
 

RATE Function 
 
NPV() Function: 
It calculates the net present value of an investment by using a discount rate and a series of future 
payments (negative values) and income (positive values). The syntax is as under: 
 
  NPV(rate, value1, [value2],…..) 
 
The NPV function syntax has the following arguments: 
 

 Rate is required. The rate of discount over the length of one period. 

 Value1, value2, ... Value1 is required, subsequent values are optional. 1 to 254 arguments 
representing the payments and income. 

 Value1, value2, ... must be equally spaced in time and occur at the end of each period. 
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 NPV uses the order of value1, value2, ... to interpret the order of cash flows. Be sure to 
enter your payment and income values in the correct sequence. 

 Arguments that are empty cells, logical values, or text representations of numbers, error 
values, or text that cannot be translated into numbers are ignored. 

 If an argument is an array or reference, only numbers in that array or reference are counted. 
Empty cells, logical values, text, or error values in the array or reference are ignored. 

 
The sheet below shows the execution of above function. 
 

 
 

NPV Function 
 
Internal Rate of Return: 
The internal rate of return is the interest rate received for an investment consisting of payments 
(negative values) and income (positive values) that occur at regular periods. 
 
IRR() Function: 
It calculates the internal rate of return for a series of cash flows represented by the numbers in values. 
These cash flows do not have to be even, as they would be for an annuity. However, the cash flows 
must occur at regular intervals, such as monthly or annually. The syntax is as under: 
 
  IRR(values, [guess]) 
 
The IRR function syntax has the following arguments: 
 

 Values is required. An array or a reference to cells that contain numbers for which you want to 
calculate the internal rate of return. 

 Values must contain at least one positive value and one negative value to calculate the 
internal rate of return. 

 IRR uses the order of values to interpret the order of cash flows. Be sure to enter your 
payment and income values in the sequence you want. 

 If an array or reference argument contains text, logical values, or empty cells, those values 
are ignored. 

 Guess is optional. A number that you guess is close to the result of IRR. 
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 Microsoft Excel uses an iterative technique for calculating IRR. Starting with guess, IRR 
cycles through the calculation until the result is accurate within 0.00001 percent. If IRR can't 
find a result that works after 20 tries, the #NUM! error value is returned. 

 In most cases you do not need to provide guess for the IRR calculation. If guess is omitted, 
it is assumed to be 0.1 (10 percent). 

 If IRR gives the #NUM! error value, or if the result is not close to what you expected, try 
again with a different value for guess. 

 
The sheet below shows the execution of above function. 
 

 
 

IRR Function 
 

7. Drawing Charts  

Charts are the graphical representation of a series of numeric data to understand large quantities of 
data easily. 
 
Microsoft Excel no longer provides the chart wizard. Instead, you can create a basic chart by clicking 
the chart type that you want on the Insert tab in the Charts group. To create a chart that displays the 
details that you want, you can then continue with the next steps of the following step-by-step process. 
 
Activity to Create a Line Chart: 
 

1. Insert data as per below sheet 
2. Select the range B1:F7 
3. Choose Insert tab, in the Chart group, select Line, and then Line with Markers. 
4. The chart will be created as given below. 
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A Line Chart & its Data 
Change Chart Type: 
 

1. Choose the chart. 
2. On the Insert tab, in the charts group, select Bar, and then Clustered Bar. 
3. The type will be changed and appear as below. 

 

 
 

Bar Chart & its Data 
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Add Chart Title: 
 

1. Choose the chart. 
2. Select Layout tab, click Chart Title and then Above Chart. 
3. Chart Title will appear above the chart as shown below and then give a chart title as per your 

desire. 

 
 

Adding a Chart Title 
 
Changing Row/Column Data: 
 

1. Choose the chart. 
2. Select Design tab, click Switch Row/Column from Data Group. 
3. The following chart will be displayed showing the switched Row and Column data. 
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Changing Row/Column Data 
 
Creating a Pie Chart: 

Pie charts are used to display the contribution of each value (slice) to a total (pie). Create a Pie chart 
by following the below mentioned steps: 

 
1. Select the range B1:F2 
2. Choose Insert tab and from the Chart group, Select Pie and Choose the Pie. 
3. The Pie chart will be shown as below. 
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Pie Chart 
 
Switching Legend Position: 

1. Choose the chart. The contextual tab of Chart Tools will be activated. 
2. Select Layout tab, choose Legend and select Show Legend at Left. 
3. The legend will be displayed on the left as shown below. 

 

 
 

Legend Position 
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Data Labels: 

1. Select the Chart. 
2. Choose the Layout Tab, click Data Labels from Labels Group, and select Center. 
3. Data Labels will be displayed in the center of each bar as shown below. 

 

 
 

Data Labels 
 
Changing Colors: 

1. Choose the Chart. 
2. Select the Plot area of the chart by clicking at the back of Bars. 
3. Choose Format tab, click Shape Fill from Shape Styles Group, and select the desired color. 
4. The color of the Plot area of the Chart will be shown as below. 
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Colored Plot Area 
 

8. Text Editing  

Text editing in a cell can be made directly. Type the text in a cell or change the cell contents in edit 
mode or by typing in the formula bar. When you edit the contents of a cell, Excel is operating in Edit 
mode. Some Excel features work differently or are unavailable in Edit mode. 
 
Text editing in Excel is the process of inserting, deleting and changing of cell contents. If you want to 
insert text or numbers just select the cell and type the desired text or numbers and press enter key. 

Similarly, press DEL key to delete the contents simply and if you want to 
change the cell contents, click in the formula bar or double click within the cell, 
and change the cell contents as per your desire. 
 
Apart from above, if you want to move or copy the cell contents to another 
location, right click the mouse button on a cell, the following contextual menu 
will appear. 

 
Right Click Menu 
Select the cell whose contents to be moved to other location, right click and 
choose Cut from the menu and right click on other location and select Paste. 
The contents of the cell moved from its original location to other. Similarly, 
follow the same procedure by choosing the Copy instead of Cut option from 
the menu. 
 

 
 
 
 
 

Right Click Menu 
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9. Enable Cell Editing 

Text editing is always done in a cell Edit Mode. To enable cell editing, Just press F2 
key or Click in the formula bar or double click in the cell. The word Edit will be 
displayed at the bottom left corner as shown below. 

 
 
 

            Edit Mode 
 

10. Protecting an Excel Document  

In Microsoft Office system, you can use passwords to help prevent other people from opening or 
modifying your documents, workbooks, and presentations. Keep in mind that Microsoft cannot 
retrieve forgotten passwords. To set the Password: 

 
1. Open the Excel Document 
2. Click File menu 
3. Choose Save As 
4. In the Save As dialog box, open the Tools list and click General Options as shown below. 

 

 
 

5. Type either of two passwords here, one to open the file, another to change the file as shown in 
the picture below. 
 

 

6. Now the Excel document is Password protected. 
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Summary of Module 

 To understand financial accounting system and accounting cycle  basic accounting 
terminologies e. g credit, debit, revenue, expense, taxation, invoice, receipt, capital, assets, 
liabilities, equity, journal, ledger, trail balance, income statement , balance sheet, charts of 
account are basic key concept to work in computerized accounting software like Peachtree. 
 

 Depreciation is a systematic and rational process of distributing the cost of tangible assets over 
the life of assets. 
 

 The General Journal is used to enter those types of transactions that are not readily categorized 
in the Tasks menu. Typical General Journal entries include chart of account beginning 
balances, depreciation, and account transfers. 
 

 The Balance Sheet lists all assets, liabilities, and capital of a business entity as of a specific 
date, such as the last day of an accounting period or the last day of the year. 
 

 To start working in Peachtree setting company profile, creating charts of Account, post entries 
in ledger and calculate balance sheet using Peachtree are basic level operation.  
 

 Learner must have expert level skill in MS Excel create different types of sheets; apply 
formulas e. g mathematical, logical, computational and statistical and proficient in creating 
charts.        
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is formula? 

Answer 
A self or user made method of calculation within a spreadsheet is called Formula. 
For example; =A1+C3/4-D2 

FAQ 2:  What do you mean by Function? 

Answer 
A premade or built-in method of calculation within the spreadsheet is called 
Function? 
For example; MODE(A1:D4), AVERAGE(C3:D6) 

FAQ 3:  What is Internal Rate of Return? 

Answer 

The Internal Rate of Return is the interest rate received for an investment consisting 
of payments (negative values) and income (positive values) that occur at regular 
periods. The IRR() function in the spreadsheet is used to calculate Internal Rate of 
Return. 

FAQ 4:  Define Standard Deviation? 

Answer 
The Standard Deviation is a measure of how widely values are dispersed from the 
average value (arithmetic mean). The STDEV() function in the spreadsheet is used 
to calculate Standard Deviation. 

FAQ 5:  Define Pie chart? 

Answer 

A graphic representation of quantitative information by means of a circle divided into 
sectors, in which the relative sizes of the areas (or central angles) of the sectors 
correspond to the relative sizes or proportions of the quantities. Pie Charts are 
always used to display one data series. 

FAQ 6:  What do you mean by a Debit entry in accounting? 

Answer 
A debit is an accounting entry that either increases an asset or expense account, or 
decreases a liability or equity account. It is positioned to the left in an accounting 
entry. 

FAQ 7:  What do you mean by a Credit entry in accounting? 

Answer 
A credit is an accounting entry that either increases a liability or equity account, or 
decreases an asset or expense account. 
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FAQ 8:  Define financial reporting? 

Answer 
Financial reporting tells the real positions of a business. It consists of Profit & Loss 
Account, Balance Sheet and Cash flow. 

FAQ 9:  What is Balance sheet? 

Answer 
A statement of the assets, liabilities, and capital of a business or other organization 
at a particular point in time, detailing the balance of income and expenditure over 
the preceding period. 

FAQ 10:  What is Journal in accounting? 

Answer 

In accounting and bookkeeping, a journal is a record of financial transactions in 
order by date. A journal is often defined as the book of original entry. Manual 
systems usually had a variety of journals such as a sales journal, purchases journal, 
cash receipts journal, cash disbursements journal, and a general journal. 

  

  

http://www.accountingcoach.com/blog/what-is-accounting
http://www.accountingcoach.com/blog/what-is-bookkeeping
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  To insert a function in Excel, Select ________. 

a.  Insert tab, Insert Function Button b.  Formulas tab, Insert Function 

c.  Home tab, Insert d.  All of the above 

2.  Which of the following is not the correct method of editing the cell content? 

a.  Press the Alt key a.  Press the F2 key 

b.  Click in the Formula bar b.  Double click cell 

3.  A function within another function is called ________. 

a.  Round Function a.  Sum Function 

b.  Text Function b.  Nested Function 

4.  Peachtree Accounting is the part of  ________. 

a.  Financial Accounting b.  Advanced Accounting 

c.  Computerized Accounting d.  Cost Accounting 

5.  The cell reference for cell range of C1 to X8 is ________. 

a.  C1;X8 b.  C1.X8 

c.  C1,X8 d.  C1:X8 
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6.  Which of the following is not the correct syntax of a SUM Function? 

a.  =SUM(D1, F3) b.  =SUM(D1:F3) 

c.  =SUM(D1:D3, F1:F3) d.  =SUM(D1’ F3) 

7.  Which of the following is used to insert new line in the same cell? 

a.  Enter b.  Alt+Enter 

c.  Ctrl+Enter d.  Shift+Enter 

8.  Which of the following is used to add two cells (A1 and A2)? 

a.  =A1 + A2 b.  =Add(A1+A2) 

c.  =together(A1:A2) d.  A1 plus A2 

9.  The advantage of using a spreadsheet is: 

a.  
Calculations can be done 
automatically. 

b.  
Changing data automatically updates 
calculations 

c.  More flexibility d.  All of the above 

10.  Which of the following is a Mathematical Function? 

a.  MODE() b.  AND() 

c.  MOD() d.  None of the above 
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Answer Key 
MCQ Number Correct Answer 

1 b 

2 a 

3 d 

4 c 

5 d 

6 d 

7 b 

8 a 

9 d 

10 c 
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Module 5: Business Functional Process 
Area (Inventory Control-Store Keeping) 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Understand the different commonly known terminologies. 

 Understand different warehousing techniques. 

 Familiar with applicable depreciation rules. 

 Suggest and Implement safety parameters for protection of 
Inventory.  

 Keep record of entry and exit dates for each and every item.  

 Post (Input) the stock entries in any database tool e.g. Microsoft 
Access table/form.  

 Apply different search criteria (query) on data.  

 Generate stock report(s).  

 Import report to different formats.  

 Understand the functionality of “Create” tab. 

 Create table in Microsoft Access.  

 Design form for a table.  

 Design different queries applicable for a table.  

 Design and generate (Produce) reports from a table.  
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Learning Unit 1: Basic Terminologies of Store Keeping 

Overview 

Store-keeping includes the receipts and issues of materials, their recording, 
movements in and out of the store and safeguarding of materials. There are 
different terminologies used for store keeping like Stock, JIT, FMCG, Cost of 
Goods, Freight, Supply chain system and many others. This learning unit will 
cover the basic terminologies about store keeping, use of warehouses, 
depreciation and its types. After completion of this learning unit you will be able 
to describe the store keeping strategies, different warehousing techniques and 
depreciation and its types.  

 

 

1. Terminologies of Store Keeping 

Store Keeping  
A store refers to “raw materials” work-in-progress and finished goods remaining 
in stock. Store-keeping means the activities relating to purchasing, issuing, 
protecting, storing and recording of the materials. Store-keeping includes the 
receipts and issues of materials, their recording, movements in and out of the 
store and safeguarding of materials. The store is a service department headed 
by a store-keeper who is responsible for a proper storage, protection and issue 
of all kinds of materials. Many terminologies are used for store keeping which 
are given below: 
 
1. Stock 
Stocking is the process of filling the store's shelves and displays with 
merchandise for sale, commonly referred to as "stock." Stocking can also refer 
to the process of storing goods in the store's backroom or warehouse.  

 

2. Just In Time (JIT) 
JIT or Just In time is an inventory strategy that companies employ to increase efficiency and decrease 
waste by receiving goods only as they are needed in the production process, thereby reducing 
inventory costs. Just in time inventory is intended to avoid situations in which inventory exceeds 
demand and places increased burden on business to manage the extra inventory. 

 
 
3. FMCG ( Fast Moving Consumer Goods) 
Fast-moving consumer goods (FMCG) or consumer packaged goods (CPG) are products that are sold 
quickly and at relatively low cost. It includes non-durable goods such as soft drinks, toiletries, 
processed foods and many other consumables. 

The basic job of the 
Stores Manager 
hence is to receive 
the goods and act 
as a caretaker of the 
materials and issue 
them as and when 
Production demands 
it. 

Remember 

The goods or 
merchandise kept 
on the premises of a 
shop or warehouse 
and available for 
sale or distribution. 

Stock 

FMCG's are all the 
things you buy 
regularly and 
probably like soap, 
shampoo, anything 
you need. 

Do you know! 

http://www.investopedia.com/terms/i/inventory.asp
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Work Cycle of FMCG  

 
 
4. Cost of Goods 
There are two types of cost of goods that is necessary to consider. These are given below: 

 

Cost of Goods Sold 
Cost of goods sold (COGS) is the direct costs attributable to the production of 
the goods sold by a company. This amount includes the cost of the materials 
used in creating the good along with the direct labor costs used to produce the 
good. COGS appear on the income statement and can be deducted from 
revenue to calculate a company's gross margin. Also referred to as "cost of 
sales." 

 

Cost of Goods Sold Formula 
 
Cost of Goods Manufactured 
Cost of goods manufactured is based on the amount of work-in-process completed. This work-in-
process includes costs of direct materials put into production, plus direct labor and overhead. 

The just-in-time 
inventory model 
allows companies to 
reduce their 
overhead 
expenses.re their 
products. 

Do you know! 

Cost of goods sold 
is the cost of the 
merchandise that 
was sold to 
customers. 

Remember 
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Cost of Goods Manufactured Formula 
 
5. Freight 
Freight is a charge paid for carriage or transportation of goods by air, land, or sea. Goods may be 
transported on freight-prepaid or freight -collect basis:  

If the freight is paid by the consignor, the goods remain the consignor's property until their delivery is 
taken by the consignee upon their arrival at the destination, and payment of the consignor's invoice. 

If freight is paid by the consignee, the goods become the consignee's property when handed over to 
the carrier against a bill of lading. 

 

6. Supply-Chain System  
Supply chain management (SCM) is the system of the flow of goods and 
services. It includes the movement and storage of raw materials, work-in-
process inventory, and finished goods from point of origin to point of 
consumption. Supply chain management has been defined as the "design, 
planning, execution, control, and monitoring of supply chain activities with the 
objective of creating net value, building a competitive infrastructure, leveraging 
worldwide logistics, synchronizing supply with demand and measuring 
performance globally. 

 

Supply chain System 

 
7. Periodic Maintenance Schedule 
Significant activities carried out regularly to maintain the condition or operational status of a building, 
equipment, machine, plant, or system. Also called time based maintenance. A complete schedule of 

A supply chain is a 
system of 
organizations, 
people, activities, 
information, and 
resources involved 
in moving a product 
or service from 
supplier to 
customer. 

Supply Chain 
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maintenance can be created and automatically added to a specific Service Calendar. Maintenance 
schedules can even be divided by “route”. 

 

8. Expiry Date 
The date on which something comes to an end, can no longer be used, or is no longer safe to be eaten 
is called its expiry date. 
 
 
9. Salvage Value 
Salvage value is the estimated resale value of an asset at the end of its useful life. Salvage value is 
subtracted from the cost of a fixed asset to determine the amount of the asset cost that will be 
depreciated. Thus, salvage value is used as a component of the depreciation calculation. 

 

 
Salvage Value 

 

2. Warehouse  

Warehouse is a commercial building for storage of goods. Warehouses are used by manufacturers, 
importers, exporters, wholesalers, transport businesses, customs, etc. They are usually large buildings 
in industrial areas of cities, towns and villages. They usually have loading docks to load and unload 
goods from trucks. Sometimes warehouses are designed for the loading and unloading of goods 
directly from railways, airports, or seaports. 

 
Warehouse Management System 
Warehouse Management System (WMS) is a software application that supports day-to-day operations 
in a warehouse. WMS programs enable centralized management of tasks such as tracking inventory 
levels and stock locations. WMS systems may be standalone applications or part of an Enterprise 
Resource Planning (ERP) system. 
 
Warehousing Techniques 
Proper warehousing techniques can lead to achieving the company goals. But it requires a fine-tuned 
combination of strategic actions, organizational capabilities, and enabling technologies. 
 
1. Focus on the Long Term 
 Concentrating on the short-term effects of a warehouse management system can cause a business 
to fixate too closely on the upfront deployment costs. Projecting what the organization will look like five 
to ten years down the road can help decision-makers find a solution that responds to its greatest 

Salvage value is the 

estimated resale 

value of an asset at 

the end of its useful 

life. 

Remember 
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perceived challenges. If uncertainty persists, it's important to find an option that is adaptable and 
versatile enough to change as the business does. 
 
2. Establish a Project Team 
It allows for a dedicated team to concentrate on implementation as their main activity, instead of as a 
side project. It also diversifies the input that goes into the selection process. Thinking long term, it 
establishes a group of employees well-versed in the solution selected and able to articulate its business 
case to other personnel. 
 
3. Recognize the Value of a Business Partnership 
 The warehouse management solutions provider should be a company that can readily accommodate 
every need. Forming an alliance can help the organization better communicate its warehousing 
challenges and objectives. This enables the provider to customize its management solution to address 
the areas that need the most short- and long-term attention.  
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Learning Unit 2: Data Management 

Overview 

The most important asset of any organization is data. It is necessary to keep 
the data in manageable form so it can take no time to keep or retrieve it. This 
learning unit covers the data management in a database software like MS 
Access. After completion of this learning unit you will be able to create 
database, tables / forms, Report generating and exporting it in other format, 
Encrypting a database using password in MS Access 2013.  
 
 
 

1. Creating Database and Table in MS Access  

MS access is one of the most popular and user friendly database tool.MS 
Acxcess database hold the actual data records inside tables. The user can add, 
edit, and delete records directly from these tables. Databases can include forms 
for entering data, queries for searching within it, reports for analyzing it, and 
tables for storing it. Whenever a user work with database, She/he is working 
with many of these objects at once. For entering data in a database in MS 
Access first create a Database and then create a table in MS Access. 

 

 
Creating a Database in MS Access  
 

1. Open MS Access from the computer. 
2. Click on create database option. 
 

 
 

Creating database in MS Access  
 

3. Write the name of the database and then click on Create button. 

There are many 
other software used 
for database 
management like 
Oracle, My SQL but 
MS Access is easy 
to use for its users. 

Remember 

A database is a 
collection of 
information that is 
organized so that it 
can easily be 
accessed, managed, 
and updated. 

Database 

MS Access is one of 
the most popular 
and user friendly 
database tool. MS 
Access database 
hold the actual data 
records inside 
tables. 

Do you know! 
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Creating database in MS Access  
 

4. The database will be created. 
 
 
Creating Table in MS Access using Design View 
 
For entering data in database it is necessary to create table/ Form in MS 
Access. For creating table do the following: 
 

1. In MS Access click on Create Tab and then click on Table.  
2. Click on the View button and open the table in Design View. 

 

 
 

3. Now give the field names that are required. 
4. Set the type of data of each field in right side column. 

 

 
 

Creating Table in MS Access 
 

Design view enables 
you to design and 
set up your 
database (kind of a 
"behind the scenes" 
view of your 
database). 

Design View 
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5. Enter sample data of each field in each field of the table in Datasheet View. 
6. The table is created now. 

 

2. Designing a Form in MS Access  

Creating forms for database can make entering data more convenient. When a form is created, it can 
design in a way that works with database and that make sense to the user. 

 
Creating a Form 
Access makes it easy to create a Form from any table in database. Any form that is created from a 
table will let view the data that's already in that table and add new data. There are different methods of 
creating forms. Options include using the Form Wizard, Design view, and even starting with a blank 
form. The option you choose will depend on your own preference and perhaps the type of form that 
you want to create. 
 

 In the Navigation pane, select the table you want to use to create a form.  

 Select the Create tab, locate the Forms group, and click the Form command. 
 

 
 

1. Your form will be created and opened in Layout View. 
 
 

       
 

To save the form, click the Save command on the Quick Access Toolbar or press CTRL+ S. When 
prompted, type a name for the form, then click OK. 
 

 

You can also add 
fields in a Form from 
different tables.  

Remember 
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Creating Forms Using Wizard 
 
Form can also be created using Form wizard. For creating forms using wizard do the following: 
 

1. Click on Form wizard under Create Tab. 
 

 
 

2. A dialogue box will be open. Select the fields that are required. 
 

 
 

Creating Form using Wizard  
 

3. Click Next and select the required View of the form. Tabular, columnar or any other. Then click 
Next button. 

 
 

Creating Form using Wizard  
 

Wizard is the most 
easy way to create 
forms in MS Access. 

Do you know! 
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4. Select the required option in next dialogue box and click Finish button. 
 

 
 

Creating Form using Wizard  
 

5. Your form will be added and open in Layout View. 
 

 

3. Inserting Data into the Form  

After creating the forms it is very easy to enter data into the form. For entering data into the form do 
the following: 
 

1. When the form is created in Layout view of the Form click on the required field in which you 
want to enter the data. 
 

        
 

Inserting Data in Form  
 

2. Enter the data in all the fields.  
 

 
 

You can insert data 
in a form using 
datasheet view of 
that table also. 

Do you know! 
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3. For inserting new record click on the aero button in search field at the bottom. The new record 
will be inserted. 
 

 
 

Adding New Record in Form  
 

4. Designing a Simple Query  

Queries allow you to get information from one or more tables based on a set of search conditions you 
define. The real power of a relational database lies in its ability to quickly retrieve and analyze your 
data by running a query. Creating query using wizard is easy. 

 
1. Select the Create tab on the Ribbon, and locate the Queries group. 

 

 
 

2. A dialogue box will appear select the simple Query option and then click Ok. 
 

Query can be 
created using one 
table and two or 
more tables also. 

Remember 
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Creating Simple Query Using Wizard  
 

3. Another dialogue box will appear select the columns from the table from which you want to 
generate Query. Click Next. 
 

 
 

Creating Simple Query Using Wizard  
 

4. Again in the next dialogue box it will ask would you like to detail or summary Query. Select your 
required option and click next. 

5. In next dialogue box it will ask about query Title and option to Open the query or Modify it in 
design view. 

6. Select the option you want and click Finish. 
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Creating Simple Query Using Wizard  
 

7. The Query will be created. Save the query using save command or CTLR+ S. 
 

 
Creating Simple Query Using Wizard 

  
8. You can Insert, Delete and Update a query to open it in Design View. 

 

 
Edit a Query  

 
9. Select the required fields from the table in design view and give criteria to run any query (Insert, 

Delete, Update) and click on Run command in the ribbon. The query will be created. 
 

Query is asking a 
question about 
something, 
especially in order to 
express one's 
doubts about it or to 
check its validity or 
accuracy. 

Remember 
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Query Result  

 

5. Designing and Generating Report form a Table  

Reports give the ability to present components of the database in an easy-to-read, printable format. 
Access let the user to create reports from both tables and queries. 

 
1. Open the table or query you want to use in your report. 
2. Select the Create tab on the Ribbon. Locate the Reports group, then click the Report command. 

 

 
 

Report Button  
 

1. It's likely that some of the data will be located on the other side of the page break. To fix this, 
resize the fields. Simply select a field, then click and drag its edge until the field is the desired 
size. Repeat with additional fields until all of your fields fit. 
 

 
 

Resizing Report Fields  
 

Organizing the Report 
Information is often easier to understand when it is divided into groups. Microsoft Office Access 2013 
makes working with grouped reports easy. You can create a basic grouped report by using the Report 
Wizard, you can add grouping and sorting to an existing report, or you can revise grouping and sorting 
options that have already been defined. For setting group levels and order of fields: 
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1. Click on Report Wizard button under Create Tab. 

2. The Report Wizard will appear. 

3. Click the drop-down arrow to select the table or query that contains the desired field(s). 

4. Select a field from the list on the left, and click the right arrow to add it to the report. 

 

 
 

Report Wizard Selecting Table and Fields  
 

5. Click Next when you are satisfied with the basic organization of your data. 

6. If you're not satisfied with the way your data is organized, you can now modify the grouping 
levels. Select a field from the list, and click the right arrow to add it as a new level. 

 

 

Adding Grouping Levels 
 

7. If necessary, modify the order of your grouped fields by selecting a field and clicking the up or 
down Priority arrow to move it up or down a level.  

Sorting Report Data 

1. Click the top drop-down arrow, and select the name of the first field you want to sort. 

2. Click the button on the right to change the sort to ascending or descending.  

 

Depending on the 

grouping you have 

chosen for your 

data, your sorting 

options may be 

limited. 

Remember 
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Apply Sorting 

Selecting a layout and Orientation 

1. Click the various layout options to see how they look, then select one to use in your report. 

2. Select either a portrait (tall) or landscape (wide) orientation for your report. Click Next. 

 

 
 

Selecting Layout and Orientation 
 

3. Select the text box, and type the title you would like for your report.  
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4. Select whether you want to preview the report or modify its design, then click Finish. 

 
 

Selecting Title for the Report 
 
5. The report will be created and saved. 

 

 
Report Preview  

 
 

6. Exporting Report  in Other Formats 

For exporting report in other formats, you need to follow the steps given below: 

1. From the Home tab, click the View command, then select Print Preview from the drop-down list. 

2. Locate the Data group on the Ribbon. 

3. Select one of the file type options, or click More to see options to save your report as a Word or 
HTML file.  

a  

Database Exporting Options 
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4. A dialog box will appear. Select the location where you want to save the report.  
5. Enter a file name for the report, then click Publish. 

 

Saving and Publishing a Report 
 
6. A dialog box will appear to notify you that your file has been successfully saved. Click Close to 

return to your report. 
 
 

7. Protecting an Access Document with a Password  

Encrypt a Database by using a password 
To create and apply a password to an Access 2013 database, use the following steps: 
 

1. Open the database in Exclusive mode. 

2. On the File tab, click Open. 

3. In the Open dialog box, browse to the file that you want to open, and then select the file. 

 
 

Browsing and Opening a Document  
 

4. Click the arrow next to the Open button, and then click Open Exclusive.  
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Browsing and Opening a Document  
 

5. On the File tab, click Info, and then click Encrypt with Password. 
 

 
Encrypting a Document  

 
6. The Set Database Password dialog box appears. 
7. Type your password in the Password box, type it again in the Verify box, and then click OK. 

 
 

  

Data encryption is 
the act of changing 
electronic 
information into an 
unreadable state by 
using algorithms or 
ciphers. 

Data encryption 
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Learning Unit 3: Stock Entries 

Overview 

This learning unit will cover the procedure for creating database creating form or tables and make stock 
entries in database, apply different searching techniques on this database creating reports. After 
completion of this learning unit you will be able to create database, creating Tables/ forms, searching 
data in database like create query and generating reports. 
 

1. Stock Keeping of Inventory in MS Access 
 

Create a database and then create a table/ from for stock entries according to the following 
instructions: 

Description: This activity will be performed by the individual to create a database and 
table/ Form of stock entries. 

 Develop a table in MS Access with following fields Item no. , 
Quantity, Entry date, Warranty, Item Specification, Vendor Data, 
Remarks, Inspection findings. 

 Design form for above designed table 

 Make at least 20 entries using form in above designed table 

 Search data based on following criteria on item whose weight are 
less than 2 KG and having green color. 

 Generate report of table data and export in other format like .pdf, 
word and excel. 

Time Guideline: This activity will take 2 and half hours.    

Presentation:  

 

After the completion of activity instructor will check individual work.  
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Summary of Module 

  A store refers to “raw materials” work-in-progress and finished goods remaining in stock. 
Store-keeping means the activities relating to purchasing, issuing, protecting, storing and 
recording of the materials. 

  The goods or merchandise kept on the premises of a shop or warehouse and available for 
sale or distribution. 

  Fast-moving consumer goods (FMCG) or consumer packaged goods (CPG) are products 
that are sold quickly and at relatively low cost. It includes non-durable goods such as soft 
drinks, toiletries, processed foods and many other consumables. 

  The just-in-time inventory model allows companies to reduce their overhead expenses.re 
their products. 

  Cost of goods sold (COGS) is the direct costs attributable to the production of the goods 
sold by a company. This amount includes the cost of the materials used in creating the good 
along with the direct labor costs used to produce the good. 

  Freight is a charge paid for carriage or transportation of goods by air, land, or sea. 

  Salvage value is the estimated resale value of an asset at the end of its useful life. Salvage 
value is subtracted from the cost of a fixed asset to determine the amount of the asset cost 
that will be depreciated. 

  A warehouse is a commercial building for storage of goods. Warehouses are used by 
manufacturers, importers, exporters, wholesalers, transport businesses, customs, etc. They 
are usually large buildings in industrial areas of cities, towns and villages. 

  Depreciation is the gradual decrease in the economic value of the capital stock of a firm or 
other entity, either through physical depreciation, changes in the demand for the services of 
the capital in question. 

  MS access is one of the most popular and user friendly database tool.MS Access database 
hold the actual data records inside tables. The user can add, edit, and delete records directly 
from these tables. 

  Creating forms for database can make entering data more convenient. When a form is 
created, it can design in a way that works with database and that make sense to the user 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is the maximize size of an Access database?  

Answer 
The maximum size of an Access database is two (2) gigabytes. This limit applies to 
both .mdb files and the newer Access database format files .accdb. For Access 
databases that have reached this limit, you have a number of options. 

FAQ 2:  What is store management? 

Answer 

Store Management includes various responsibilities such as receiving the raw 
material, protecting the raw materials protecting from damage, spoilage and keep the 
finished goods until the goods are dispatched. Store management also includes 
distribution of material in right quantity at the right time and at the right place. 

FAQ 3:  What is JIT Management system? 

Answer 
Just in time (JIT) inventory is a management system in which materials or products 
are produced or acquired only as demand requires. 

FAQ 4:  What is the purpose of Depreciation? 

Answer 

The purpose of depreciation is to charge to expense a portion of an asset that relates 
to the revenue generated by that asset. This is called the matching principle, where 
revenues and expenses both appear in the income statement in the same reporting 
period, which gives the best view of how well a company has performed in a given 
accounting period. 

FAQ 5:  What are the Characteristics of FMCG? 

Answer 

 Frequent purchase 
 Low involvement (little or no effort to choose the item) 
 Low price 
 Short shelf life 
 Must use for daily consumption 

FAQ 6:  What is Warehouse Management system? 

Answer 

A warehouse management system (WMS) is a part of the supply chain and primarily 
aims to control the movement and storage of materials within a warehouse and 
process the associated transactions, including shipping, receiving, put away and 
picking. 

FAQ 7:  Is the Residual value and salvage value is the same? 

Answer 
Residual value, salvage value and scrap value are three terms that refer to the 
expected value at the end of the useful life of the property, plant and equipment used 
in a business. 
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FAQ 8:  What is the residual value of an asset? 

Answer 
In accounting, residual value is another name for salvage value, the remaining value 
of an asset after it has been fully depreciated. The residual value derives its 
calculation from a base price, calculated after depreciation. 

FAQ 9:  Why MS Access is used? 

Answer MS Access is easy to use for its users 

FAQ 10:  What is Freight? 

Answer A freight rate is a price at which a certain cargo is delivered from one point to another. 
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Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  All of the following are the methods of inventory costing except_______________. 

a.  FIFO b.  LIFO 

c.  AVCO Average cost d.  Stock take 

2.  Opening inventory + Net purchases = What?  

a.  Ending inventory b.  Closing stock 

c.  Cost of goods manufactured d.  Cost of goods available for sale 

3.  An asset possess which of the following? 

a.  
Future economic benefits for the 
business 

b.  All kind of benefits for the business 

c.  Expenses for the business d.  Merits and Demerits for the business 

4.  Which of the following is not an inventory? 

a.  Machines b.  Raw material 

c.  Finished products d.  Consumable tools 

5.  What is depreciation? 

a.  Cost of a fixed asset b.  Cost of a fixed asset’s repair 

c.  The residual value of a fixed asset d.  
Portion of a fixed asset’s cost 
consumed during the current 
accounting period. 

6.  What are the main objects that make up an Access Database? 

a.  Records, Forms, Queries, and Tables b.  
Forms, Queries, Records, and 
Reports 

c.  Forms, Queries, Tables, and Reports d.  Records, Tables, and Queries 

7.  
Ahmad needs to compile a list of all of her customers who have not paid their bill 
yet. What’s the best tool to do this? 

a.  Forms b.  Query 

c.  Table d.  Record 
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8.  In Access, the rows and columns of a table are referred to as _______________. 

a.  records and fields b.  records and categories 

c.  filters and categories d.  placeholders and categories 

9.  Air freight is costly, but its speed may create savings because of: 

a.  Lower Inventory b.  
Getting to store shelves before water 
carriers. 

c.  Lower costs created by FIFO. d.  
Other transportation modes take more 
time. 

10.  A supply chain is essentially a sequence of linked: 

a.  customer and prospects b.  suppliers and customers 

c.  supplier and manufacturer d.  events in the marketing process 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 d 

3 a 

4 d 

5 d 

6 c 

7 b 

8 a 

9 a 

10 b 
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Module 6: Business Functional Process 
Area (HRM) 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Understand the working of Human Resource management 
Information System.  

 Keep Employees record updated.  

 Provide assistance in calculation of Payroll of the company.  

 Design and Create Organization’s employee database.  

 Update daily attendance (Punctuality, Regularity) record of each 
worker in database.  

 Keep the accounts related information of each employee.  

 Maintain the performance assessment of every individual.  
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Learning Unit 1: Familiarity with HRM 

Overview 

In this leaning unit, you will learn the working of Human Resource Management Information System, 
Employees record updation and calculation of Payroll of the company .After completion of this Learning 
unit you will able to  demonstrate HRIS ,maintain employee record  &pay roll of company .  
 

1. Common Human Resource Management Terminologies  

Human Resource Management (HRM) is the process of hiring and developing employees so that they 
become more valuable to the organization. Human resource management includes conducting job 
analyses (TNA), planning personnel needs, recruiting the right people for the job, orienting and training, 
managing wages and salaries, providing benefits and incentives, evaluating performance, resolving 
disputes, and communicating with all employees at all levels. Examples of core qualities of HR 
management are extensive knowledge of the industry, leadership, and effective negotiation skills. 
Formerly called personnel management. 

 

Human Resource Management Functions 

 

Employee Retention 

An effort by a business to maintain a working environment which supports current staff in remaining 
with the company. Many employee retention policies are aimed at addressing the various needs of 
employees to enhance their job satisfaction and reduce the substantial costs involved in hiring and 
training new staff. The advantages of high employee retention are as follows:            

1. A lot of investment is needed to train an employee and to make him productive. If such an employee 
leaves the organisation; they lose the money invested and also an employee who could have 
contributed significantly to the organisation. 

2.  
3. If a person employed in a critical role leaves, then it disturbs the functioning of the organisation. Also, 

to replace such an employee involves huge costs. 

Human Resources Information System (HRIS) 

A Human Resources Information System (HRIS) is software or online solution that is used for data 
entry, data tracking and the data information requirements of an organization's human resources (HR) 
management, payroll and bookkeeping operations. A HRIS is usually offered as a database.  

 

HRIS is geared toward enhancing the capacity of HR management to: 

Human 
Resource

Recruitment
Employee 
Relations

Training Payroll
Benefits 

Administration

http://www.businessdictionary.com/definition/developer.html
http://www.businessdictionary.com/definition/employee.html
http://www.businessdictionary.com/definition/job.html
http://www.businessdictionary.com/definition/need.html
http://www.businessdictionary.com/definition/recruiter.html
http://www.businessdictionary.com/definition/right.html
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 Absorb new and promising technologies 

 Simplify workflow 

 Optimize precision, stability and credibility of workforce data 

 Simplify the deployment and collection of data 

An efficient HRIS provides:                                                                          

 Administration of all staff data 

 Reporting and evaluation of staff data 

 Company-related records, including staff handbooks, disaster 

evacuation methods and security recommendations 

 Rewards management, such as enrolment, status modifications and 

updating of personal data 

 Comprehensive integration with payroll, in addition to other accounting 

systems and financial software 

 Applicant monitoring and resume administration                

An efficient HRIS helps an organization track:                                                     

 Paid time off (PTO) and attendance 

 Pay scale history 

 Positions and pay grades                                                            

 Overall performance development strategies 

 Coaching obtained 

 Disciplinary actions 

 Personal staff data 

 Key staff succession plans 

 Identification of prospective staff 

 Applicant administration, including interview process and selection 

An organization can select and customize a HRIS it to meet its requirements. An efficient HRIS 
provides an organization with information on virtually anything required to monitor and examine 
staff/applicant data. A customized HRIS helps HR train staff to execute administrative tasks, allowing 
HR to focus on other strategic functions.  
 
In addition, information required for knowledge development, equal treatment, staff management and 
career growth is provided. Also, managers can gain access to the information required to efficiently 
and legally assist the success of their direct reports. 

An efficient HRIS 
provides an 
organization with 
information on 
virtually anything 
required to monitor 
and examine 
staff/applicant data. 

Remember 
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HRIS Functions 

Below are tools and employee retention tips for communicating with staff: 

 Toilet notices and notices in lifts 
 Electronic 
 SMS 
 Telephone campaign 
 Email 
 Surveys 
 Questionnaires 
 Climate surveys 
 Quarterly feedback session 
 Desk drops 
 Fun email surveys questions with fun surveys email people and my space bulletin surveys 
 Create online calendars 
 Bookmark template 
 Letterhead templates 
 Creative presentation idea  
 Ice breakers staff meetings 
 Goody bag idea 
 Strange unique gifts    

Fringe Benefits  

The term fringe benefits refer to the extra benefits provided to employees in addition to the 
normal compensation paid in the form of wage or salary. Many years ago, benefits and services were 
labeled “fringe” benefits because they were relatively insignificant or fringe components of 
compensation. However, the situation now is different, as these have, more or less, become important 
part of a comprehensive compensation package offered by employers to employees. 
 
 

Fringe benefits are 
tools used by human 
resources to hire 
and retain top talent 
and to help create a 
motivated workforce. 
 

Fringe Benefits 

http://www.workplace-communication.com/bookmark-template.html
http://hrmpractice.com/tag/benefits/
http://hrmpractice.com/tag/compensation/
http://hrmpractice.com/tag/salary/
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Purpose 

Fringe benefits are a major consideration in a total compensation package. Salaries are important, but 
employees often accept or leave a job based on the quality of fringe benefits. Health insurance costs 
have become very expensive and employees that may have previously left a job more likely stay for 

these benefits. Fringe benefits are tools used by human resources to hire and 
retain top talent and to help create a motivated workforce. 

Examples of fringe benefits includes:  

 
• Retirement benefit plans                                                            
• Group health insurance                                        
• Medical, prescription, dental, and vision plans                                              
• Long-term care insurance plans 
• Life insurance coverage 
• Relocation assistance 
• Legal assistance plans 
• Transportation benefits 
• Child care benefits 

• Adoption assistance  
• Employee discounts (e.g. wellness programs, hotels and resorts, movie 
theaters, theme parks, business establishments, etc.) 
 

2. Provide Assistance in Developing and Approving Company Policies  

The following steps summaries the key stages involved in developing policies: 

1. Identify Need 

Policies can be developed: 

 In anticipation of need (e.g. child protection policies should be in place once an organization 
starts to work with children or young people); and 

 In response to need (e.g. a policy on a government strategy may be developed once proposals 
are published). 

The company needs to constantly assess its activities, responsibilities and the external environment 
in order to identify the need for policies and procedures 

2. Identify who will Take Responsibility 

Delegate responsibility to an individual, working group, sub-committee or staff members, according to 
the expertise required.  (More on the management committee's role in policy development). 

 
3. Gather Information 

Do you have any legal responsibilities in this area? Is your understanding accurate and up to date? 
Have other organizations tackled the same issue? Are there existing templates or examples that you 
could draw on? Where will you go for guidance? 

 

Google: Perks 
include free food, 
massages, offsite 
trips to places like 
Vegas and Hawaii, 
and a flexible work 
schedule, although 
according to one 
senior software 
engineer the 
company 
environment is so 
outstanding that 
"you don't really 
want to leave 
campus." 

Do you know! 
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4. Draft Policy      

Ensure that the wording and length or complexity of the policy is appropriate to those who will be 
expected to implement it.   

 

5. Consult with Appropriate Stakeholders 

Policies are most effective if those are consulted are supportive and have the 
opportunity to consider and discuss the potential implications of the policy. 
Depending on whether you are developing internal or external policies, you 
may wish to consult, for example: 

 Supporters; 
 Staff and volunteers; 
 Management Committee members; and 
 Service users or beneficiaries 

6. Finalize / Approve Policy 

Who will approve the policy? Is this a strategic issue that should be approved by the Management 
Committee or is the Committee confident that this can be dealt with effectively by staff? Bear in mind 
that, ultimately, the Management Committee is responsible for all policies and procedures within the 
organization. 

 

7. Consider whether Procedures are Required 

Procedures are more likely to be required to support internal policies. Consider whether there is a need 
for clear guidance regarding how the policy will be implemented and by whom. (e.g. a policy regarding 
receiving complaints will require a set of procedures detailing how complaints will be handled). Who 
will be responsible for developing these procedures? When will this be done? What will be the 
processes for consultation, approval and implementation? 

 

8. Implement 

How will the policy be communicated and to whom? Is training required (for internal policies)? Should 
the organization produce a press release (for external policies)? 

 

9. Monitor and Review 

What monitoring and reporting systems are in place to ensure that the policy is implemented and to 
assess usage and responses? On what basis and when will the policy be reviewed and revised (if 
necessary)? 

 

 

 

 

 

 
Policies are most 
effective if those are 
consulted with 
stakeholders. 

Consult with           
stakeholders 
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3. Update the Employee Records 

The employee personnel file is the main employee file that contains the history 
of the employment relationship from employment application through exit 
interview and employment termination documentation. Only Human Resources 
staff and the employee’s immediate supervisor and manager may have access 
to the information in the employee personnel file, and it never leaves the Human 
Resources office. 

The employee personnel file is generally stored in a locked, fire-proof file 
cabinet in a locked location that is accessible to Human Resources staff. The 
confidentiality of the employee information in the personnel file is of 
paramount importance. 

Of all the company-kept employee files, the employee personnel file is most 
frequently accessed day-to-day for information by the employer, supervisor, 
or Human Resources staff. 

4. Considerations about Employee Personnel File Content 

The fundamental principles and questions to consider when filing any 
document in an employee personnel file are these.  

 Will the employer need a particular document to justify decisions if the 
employer was sued? Would the employer need the document in a court of law? 

 Does the employee know and understand that the document will be filed 
in his or her personnel file? In most cases, employers ought to have the 
employee sign the document, not to signify agreement with the contents of the 
document, but to acknowledge that they are aware of and have read the 
document. 

 No surprises, opinions, or personal notes about the employee should 
ever be placed in an employee personnel file. Just the facts, no speculative 

thoughts, belong in an employee personnel file. 

 

5. Contents of an Employee Personnel File 

Following are recommendations about the documentation that an employer should keep in an 
employee personnel file. 
Employment History includes the following: 
 

 Job application 

 Resume 

 Resume cover letter 

 Education verification 

 Employment verification 

 Rejection letter 

 Position job description 

No surprises, 
opinions, or 
personal notes 
about the employee 
should ever be 
placed in an 
employee personnel 
file. Just the facts, 
no speculative 
thoughts, belong in 
an employee 
personnel file. 

Remember 

 
Any contract, written 
agreement, receipt, 
or acknowledgment 
between the 
employee and the 
employer (such as 
a non compete, 
an employment 
contract 

Employment 

Contract 
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 Job analysis records 

 Job offer letter or employment contract 
 Employment agency or temp agency agreement, if used 

 Emergency contact information 

 Signed employee handbook acknowledgment form showing receipt of employee handbook 

 Checklist from new employee orientation showing topics covered and by whom 

 Any relocation agreements and documentation 

 Any contract, written agreement, receipt, or acknowledgment between the employee and the 
employer (such as a non-compete agreement, an employment contract, or an agreement 
relating to a company-provided car), for example Life of employment official forms including: 
requests for transfer, promotion, internal job applications, and so forth 

 Any other documentation related to employment. 

 
Employee performance development and improvement includes the following documents: 
 

1. Copies of any performance appraisal used or employee development plans 

2. Employee self-assessments 

3. Records from any formal counseling sessions 

4. Notes on attendance or tardiness 

5. Performance improvement plan documentation 

6. Disciplinary action reports 

7. Employee recognition presented such as certificates, recognition letters, and so forth 

8. Employee formal suggestions and recommendations, organization responses 

9. Training records 

10. Requests for training 

11. Competencies assessment 

12. Training class or session notifications or schedules 

13. Needs assessments signed 

14. Training expense reports 

15. Complaints from customers or coworker 
 

 
Employment Termination Records 
 

 Employee resignation letter 

 Exit interview documentation 

 Cobra notification 
 Employment ending checklist 

 Final accounting   for all aspects of the employee's employment such as final paycheck, 
vacation pay, return of company property, and so forth. 
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Learning Unit 2: HRM Record Keeping  

Overview 

In this learning unit you will be learn to Organization’s Employee database, update daily attendance 
(Punctuality, Regularity) record of each worker in database, keep the accounts related information of 
each employee &maintain the performance assessment of every individual. After  completion of this 
learning unit  you will be able to  design and create organisation’s employees database, calculation of 
staff salaries using different excel formulas &maintain  the  staff performance appraisal. 
 

1. Procedures of Developing Simple Database to Keep Employees Record in 
MS Access 

The procedure of designing a database using MS Access is elaborated using the following illustrations: 
 

1. Click Microsoft Access from Start button or from desktop shortcut. 
 

2. Click on Blank Database Button as shown below. 
 

 
 

3. Now click on table and create field as shown in below illustration. 
 

 
 

4. Now fill data in datasheet view as illustrated below. 
 



 Module 6: Business Functional Process Area (HRM) 

Teaching and Learning Material: Information Technology (Office Assistant)                                                                          | 173 

 
 

5. Now click on design view of table as shown below. 
 

 
 

6. Save table title Employee as shown below. 
 

 
 
 

7. Set field name and also data type as shown below. 
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8. Open table in datasheet view as shown below. 
 

 
 

9. Save the table as shown below. 
 

 
 

10. Fill Data in employee table as shown below. 
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11. Save the data using save command as shown below. 
 

 
 

 

2. Enter Daily Working Hours for Every Worker in an Excel Sheet 

Data about daily working hours for every worker can be entered in an Excel Sheet using following 
steps: 
 

1. Enter the labels for the worksheet as shown below. 
  

 
 

2. Select F2:G9. Right-click the selection and then select Format Cells. Under Category, select 
Time. Under Type, select 1:30 PM (Click OK). 
 



Module 6: Business Functional Process Area (HRM) 

176 |                                                                          Teaching and Learning Material: Information Technology (Office Assistant) 

 

3. Select H2:H9. Right-click the selection and then select Format Cells. Under Category, select 
Custom. Under Type, select h:mm  Click OK. 
 

 
 

4. Right-click H10 and then select Format Cells. Under Category, select Number and click OK. 
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5. Select H2:H7 and then enter the following function: =IF 
(OR(E2="Project1",E2="Project2",E2="Project3"),G2-F2,(G2-F2)*0.5) 

 

6. Press Ctrl + Enter. 

Enter the data as shown in cells D2:G7 



Module 6: Business Functional Process Area (HRM) 

178 |                                                                          Teaching and Learning Material: Information Technology (Office Assistant) 

 

Excel automatically calculates half the time for Admin and full time for the projects. The total number 
of hours is calculated in H10. 

 

3. Calculate Employees’ Salaries using Formula 

Steps involved in salary calculation are as under: 

 

Step 1 

Open a Microsoft Excel spreadsheet. 

Step 2 

Click cell "A1" and type "Employee." Press the "Enter" key. Click cell "A2" and type the name of the 

first employee. Continue entering each employee's name in column A. 

Step 3 

Click cell "B1" and type "Employee ID." Press "Enter." Click cell "B2" and type the employee ID of the 

first employee. Continue entering each employee's ID in column B. 

Step 4 

Click cell "C1" and type "Hourly Rate." Press the "Enter" key. Click cell "C2" and type the hourly rate 

of the first employee. Continue entering each employee's hourly rate in column B. 

Step 5 

Click cell "D1" and type "Total Hours." Press the "Enter" key. Click cell "D2" and type the total hours of 

the first employee. Continue entering each employee's total hours in column C. 

Step 6 

Click cell "E1" and type "Regular Hours." Press the "Enter" key. Click cell "E2" and type 

"=IF(D2>40,40,D2)." Press the "Enter" key. This formula instructs Excel to display only the employee's 

regular hours. 
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Step 7 
Click cell "E2" and place your mouse at the lower-right corner of the cell. Your mouse pointer changes 
to a "+" sign. Click the corner of cell "E2" and drag your mouse to copy the formula for each employee. 

Step 8 

Click cell "F1" and type "Regular Salary." Press "Enter." Click cell "F2" and type "=E2*C2" in the cell. 

Press the "Enter" key. This formula multiplies the employee's regular hours by his hourly rate. 

Step 9 

Click cell "F2" and place your mouse at the lower-right corner of the cell. Your mouse pointer changes 

to a "+" sign. Click the corner of cell "F2" and drag your mouse to copy the formula for each employee. 

Step 10 

Click cell "G1" and type "Overtime Hours." Press "Enter." Click cell "G2" and type " =IF(D2>40,D2-

40,"0")" in the cell. Press the "Enter" key. This formula evaluates the employee's total hours and 

displays only hours over 40. If the employee has less than 40 hours, the cell displays a "0." 

Step 11 

Click cell "G2" and place your mouse at the lower-right corner of the cell. Your mouse pointer changes 

to a "+" sign. Click the corner of cell "G2" and drag your mouse to copy the formula for each employee. 

Step 12 

Click cell "H1" and type "Overtime Salary." Press the "Enter" key. Click cell "H2" and type 

"=(C2*1.5)*G2" in the cell. Press "Enter." This formula multiplies the employee's overtime hours by the 

general overtime rate of time and a half. 

Step 13 

Click cell "H2" and place your mouse at the lower-right corner of the cell. Your mouse pointer changes 

to a "+" sign. Click the corner of cell "H2" and drag your mouse to copy the formula for each employee. 

Step 14 

Click cell "I1" and type "Gross Salary." Press "Enter." Click cell "I1" and type " =H2+F2" in the cell. 

Press the "Enter" key. This formula adds the employee's regular salary and any overtime. 

Step 15 

Click cell "I2" and place your mouse at the lower-right corner of the cell. Your mouse pointer changes 

to a "+" sign. Click the corner of cell "I2" and drag your mouse to copy the formula for each employee. 

Step 16 

Click cell "C2" and drag your mouse to highlight each employee's hourly rate. Click the "Home" tab and 

click the "$" sign in the "Number" group to format the cells to include a dollar sign and increase the 

number to two decimal places. Apply this format to the dollar amounts in column "F," "H" and "I." 

Step 17 

Click cell "A1" and drag your mouse to cell "I1." Click the "Home" tab and click the "B" sign in the "Font" 

group to apply bold formatting to the cells. 
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Simple Excel Formula for Salary Calculation  
 

 

 
 

Example Salary Calculation & Use of IF Function 
 
Employee Code No = keep it same like in picture  
Name = keep it same like in picture  
Designation = keep it same like in picture  
Basic Salary = keep it same like in picture - See more at:  
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Now calculate some ALLOWANCES based on assumptions 
 

 
 
House Rent Allowance (HRA) = If 10% of basic salary is higher than Rs 2000, than HRA will Rs 2000. 
If 10% of basic salary is lower than Rs 2000, then HRA will 10% of Basic Salary  
 
Formula =IF(D2*10%>2000,2000,D2*10%)  
write formula in E2 cell & drag formula to E21 cell,  
 
Dearness Allowance (DA) = DA is 25% on Basic Salary  
Formula =D2*25%  
write formula in F2 cell & drag formula to F21 cell  
 
Medical Allowance (MA) = Executives get MA Rs 1000, Officers get MA Rs 700 & Assistants get 
MA Rs 500  
Formula =IF(C2="Excutives",1000,IF(C2="Officers",700,500))  
write formula in G2 cell & drag formula to G21 cell  
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Gross Salary = Total of Basic + HRA + DA + MA  
Formula =SUM(D2:G2)  
write formula in H2 cell & drag formula to H21 cell  
 
Professional Tax = Upto 5000 = 0, upto 1000 = 60, upto 15000 = 100 & over 15000 = 150  
Formula =IF(H2<=5000,0,IF(H2<=10000,60,IF(H2<=15000,110,150)))  
write formula in I2 cell & drag formula to I21 cell  
 
Salary Paid Per Month = Gross Salary - Professional Tax  
Formula =H2-I2  
write formula in J2 cell & drag formula to J21 cell  
 
Annual Salary = Salary Paid Per Month * 12  
Formula =J2*12  
write formula in K2 cell & drag formula to K21 cell  
 
Income Tax = Upto 100000 = 0, then 50000 = 10%, then 100000 = 20%, over 250000 = 30%  
Formula =IF(K2<=100000,0,IF(K2<=150000,(J2-100000)*10%,IF(K2<=250000,(K2-
150000)*20%+5000,(K2-250000)*30%+25000)))  
write formula in L2 cell & drag formula to L21 cell  
 
Net Salary Payable = Annual salary - income tax  
Formula =M2-M2  
 
 
Protecting Word Document 
After creation of salary sheet according to attendance there are several files which are most confidential 
and not for public. These files should be protected to other. 
 

1. Open word file 
2. Click on file in 2010 or office button in 2007 
3. Click on info 
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4. Click on encryption with password. 
 

 
 

5. Click Protect Document. This square button is located under the “Information about 
<document>” section. Click “Encrypt with Password” in the menu that appears. 
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6. Enter a password. You will be asked to enter the password again to confirm it. You will not be 
able to retrieve this password if you forget it, so write it down in a safe location. In order for 
the password to take effect, you must save the file. 
 

 
 

7. Remove your password. If you want to remove your password, open the document and click 
the File menu again. Click Protect Document and select “Encrypt with Password”. There will 
be a password in the box, delete it and press OK 
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Summary of Module 

  Defining common Human Resource Management terminologies e.g. employee retention, 
fringe benefits, Responsibility Assignment Matrix.  

  Provide due assistance in developing and approving company policies including 
Compensation policy, leave policy, Training assessment and writing of ACR.  

  Updating the Employee records and Provide assistance to accounts department for Salary 
calculations against entries in attendance system.  

  Design a generic database in access form (may have more than one table) to keep the 
employee records from their respective profiles.  

   You can enter daily working hours for every worker in an excel sheet.  

  Calculate employees’ salaries by applying different mathematical formulas, e.g. per hour 
work rate, calculation of daily allowance, etc.  

  Maintaining quantitative performance assessment in confidential protecting word 
documents.  
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Frequently Asked Questions (FAQs) 

FAQ 1:   What is Human Resource Management? 

Answer 

Human Resource Management (HRM) is the function within an organization that 
focuses on recruitment of, management of, and providing direction for the people who 
work in the organization.  

FAQ 2:  What is meaning Human Resources Information System (HRIS) mean? 

Answer 

A Human Resources Information System (HRIS) is software or online solution that is 
used for data entry, data tracking and the data information requirements of an 
organization's human resources (HR) management, payroll and bookkeeping 
operations. 

FAQ 3:  What do you mean by term fringe benefits? 

Answer 
The term fringe benefits refer to the extra benefits provided to employees in addition to 
the normal compensation paid in the form of wage or salary. 

FAQ 4:  What is meant by the acronym RACI? 

Answer Responsible, Accountable, Consulted and Informed 

FAQ 5:  What is ACR? 

Answer 
ACR stands for Annual Confidential Report. This is an annual assessment report of 
subordinate staffs maintained by Human Resources Department of the concerned 
institution/company. 

FAQ 6:  What are Employment Termination Records? 

Answer           

Employee resignation letter, Exit interview documentation Cobra notification, 
Employment ending checklist, Final accounting   for all aspects of the employee's 
employment such as final paycheck, vacation pay, return of company property, and so 
forth. 

FAQ 7:  What are Types of Formal Training? 

Answer Orientation training, remedial training and advance or  upgrading training 

FAQ 8:  What is employment contract? 

Answer 
Any contract, written agreement, receipt, or acknowledgment between the employee 
and the employer (such as a non-compete, an employment contract 

  

http://hrmpractice.com/tag/benefits/
http://hrmpractice.com/tag/compensation/
http://hrmpractice.com/tag/salary/
http://humanresources.about.com/od/glossaryc/g/cobra.htm
http://humanresources.about.com/od/glossaryp/g/paycheck.htm
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FAQ 9:  What is Human Resource Management Services Role? 

Answer 
Determine skills employees need, the organizational structure, technological 
requirements and services required for organization. 

FAQ 10:  What are Seven Cs? 

Answer Context, Consistency, Completeness, Control, Compliance, Correctness, and Clarity 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer 
Key at the end of this module. 

1.  Which of the following is NOT a part of fringe benefits? 

a.  Retirement benefit plans                                                            b.  Long-term care insurance 

c.  Group health insurance                                           d. Basic salary 

2.   What is meant by ACR ________________? 

a.  Annual control report  b.  Anonymous covering report  

c.  Annual clerical report  d.  
Annual confidential report 
 

3.  Pay Performance compensation policy based upon _____________. 

a.  Employee leaves record  b.  Employees education  

c.  Employee performance  d.  Employee technical skills  

4.  What is meaning of acronym HRM _____________. 

a. Humane  Resource Management  b. Human Resource Management  

c. Humanistic Resource Management     d. Human Relations Management  

5.  Which of the following terms was also used before the language of modern HRM?  

a. Labour relations b. Personnel management 

c. Personal management d. 
Industrial relations  
 

6. Which of the following is not a function normally performed by the HR department? 

a. Employee relations b. Training and development 

c. Recruitment and selection d. Accounting 

7. What you mean by KPIs? 

a. Key Performance indication b. Key Performance Indicators 

c. Key personal Intelligence d. Key Personal Information 



 Module 6: Business Functional Process Area (HRM) 

Teaching and Learning Material: Information Technology (Office Assistant)                                                                          | 189 

8. 
Which of the following is not a reason why performance appraisal is used by 
organizations? 

a. To determine promotion b. To motivate employees 

c. To allocate financial rewards d. Because it is legal requirement 

9. Performance appraisal involves all the following except: 

a. Setting work standards b. Comparing performance to standards 

c. Providing feedback to employee d. 
Preparing job descriptions for groups 
of job 

10. Employee Personal file comprises all the following except: 

a. 
History of the employment 
relationship 

b. Exit Interview record 

c. Employee Finical record d. 
Employment  termination 
documentation  
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Answer Key 
MCQs No. Correct Answer 

1 d 

2 d 

3 c 

4 b 

5 b 

6 d 

7 b 

8 d 

9 d 

10 c 
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Module 7: Business Functional Process 
Area (Administration) 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Maintain Office Records. 

 Manage Company files/folders (Soft copy). 

 Provide assistance for Electronic Office / Digital Work Flow 
Environment. 

 Provide assistance in preparing the corporate presentations. 

 Create slides. 

 Apply animation and transition effects on slides. 

 Import Picture and Video Graphic effects. 

 Incorporate Audio and Video controls. 

 Perform text editing (format) features. 

 Familiar with Design, Transition, Animation and Slide Show tabs 
of the Microsoft PowerPoint. 
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Learning Unit 1: Administrative Skills 

Overview 

In this learning unit, you will learn to develop company database to keep the official correspondence 
records for receive and issuance of signed letters, applications, Reports, Maintain the soft copies of 
the company official data and ensure its confidentiality, Integrity and availability.  

1. Design and Develop Company Database  

Required Outputs of Project 

 Signed received documents can be accessed by Subject, Document 
Number and Sender Name + Date. 

 Signed issued documents can be accessed by subject, Document 
Number and Sender Name + Date. 

 Signed reports can be accessed by subject, report Number and Date. 

ER-Diagram 

 

ER- Diagram for Received Document  

 

A Database 
Management 
System is a 
collection of 
programs that are 
used to create and 
maintain data. 

Remember 

Microsoft Access 
2013 is an Object 
Based Data Model. 

Do you know! 
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ER-Diagram for Issued Document  

List of Tables Required 

Receiving Table: This table will store details about the file received e.g. 
Recv_Doc_Numb, Subject etc.  

Issuance Table: This table will store details about the file received e.g. 
Issu_Doc_Numb, Subject etc. 

Reports Table: This table will store details about the file received e.g. 
Report_Numb, Subject etc. 

List of Forms Required 

Receiving Form: This form will be used to add information of received 
document into the database or Delete information from the record. 

Issuance Form: This form will be used to add information of issued 
documents into the database or Delete information from the record. 

Reports Form: This form will be used to add information of reports into the 
database or Delete information from the record. 

List of Queries Required 

 Search the required document by Document Number. 

 Search the required document by Sender and Date 

 Search the required document by Subject 

 

 

 

 

ER-Relationship 
model is a logical 
representation of 
data in an 
organization. It 
consists of Entity, 
Attributes and 
relationships. 

ER-Model 

An entity is a 
person, place, thing 
or event for which 
data is collected and 
maintained. 

Entity 

A primary key is a 
field or set of fields 
that can uniquely 
identify a row of a 
table. Duplicate 
values are not 
allowed. 

Primary Key 

A window that 
consists of visual 
component is called 
form. Forms are 
used to interact with 
database. 

Forms 

Query is a statement 
that extracts specific 
information from 
database. 
A query is created 
by specifying fields 
to display from a 
table or another 
query. 

Queries 
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List of Reports Required 

 Subject wise Document File 

 Date and Sender or Receiver wise Document File 

 Document Number wise Document File 

 

Steps to Complete the Project 

Create a Database  

You can create a new blank database file using MS Access 2013 by any name 
e.g. record keeping, Signed document etc. 

Create Tables 

 Create three tables i.e. Receiving, Issuance, Report. 

 Add the following Attributes to the table: 
o Attachment Attribute As Attachment type 
o Subject Attribute As Long Text 
o Document Number Attribute As Long Text 
o Date Attribute As Date and Time Type 
o Sender or Receiver Attribute As Long Text 

 Declare an attribute as a Primary key 

Create Forms 

 Forms can be created using Form wizard. 

 Form can be designed using Design View Mode. 

 All fields of the table will be displayed automatically related to the tables. 

 Create a 3 New Buttons and name it as ADD New Record, Save, Clear 
Form. 

Create Queries 

 Queries can be created from Query Wizard. 

 Queries can be viewed in Design View. 

 Select the field from Receiving Table and ADD the desired fields. E.g. 
Recv_Doc_Numb etc. 

Create Reports 

 Reports can be created using Report Wizard 

 Select the Tables and queries from the given list 

 ADD the required fields using ADD button 

 

 

 

Design view gives 

you a more detailed 

view of the structure 

of the form. Header, 

Detail, and Footer 

sections can be 

viewed. 

Remember 

SQL stands for 

Structured Query 

Language. It is a 

Non-Procedural 

Language. 

Do you know! 

Layout view is a 

more visually-

oriented view than 

Design view. Useful 

view for setting the 

size of controls and 

displays real data. 

Remember 

Reports are the 
outputs of a 
database 
application. Different 
types of reports can 
be generated by 
manipulating the 
data. 

Reports 
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2. Confidentiality and Integrity  

Confidentiality of information is protecting the information from disclosure to 
unauthorized parties. Information has value, especially in today’s world. It is 
responsibility of employee to ensure confidentiality are undertaken to prevent 
sensitive information from reaching the wrong people, while making sure that 
the right people can in fact get it.  Integrity involves maintaining the 
consistency, accuracy, and trustworthiness of data over its entire life cycle. 
Data must not be changed in transit, and steps must be taken to ensure that 
data cannot be altered by unauthorized people (for example, in a breach of 
confidentiality). 

Encrypt a Database by Using a Password 

Following are the steps used for encrypting a file in Microsoft Access 2013: 

1. Open the Access file in Exclusive Mode 

 

2. Click on FILE at top left corner. 

 

3. Click on Encrypt with Password. 

The protection of the 
database from 
unauthorized users, 
which may involve 
password and 
access restriction. 

Security 

Integrity of 
information refers to 
protecting 
information from 
being modified by 
unauthorized users. 

Integrity 

Encryption is the 
most effective way 
to achieve data 
security. To read an 
encrypted file, you 
must have access to 
a secret key or 
password that 
enables you to 
decrypt it. 

Encryption 
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4. Enter the Password and Click OK. Your File is secured with password. 

 

3. Scanning and Printing  

Scanning is a process of converting paper documents such as letters, forms, 
receipts, contracts and other documents into digital/soft copy which can be 
easily integrated as a part of database document in home or office computers 
or may be added to a central database 

Scanning  

Document scanning involves both document scanning software and machinery. 
You need to install the device drivers so use the scanner for scanning the 
documents. 

Benefits of Documentation Scanning or Digitization 

 Digitization of paper records increases productivity of the workers 

 After digitization, file searching, sharing of documents and protecting becomes much easier.  

Optical Character 
Recognition enables 
you to convert 
scanned Papers into 
editable format. 

Do you know! 

Device driver is a 

program that 

controls a particular 

type of device that is 

attached to your 

computer. 

Remember 
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 large volumes of paperwork not required resulting in saving of trees 

Steps involved in Scanning 

1. Check the contents of the box 
a. The contents might vary by country/region. See the packaging for a list of items shipped 

in the box. 
2. Remove the packaging 

a. Place the scanner in a sturdy, well-ventilated, dust-free place. 
b. Raise the scanner lid, and then remove any packaging. 
c. Remove any plastic film from the outside of the scanner and from the scanner glass. 
d. Recycle the packing materials. 

3. Install the software 
a. After you complete the previous hardware setup steps, you can install the scanner 

software using a CD. 
b. Turn the computer on and log in. 
c. Insert the scanner CD into the CD drive of the computer, and then wait a few seconds 

for the software installer to start. 
d. If the installer does not start automatically, click or tap and hold the bottom left corner 

of the screen, click or tap File Explorer , and then double-click or double-tap the CD or 
DVD drive. 

e. In the installation window, Click Go Online or No thanks, I prefer the CD installation.  
f. Follow the on-screen instructions to install the software. 

Printing 

Printing is a process for reproducing text and images using a master form or template. A printer is a 
peripheral which makes a persistent human readable representation of graphics or text on paper or 
similar physical media. 

Steps involved in Printing 

1. Once you’ve completed your document and are ready to print, click File in the top left-hand 
corner of your document. 

2. Move down and click Print in the menu. This will bring up the ‘Print’ dialogue box. 
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3. Choose how many copies of your document you need. 

 

4. Depending on your printer options, you can choose other printing features such as whether you 
want to print all pages or only certain pages. 

 

5. When you’re happy with your settings, Click Print. The document will now start printing on your 
printer. 
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Learning Unit 2: Preparing a Presentation 

Overview 

In this learning unit, you will learn to select appropriate slide layout, apply different animation effect on 
text or objects, adjust audio and video controls on a slide, play slide show by selecting different 
transitions, text formatting features and protecting the presentation file. After completion of this learning 
unit, you will be able to create slides layouts, animation effects on text or objects, audio video controls 
on slide, slide transition, text formatting and protecting the presentation.  

1. Design and Selection of Slide Layout  

Slide layouts contain formatting, positioning, and placeholders for all of the 
content that appears on a slide. There are different slide layouts available in 
Microsoft Power Point 2013. Following are the names of slide layouts.  

 

1. Tittle  
2. Tittle and Content 
3. Section Header 
4. Two contents 
5. Comparison 
6. Tittle Only 
7. Content and Caption 
8. Picture with Caption 

 

Adjusting slide layouts 

When you insert a new slide, it will usually have placeholders. Placeholders 
can contain different types of content, including text and images. Some 
placeholders have placeholder text, which you can replace with your own text. 

 

Insert a new slide 

1. Start a new presentation; it will contain one slide with the Title Slide 
layout. You can insert as many slides as you need from a variety of 
layouts. 

 

 
2. Choose the desired slide layout from the menu that appears.  

Slide titles are used 
to define the 
information on the 
slide as well as 
create a navigational 
outline. 

Tittle Slide 

Slide layout contains 
placeholders for 
text, videos, 
pictures, charts, 
shapes, clip art and 
background. 

Do you know! 

Section headers 
helps divide 
information and let 
users know when 
topics are changing. 

Section Header 

A series of words 
superimposed on 
the bottom of a 
presentation that 
communicate 
dialogue. 

Caption 
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3. The new slide will appear. Click any Placeholder and begin typing to add text. You can also click 

an icon to add other types of content, such as a picture or a chart. 

 

 
 

4. To change the layout of an existing slide, click the Layout Command, then choose the desired 
layout 

Placeholders are the 
Objects on the slide 
that holds the Text. 

Do you know! 

Animation is a set of 
effects which can be 
applied to objects in 
PowerPoint so that 
they will animate in 
the Slide Show. 

Do you know! 
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2. Applying Animation Effects  

Animation can help make a Microsoft PowerPoint 2013 presentation more 
dynamic, and help make information more memorable. The most common 
types of animation effects include entrances and exits.  

 

Apply entrance and exit animation effects 

Following are the steps to add animation to text or objects: 

 

1. Select the text or object that you want to animate 
2. On the Animations tab, in the Animation group, click an Animation Effect from the gallery. 

Click the More arrow to see more options. 

 

 
3. To alter your selected text animates, click Effect Options and then click what you want the 

animation to do. 

The Animation Pane 

allows you to view 

and manage all of 

the effects and can 

modify and reorder 

effects directly. 

Remember 
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4. To specify the timing of the effects, on the Animations tab, use the commands in the Timing 
group. 
 

3. Applying Audio and Video Controls  

To add sound to the animated text or object do the following things: 

 

1. On the Animations Tab, in the Advanced Animation Group, click Animation Pane. The 
Animation Pane opens on the side of the workspace pane, showing the order, type and duration 
of animation effects applied to text or objects on a slide. 

 

2. Locate the effect to which you want to add sound, click the Down Arrow and then click Effect 
Options. 
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3. On the Effect Tab, under Enhancements, in the Sound Box, click the arrow to open the list and 

then do one of the following:  

 

 
4. Repeat for each bullet of text to which you want to add a sound effect 
5. To preview all the animation and sound applied to a slide, in the Animation Pane, click Play. 

 

4. Applying Transitions 

There are three categories of unique transitions to choose from, all of which can be found on the 
Transitions tab: 

1. Subtle 
2. Exciting 
3. Dynamic Content 

Transitions are the 
animation-like 
effects that occur in 
Slide Show view 
when you move 
from one slide to the 
next during on-
screen presentation. 

Transitions 

Exciting transitions 
are more visually 
interesting than 
Subtle transitions, 
adding too many 
can make your 
presentation look 
less professional. 

Remember 
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Add the same slide transition to all of the slides 

For adding the same slide transition to all the slides, use following steps:  
 

1. On the Menu Bar Click on Transition Tab. 
2. Select the Slide Thumbnails of the slides that you want to apply slide transitions to. 
3. On the Animations tab, in the Transition To This Slide group, click a Slide Transition Effect 
4. To set the slide transition speed between the current slide and the next slide, in the Transition to 

this Slide group, click on Timing group to control speed of slides. 
5. In the Transition to this Slide group, click Apply to All. 

 

Add different slide transitions to the slides 

Procedure of adding different transition same as above but you have to individually add the transition 
to that slide. 

 

5. Features of Text Formatting  

The functions for formatting text in PowerPoint are very similar with other Microsoft programs, 
especially Microsoft Word. Select the text you want to format and Right Click.  

Transiting between 
two slides that use 
similar slide layouts, 
Dynamic transitions 
will move only the 
placeholders. 

Do you know! 

Text formatting 
feature in Power 
Point are same as 
they are in MS 
Word. 

Remember 
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Icons from Right to Left 

1. Font: Change the writing style of text 
2. Font Size: Change the size of Text 
3. Increase Font Size: Increase Text size 
4. Decrease Font Size: Decrease Text size 
5. Decrease Indent: Decrease Line spacing 
6. Increase Indent: Increase Line spacing 
7. Bold: Making the Text Bold 
8. Italic: Changing the Text to Italic style 
9. Underline: Underlines the Text 
10. Right Align: Aligns the Text to right side 
11. Center Align: Aligns the Text to right side 
12. Left Align: Aligns the Text to left side 
13. Font Color: Changes the color of Text 
14. Format Painter: Copies the format of selected text to the other text 

 

6. Protecting a Power Point Presentation 

There are ways of protecting slides as follows: 

Document Inspector 

You create or edit a presentation, certain personal information may be added to the file automatically. 
You can use the Document Inspector to remove this type of information before sharing a presentation 
with others. 

1. Click the File tab to go to backstage view. 
2. From the Info pane, click Check for Issues, then select Inspect Document from the drop-down 

menu. 

Document Inspector 
gives users an easy 
way to examine 
documents for 
personal or sensitive 
information, text 
phrases, or other 
document contents. 

Do you know! 
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3. The Document Inspector will appear. Check or uncheck the boxes, depending on the content you 
want to review, then click Inspect. In our example, we'll use the default selections. 

 

 

4. The inspection results will show an exclamation mark for any categories where it found potentially 
sensitive data, and it will also have a Remove All button for each of these categories. Click Remove 
All to remove the data. 
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5. When you're done, click Close. 

 
 
Password Protection 

Password can be protected using following method: 
 
1. Click the File tab to go to backstage view. 
2. From the Info pane, click Check for Issues, then select Protect Document a drop-down menu will 

appear select Encrypt with Password. 
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3. Enter the password and click OK. 

 

4. Your presentation is password protected. 
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Summary of Module 

  Steps for Designing and developing a company data base in MS Access 2013. 

  ER-Relationship Model was used to draw the basics of company’s data base. 

  Tables, forms, Queries and reports were created to complete the database in MS Access. 

  Different built in data types were used e.g. Long Text, Attachment, Date and Time etc. 

  Data integrity, security and confidentiality was achieved using encryption and password 
option both in MS PowerPoint and MS Access. 

  Procedures for Scanning and Printing of a document and storing it in proper file and folders 
was studied. 

  Introduction of MS Power Point 2013. Creation of new files, saving the file and closing the 
presentation file. 

  Transition effect were applied to the text and Object to make the presentation more 
interactive to gather the viewers’ attention. 

  Animations were added to the slides using animation pane, Advanced animation options 
and Timing Menu. 

  Applied different text formatting options available in MS PowerPoint to the written Text. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  How to insert a New Slid? 

Answer 
New slide can be inserted from the Slides Tab New Slide Or Ctrl+N from Keyboard 
a new slide will be added. 

FAQ 2:  Which layout is used for Introduction of topic? 

Answer Tittle slide layout is used for introduction of topic. 

FAQ 3:  What are the steps to add animation to text or Object? 

Answer 
Select the Text or Object you want to add animation to. Then click on Transition Tab in 
Main Menu. Select the desired animation.  

FAQ 4:  Can we encrypt the presentation file? 

Answer Yes, you can encrypt the file in power point using Encrypt with Password from File Tab 

FAQ 5:  What is Query? 

Answer 
Query is a statement that extracts specific information from database. Query is 
created by specifying fields to display from a table or another query 

FAQ 6:  Is there any option to add files in MS Access? 

Answer Files can be attached in MS Access using Attachment type while adding the fields 

FAQ 7:  What is a relationship? 

Answer A relationship is a logical connection between different entities.  

FAQ 8:  Can a Primary Key contain duplicate values? 

Answer No, Primary key cannot contain duplicate values. As Primary Key is identified uniquely 

FAQ 9:  How we can interact with database to add data? 

Answer Forms are used to interact and add data to the tables in MS Access. 

FAQ 10:  Extension of Power Point and MS Access file? 

Answer The extension of PowerPoint is .pptx and extension of MS Access is .accdb 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  Properties that describe the entity’s characteristic are called_____________. 

a.  Attributes b. Entity 

c. Identifier d. Relationship 

2.  File should be opened in ________ mode to be encrypted. 

a.  Encryption Mode b. Exclusive Mode 

c. Normal Mode d. None of the Above 

3.  Which of the following is not present in Query Mode? 

a.  Data Sheet View b. SQL View 

c. Design View d. Layout View 

4.  What field type is used to store picture in a table? 

a.  Memo b. OLE 

c. Hyperlink d. None 

5.  Which short cut key inserts a new slide in current presentation? 

a.  Ctrl+N b.  Ctrl+S 

c.  Ctrl+M d.  Ctrl+V 

6.  Format painter is used? 

a.  To paint pretty pictures on your slides b.  
To copy formatting from one text and 
then apply on other 

c.  
To change the background color of 
your slides 

d.  
To paint pretty pictures on 
background of slides 
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7.  Slide show tab options include all of the following except: 

a.  From Current Slide b.  Custom Slide Show 

c.  Setup Slide Show d.  Reset Slides 

8.  Which option can be used to add custom timing for slide presentation? 

a.  Slide Timings b.  A and C Both 

c.  Rehearse time d.  None of Above 

9.  
The slide that is used to introduce a topic and set the tone for the presentation is 
called __________________. 

a.  Table Slide b.  Graph slide 

c.  Bullet slide d.  Title slide 

10.  Objects on the slide that hold text are called ______________. 

a.  Placeholders b.  Object holders 

c.  Auto layouts d.  Text holders 
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Answer Key 
MCQ Number Correct Answer 

1 a 

2 c 

3 d 

4 b 

5 a 

6 b 

7 d 

8 c 

9 d 

10 a 
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Module 8: Project 

Learning Outcomes 

After completion of this learning module, you will be able to study, 
analyze and develop an automated system (Management Reporting 
System) for an enterprise for Accounts, Inventory, Human Resource 
management business areas. 
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Learning Unit 1: Project  

Overview 

In this module, you will learn how to study, analyze and develop an automated system (Management 
Reporting System) for an enterprise for Accounts, Inventory, Human Resource management business 
areas. After completion of this learn unit, you will be able to provide a lead for the potential job 
opportunity for the executer. 
 

1. Gap Analysis 

A gap analysis is a method of assessing the differences in performance between a business 
information systems or software applications to determine whether business requirements are being 
met and, if not, what steps should be taken to ensure they are met successfully. Gap refers to the 
space between "where we are" (the present state) and "where we want to be" (the target state). A gap 
analysis may also be referred to as a needs analysis, needs assessment or need-gap analysis.  
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Gaps can exist in three primary categories: 
 

1. Human resource, for example, resources lacking the right skill set, or roles that aren’t clearly 
defined. 

2. Processes, such as excessive redundancies in business processes, or unclear handoffs 
between steps in a process. 

3. Technology, like missing technological capability or incompatible systems. 
 
 

2. Conduct a Gap Analysis  

To conduct a Gap Analysis for your project, follow these three steps: 

1. Identify Your Future State 

First, identify the objectives that you need to achieve. This gives you your future state – the "place" 
where you want to be once you've completed your project. 

Simple example: 

Future State Current Situation Next Actions/ Proposals 

Answer 90 per cent of calls 
within 2 minutes. 

    

 

2. Analyze Your Current Situation 

For each of your objectives, analyze your current situation. To do this, consider the following questions: 

 Who has the knowledge that you need? Who will you need to speak with to get a good picture 
of your current situation? 

 Is the information in people's heads, or is it documented somewhere? 

 What's the best way to get this information? By using brainstorming workshops? Through one-
to-one interviews? By reviewing documents? By observing project activities such as design 
workshops? Or in some other way? 

Simple example: 

Future State Current Situation Next Actions/ Proposals 

Answer 90 per cent of calls 
within 2 minutes. 

Approximately 50 per cent of 
calls are answered within 2 
minutes. 

  

 

3. Identify How You will Bridge the Gap 

Once you know your future state and your current situation, you can think about what you need to do 
to bridge the gap and reach your project's objectives. 
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Simple example: 

Future State Current Situation Next Actions/ Proposals 

Answer 90 per cent of calls 
within 2 minutes. 

Approximately 50 per cent of 
calls are answered within 2 
minutes. 

1. Develop a call volume 
reporting/queue modeling 
system to ensure that there 
are enough staff during busy 
periods. 

2. Recruit any additional people 
needed. 

3. Develop a system that allows 
callers to book a call back 
during busy periods. 

  
Gap Analysis to provide an appropriate amount of detail. If you present too much detail, people will be 
overwhelmed, but if you don't give enough detail, you won't tell them what they need to know to sign 
the project off. 
 
When you analyze your future situation and current state, use metrics where information can be 
quantified (such as "costs of the product."), and general statements when metrics aren't available (such 
as "creativity is valued within the organization." 
 

3. Develop and Maintain Accounts Record of any Business using Peachtree  

Peachtree is an accounting application for small and medium-sized businesses (SMBs) made by Sage 
Software. Peachtree enables comptrollers and managers to automate and manage numerous 
accounting tasks.  

Learning Activities 
 

Description:   This activity will be performed by the individual to 
develop computerized accounting system using 
Peachtree. To keep record of all transactions is common 
problem for all domains. Therefore, each individual will 
select different real time business domain under the 
supervision of instructor and shift company manual 
system into Peachtree and will perform following task 
using software: 
 

 Reconciling accounts payable and receivable. 

 Creating financial statements check invoices. 

 Importing and manipulating spreadsheets. 
 

Time Guideline: This activity will take 6 hours daily during a week  
   

Presentation:  
 

After the completion of project, each student will present before class.   
 
 
 

Propose of I.T 

Assistant course is 

produced User of 

system, not the 

developer of system. 

Instructor will guide 

regarding systems 

development.   

Remember 
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4. Inventory Management System in MS Access 

Inventory Management System sufficiently to determine the feasibility and usability of a finished 
system.  The core concept is to track the sale of items from the cash registers with additional 
features for interpreting the data.  

 

 

Learning Activity 

Description:   This activity will be performed by the individual inventory management is 
common problem for all domain. Therefore, each individual will select different 
domain under the instruction of instructor.  
 

 Generate your inventory list, with Economic Order Quantity (EOQ) modeling 
feature. We calculate the re-order point and get the optimal order quantities 
by using built in EOQ model. It helps the business owners manage their 
inventory items in an optimal mode and cut down their business cost. 
 

 Inventory items images and manufacturer lot tracking. 
 

 Inventory items multi-level categories feature allow you to define multi-level 
products categories New Update! 

 

 Accounting manager, generate accounting receivable and payable forms, 
inventory value and sales income balance sheet for business owner to 
review their current financial situation. 

 

Open source code 

for application 

development may 

be used.     

Remember 
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 System will help you generate the purchase order and add the new arrival 
items to the inventory list. It also saves all your suppliers information and 
their products list in supplier's information database. 

 

 When you make sales system will help you generate the sales order and 
automatically reduce inventory items number from your inventory list. Also 
it will save all your customer's information to customer's database. 

 

 Products RMA recall management, we update the inventory level after 
received the RMA update, and re-calculate inventory level based on these 
data. 

 

 Products Return To Vendor (RTV) manager, we update the inventory level 
after received the RTV update, and re-calculate inventory level based on 
these data. 

 

 Products order and expiration tracking, we monitoring all the products 
expiration date and generate report for update status. 

 

 Monitoring product ATP and CTP information based on product ordering 
status and generate the ATP and CTP reports. 

 

 Managing products by locations tracking ware house management system. 
 

 It comes with your company employee database which allows you to easily 
track your employee information and their sales track record. 

 

 Generate the cost comparison report for you to review the products cost 
from different suppliers on each order you made and help you cut down next 
time order cost. 

 

 Contact management features allow you to manage your customer tracking 
information and vendors tracking and transactions drill down information. 

 

  Integrated the MS Outlook email and contact feature and link to you 
supplier and customer management database. 

 

 You can easily generate the report for all sales record, purchase order 
record, inventory list records based on your need.  

 
 

Time Guideline: This activity will take 6 hours daily during a week.   
 

Purpose:  An inventory-control system is the mechanism within a company that is used 
for efficient management of the movement and storage of goods and the related 
flow of information. 
 

Presentation:  
 

After the completion of project, each student will present in the class.   
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5. Human Resource Management System in MS Access 

 
HRMS software allows your human resource team start working more efficiently on utilizing their 
time and resource. It offers you wide range solutions for your human resource data management 
needs. For Example, it includes employee data management, job data management, applicant’s data 
management, employee training data management, and company document management. 
 
 

 
 

Learning Activity 

Description:    This activity will be performed by the individual HR Management System is 
common need for all business. Therefore, each individual will select different 
domain under the instruction of instructor. 

 Domain study.   

 Collect the functional requirement.  

 

Employee Data Management 

This human resource management system (HRMS) software helps you 
recording your employee data, with general information, photo, note attachment 
files, medical information, tax information, monthly timesheet, payroll reports 
(based on the tax information and timesheet), resume and training records and 
medical insurance and emergency contacts.  

 

Job Data Management  

Human resource job data manager helps you record your company's job 
opening records.  

Applicant Data Management  

 Recording all applicants records and contact information  
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 Applicant's status management  

 Applicant reference contact information management  

 Applicant interview schedule setup and manage  

 Create Employee Application Form and Employee Record Audit Form for 
all applicants and keep those document records on document 
management system.  

Employee Training Data Management  

 List all training program that company has  

 Records all the employees training records  

 

HR Documents Data Management  

Manage all HR documents in different categories. 

 
Time Guideline: This activity will take 6 hours daily during a week. 

    
Purpose:  This Microsoft Access based human resource management system (HRMS) 

software will be designed for small to medium sized business. 
 

Presentation:  
 

After the completion of project, each student will present in the class.   
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Summary of Module 
 

 A gap analysis is a method of assessing the differences in performance between a business' 
information systems or software applications to determine whether business requirements are 
being met and, if not, what steps should be taken to ensure they are met successfully. 
 

 A gap analysis may also be referred to as a needs analysis, needs assessment or need-gap 
analysis. 
 

 Peachtree is an accounting application for small and medium-sized businesses (SMBs) made by 
Sage Software. Peachtree enables comptrollers and managers to automate and manage 
numerous accounting tasks.  
 

 HRMS software allows your human resource team start working more efficiently on utilizing their 
time and resource. 
 

 An inventory-control system is the mechanism within a company that is used for efficient 
management of the movement and storage of goods and the related flow of information. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is GAP Analysis? 

Answer 
A technique that businesses use to determine what steps need to be taken in order to 
move from its current state to its desired, future state. Also called need-gap analysis, 
needs analysis, and needs assessment. 

FAQ 2:  Main Phases of GAP Analysis? 

Answer 

Gap analysis consists of the following phases: 
 

 listing of characteristic factors (such as attributes, competencies, performance 
levels) of the present situation ("what is"),  

 listing factors needed to achieve future objectives ("what should be"), and then  

 Highlighting the gaps that exist and need to be filled. Gap analysis forces a 
company to reflect on who it is and ask who they want to be in the future. 

FAQ 3:  What is Peachtree? 

Answer 
Peachtree is an accounting application for small and medium-sized businesses 
(SMBs) made by Sage Software. Peachtree enables comptrollers and managers to 
automate and manage numerous accounting tasks. 

FAQ 4:  What is QuickBooks? 

Answer 

QuickBooks is Intuit Inc’s set of software solutions designed to manage payroll, 
inventory, sales and other needs of a small business. The software’s features include 
marketing tools, merchant services, product and supplies, training solutions. Each 
solution is developed according to different industries and their needs. 

FAQ 5:  What is benefit of using MS Access HRM solution? 

Answer 

If you are a small business, and you need to setup a database for your human 
resource management but don't have a big budget to build it up, MS Access HR 
software is perfect for you because small businesses have unique requirements for 
human resource management software that demand full capabilities without 
complexity and want to see quick return with investment.  

FAQ 6:  Why Use Microsoft Access Solution? 

Answer 

As we all know, Microsoft Access is the most widely used desktop database system in 
the world. Microsoft Access is part of Microsoft Office so there is a common interface 
and lots of developers and support options available. It pretty much covers all the 
functionalities for small business needs. And it is significant less expensive than SQL 
Server or Oracle. For small businesses, this is the fastest and least expensive 
database solution to get your goals accomplished. 



Module 8: Project 

228 |                                                                          Teaching and Learning Material: Information Technology (Office Assistant) 

FAQ 7:  What is ERD? 

Answer 

An entity-relationship diagram (ERD) is a graphical representation of an information 
system that shows the relationship between people, objects, places, concepts or 
events within that system. An ERD is a data modeling technique that can help define 
business processes and can be used as the foundation for a relational database. 

FAQ 8:  What is inventory management? 

Answer 

Inventory Management System sufficiently to determine the feasibility and usability of 
a finished system.  The core concept is to maintain different kind of stock item or non-
stock items with the help of LIFO, FIFO and Average Methodology. It is used to track 
the sale of items from the cash registers with additional features for interpreting the 
data.  
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  What are the different views to display a table? 

a.  Datasheet View b.  Design View 

c.  Pivot Table & Pivot Chart View d.  All Of Above 

2.  Which key Uniquely identifies each record ________? 

a.  Primary Key   b.  Key Record 

c.  Field Name d.  Unique Key 

3.  Which of the following is not a type of Microsoft Access Database Object? 

a.  Table  b.  Form 

c.  Worksheets d.  Modules 

4.  Query can be used to select data from is called ________. 

a.  Single Table  b.  Multiple Tables 

c.  Both  A & B d.  None of above 

5.  Which of the following is used to get data from user?  

a.  Form b.  Pages 

c.  Query d.  Reports 

6.  Which one of the following is not a feature of QuickBooks? 

a.  Online Banking  b.  Secure Sharing 

c.  Direct Payment d.  Detailed Report 

7.  
Involvement of which technology helps QuickBooks runs smoothly at any place 
and time? 

a.  ERP  b.  Cloud Computing 

c.  Network Connectivity d.  SAP 
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8.  
Due to which feature of QuickBooks, the data remains secure and there is no risk of 
sudden loss? 

a.  Security  b.  Multiple Access 

c.  Special Accountant Access d.  Automatic Data Backup 

9.  Which is an Advantage of QuickBooks Online Software? 

a.  
No Direct Updating of Latest Version 
& No Data Mismatch  

b.  
No Data Mismatch & Updating of 
Latest version 

c.  
Updating of Latest version & More 
Data Mismatch 

d.  
More Data Mismatch & No Direct 
Updating of Latest Version 

10.  
QuickBooks can be accessed from various devices including PC, Tablet, Mobile, 
etc. provided ___________. 

a.  Having Desktop b.  Having Internet Connection 

c.  Having Cloud Computing d.  Having Data 

11.  We can say that the business is in profit, when: 

a.  Assets exceed Expenditure   b.  
Income exceeds Liabilities 
 

c.  Income exceeds Expenditure d.  Income exceeds Liabilities 

12.  Term "Credit" means_______ by the business.  

a.  Receiving of benefits b.  
It has no effect on business   
 

c.  Providing of benefits d.  It depends upon items 

13.  What type of expenses is paid out of Gross Profit?  

a.  General Expenses b.  Financial Expenses 

c.  Selling Expenses d.  All of the given options 
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14.  
A company purchased a Laser Printer for Rs.6000. I will be used for 5 years and its 
residual value is expected to be Rs. 1000. What is the annual amount of deprecation 
using straight line method of depreciation?  

a.   Rs. 1000  b.  Rs. 2000 

c.  Rs. 3000 d.  Rs. 3300 

15.  
The process of transferring journal entry information to the ledger is called 
_____________. 

a.  Journalizing  b.  Posting 

c.  Balancing d.  Analyzing 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 a 

3 d 

4 c 

5 a 

6 c 

7 b 

8 d 

9 b 

10 b 

11 c 

12 a 

13 d 

14 a 

15 b 

 




